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PREFACE

Welcome to the FACTS System software that automates your business operations! The FACTS System is
composed of 22 highly integrated modules. Each module has a manual dedicated its use and functionality.
For ease of use, the manuals are formatted similarly. All of the FACTS manuals contain the following
sections: system overview, program descriptions, references, glossary of terms, and sample reports.

System Overview

This section discusses the function and process flow for each module. Each System Overview section
contains:

¢ Anoverview of each module and its interaction with other modules

e  Flow charts of the module’s system

e Anoverview of the modules posting to the General Ledger. This section should be reviewed even
if the General Ledger Module is not being used

e Procedures and close-out checklists for daily, weekly, periodic (monthly) and yearly processing

Program Descriptions

These chapters detail each program in the module. Each program description includes the functions, user
inputs, and a screen print. The programs are listed in the order that they appear on the menu. There is an
overview preceding each menu that explains the interaction of the programs within the menu.

References

Throughout the documentation the phrase (ref. #) is used. This is referring to the appendix called
“References.”

References are used to prevent the same information from being repeated one program to the next. They are
located at inputs where a user might want further information. References are always numbered. For
example, F2 allows a search (ref.5): this indicates that pressing F2 will allow a search on the input, and more
information on searches can be found in the Reference Appendix under reference #5.

Glossary of Terms

The glossary provides a definition of terms used in the manual and related terms from other modules.

Sample Reports

This section provides a sample printout of most of the reports and prints in the module. A directory is
included that lists each report and the page number in the section.

iv FACTS AP
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CHAPTER 1

System Overview

The FACTS Accounts Payable module is a system that will maintain accurate
file information, provide complete audit trails and will optionally post to
general ledger. Interaction with General Ledger is automatic and great
flexibility is available through the use of the GL posting tables.

The system has been designed so that all transactions will produce a printed
audit trail. This allows users the secure feeling that all information is traceable
throughout the system. Instructional prompts, default values and the
capability to back up to previous inputs promote both operator efficiency and
comfort in using the system.

Accounts Payable is broken down into the following menus:

':1 Document Entry, which also includes the Recurring Document Entry
subsystem. This is where you enter AP invoices. Invoices that you enter
on a regular basis can be set up in the Recurring Invoices subsystem to
cut down on data entry.

Payment & Hold Selection, which enables you to select invoices for
v payment. Invoices that have been entered through Document Entry or
Recurring Document Entry must be selected before you can run checks.

Checks subsystem, which allows you to print, and if necessary, reprint
checks and then update the AP system when you are satisfied that the
checks are correct.

N

AP Inquiries, which gives you a quick way to find current and past
information on vendors.

G,IIE_

AP Reports & Prints have the option of printing in vendor number,
alpha, or vendor class order. In addition to the order, you can choose the
range to print. For example, if you choose to print the Aged Payables
Report, you can set the report to start printing at one vendor class and
end at another.

W
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End of Period contains programs that you should run to close the
module correctly at the end of each period. There is an end-of-period
checklist provided later in this section that contains the procedures used
to close the AP module. Some programs are optional, such as the Period
Check Register, and others are required, such as the Register History
Report. The end-of-period menu programs provide you with a complete
audit trail of the AP balance.

File Maintenances enable you to enter, change and delete data. These
programs are used to enter the initial data required to set up the system.
You can add, change and delete the records in a file. You will use some
file maintenance programs, such as Vendor F/M, during live processing
more than others. The system also contains an additional maintenances
sub-menu; the programs are Infrequent File Maintenances. These
infrequent file maintenances (found on the Infrequent File Maintenances

menu) are used mostly during installation.

1-2

Always check with you Affiliate before you change settings in Infrequent
File Maintenances.

Vendors are entered through the Vendor F/M program setting parameters
which determine how the system is to process transactions for each vendor.
Vendor information is stored and is available to be printed on a report or to be
displayed on the screen by an inquiry.

Following are just a few of the flags set for each vendor: active/inactive -
determines whether any transactions may take place for this vendor, i.e.,
documents entered or checks written, on hold - determines whether any
purchase orders may be entered for the vendor and whether any open
documents owed to the vendor may be paid, permanent/temporary -
determines whether the vendor should automatically be removed by the
system at the end of each period if the vendor balance is zero, and ledgercards -
determines whether to store ledgercards (each transaction affecting a vendor's
account). Vendors are also assigned a terms code (determines document due
dates, etc.), GL posting table (for distributing transactions to general ledger)
and vendor class (for reporting purposes).

Vendor information stored is available for display through the Vendor Inquiry
program that displays general information, payment history, ledgercards and
account information. Account information includes open documents, activity,
and paid documents. Vendor notes may also be entered in the inquiry
program. The Vendor Inquiry provides users with all the vendor information
at their fingertips and makes AP management an organized and efficient
process.

Throughout the Accounts Payable system, whenever the vendor's number must
be entered, the user has the ability to search for the customer through an alpha
lookup, a keyword search or a contact name search. The search capability
relieves the user of having to remember vendor numbers.

FACTS AP
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Documents (invoices) may be entered into the system for payment either
through the AP Document Entry program or through the Purchase Orders
system when a document is tied with a purchase order placed into the system.
When a document is entered it must be assigned to a branch. Most AP reports
may then list documents by profit center (branch). When entering an accounts
payable document, the user must also expense the full amount of the document
to the appropriate GL account numbers. If job cost is used, each document may
be automatically posted to a specific job number in the Job Cost module.

The Recurring Document system is available if the user pays documents that
are repetitive on a regular basis (i.e., rent or loan payments). Users set up a
document in an entry program specifying the amount of the document to post
to the open payables file, the dates to post the invoice, and a predetermined
cutoff. Users then run a posting program which automatically posts the
invoices into the document entry file, ready to post to the open payables file.
The Recurring Documents system relieves the user of entering the same
document information on a regular basis and remembering when to enter the
documents.

At the time when the user is ready to make payments against open documents,
the Payment & Hold Selection menu is used. Making payments is a very
flexible process which can adapt to any office environment. Individual
documents may be placed on hold to indicate they may not be paid.
Documents may be selected for payment manually, allowing the user to enter
partial payments and to override the discount amounts and dates. Documents
may also be selected for payment automatically by the system, allowing the
user to select the basis on which payments are made, i.e., discount or due date,
check date, etc. Payments selected for payment may be reviewed using the
Payment Selection List program. At any time prior to printing checks,
payments may be corrected or deleted. Payment selection may be made based
on the branch assigned to each document. This allows multiple profit centers
(branches) to make payment selection and pay only the documents expensed to
that profit center.

Once the Payment Selection List is verified, checks may be created and printed
by the system through the Checks menu. There are four types of checks in the
Accounts Payable system. Each type of check must be updated by the Check
Register program. The Check Register provides an audit trail of all checks and
updates all appropriate files. The four types of checks are the following: 1)
Printed checks - the Check Print program is used to print checks which were
generated for the Payment Selection List; 2) Manual checks - the Manual
Check Entry program is used to enter and record manual checks (written
manually by the user) paying invoices in the open payables file; 3) Noninvoice
checks - the Noninvoice Check Entry program is used to pay a document not in
the open payables file, i.e., entering the document(s), expensing the
document(s) and recording payment of the document(s) at the same time
(example, a C.O.D. document); and 4) Void checks - the Void Check Entry
program is used to void out a printed or manual check already updated by the
Check Register and documents are posted back into the open payables file.

FACTS AP 1-3
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All Accounts Payable reports have the option of printing in vendor number,
alpha, or vendor class order. In addition to the order, the user may choose the
range to be printed. For example, the Aged Payables Report may be printed by
vendor class. There is a wide variety of reports which print all available
information stored in the Accounts Payable system. The following are the
Accounts Payable reports:

1.

The Cash Requirements Report prints up to six time periods of cash
requirements for invoice payment. The periods of time are
determined by the user as well as whether the documents are to print
based on due date or discount date. The report may be printed in
summary (total amount due to each vendor within the specified time
periods) or detail (information on each document due to each vendor
within the specified time periods).

2. The Open Payables Report prints a list of open payables, zero balance

documents or both. The options are to print in summary (vendors and
their balances), detail (vendors and information on each document
due) or detail with transactions (vendors, and all transactions against
each document).

3. The Aged Payables Report prints a report of open payables in aging

columns as of a specified aging date. The user may also specify how
many days past due an invoice must be before appearing on the report
and whether to include contact information and purchase information.
The report may be printed in summary (vendor and balance) or detail
(vendor and information on each invoice due to the vendor).

Accounts Payable—7.7
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4. The Inactive Vendor Listing prints a list of all vendors who have been
inactive as of a specified cutoff. Purchase history figures may be
included in the report. This report will not update any files but may
be useful in allowing the user to delete inactive vendors.

5. The Vendor Listing prints a report of either general or historical
information on vendors. The vendor's address, phone number,
and/or contact may print on either report.

6. The Vendor Ledgercards Report prints a list of the transaction types
chosen that have affected the vendor's balance.

7. The Vendor Label Print program prints up to 99 labels per vendor and
may be sorted by zip code.

8. The Rolodex Vendor Card Print program prints up to 99 rolodex cards
per vendor and may be sorted alphabetically.

9. The Purchase History Report prints various purchase history
information from the vendor's history. The user may select month-to-
date, year-to-date or prior year information and determine the
minimum purchases to print. The user has the option to select specific
document groups to print.

10. The Payment History Report prints total payments made to vendors for
up to 6 periods.

11. The 1099 Print prints the nonemployee compensation statements. The
user chooses the beginning and ending vendor and the document
group(s) to print. The forms used are the standard 1099 forms
distributed by the IRS.

12. The Vendor Balancing Register is run only when the vendor's balance
does not agree with the invoices for that vendor (i.e., very unlikely - if
there is a power failure in the middle of an update, etc.). The register
prints all out-of-balance vendors. The optional update will correct
each vendor balance and the total AP balance.

13. The Vendor Notes Print program prints the notes for any vendors in the
vendor file.

14. The AP Code List prints a listing of the various AP codes: vendor
classes, terms codes and GL posting tables.

The Accounts Payable system provides an End-of-Period menu. This menu
contains programs that should be run to close the module correctly at the end
of each period. There is an end-of-period checklist provided later in this section
instructing the user on the procedures used to close the AP module. Some
programs are optional (Period Check Register) where others are required
(Register History Report). The end-of-period menu programs provide the user
with a complete audit trail of the AP balance.
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Accounts Payable Flow Charts

The following pages present flow charts that illustrate the flow of information
from Accounts Payable to the other modules in the FACTS System. They also
illustrate the flow of information within Accounts Payable.

Note that not all files and programs are shown. The flow charts simply present
how information flows through the system.

The following symbols represent the types of information shown on the flow
charts.

Program Register or report with

optional update

Report
File

FACTS Module
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Print Checks

System Overview
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Posting to General Ledger

You can set up the Accounts Payable system to automatically post to General
Ledger. To do this, set the GL distribution flag in the AP Static Control F/M to
one of the following: 0-indicating no GL distribution is printed or posted; 1-
indicating the GL distribution is printed (printing is in detail format) but not
posted to GL; 2-indicating the GL distribution is printed (printing is in detail
format) and posted to GL in summary (posting includes the total amount
posted to each account number); or 3-indicating the GL distribution is printed
(printing is in detail format) and posted to GL in detail (posting includes each
item contributing to the amount for each account number).

Two other flags control automatic posting from AP to GL. The GL expense
journal and GL disbursements journal flags, also located in the AP Static
Control F/M program, allow you to direct transactions posted from the
Document Entry Register and Check Register to specific GL Journals.

The Accounts Payable transactions that may print a GL distribution and post to
GL are the transactions from the Document Entry Register and the Check
Register.

The GL distributions are built and posted through the use of GL posting tables.

Users establish their own set of valid GL posting tables to be assigned to each
vendor. For example, all invoices from freight companies may be expensed to
the same GL account number. The user should assign one GL posting table to
all freight vendors. Posting tables may be alphabetic or numeric and should be
easily recognized. During Document Entry, the user must enter the vendor
number. The GL posting table code assigned to that vendor is displayed and
may be overridden on the invoice. The GL account numbers stored with the
GL posting tables become the default value for the expense account number
entered in Document Entry. Document Entry also allows a search to display all
G/L numbers set up in a posting table.

In Document Entry, the user may expense an invoice to up to 999 expense
accounts. The GL posting table allows the user to set up to five default expense
accounts to make entry of AP documents easier.

The GL posting table also contains the Accounts Payable G/L number to post
and the Discounts G/L number to post when a discount is taken.
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Example: Southern bell is a vendor set up in the vendor file and for GL posting
purposes is considered a telephone vendor. Therefore, the user sets up a GL
posting table TEL-telephone. When posting most phone bills from Southern
Bell, the user normally expenses to the telephone GL expense account.
However, occasionally the user advertises in the yellow pages and when those
bills are entered, they are expensed to the advertising GL expense account. The
user sets up the GL posting table as follows:

GL Table  TEL
Description Telephone

G/L # Description

Expense1 735-00-00 Telephone

2 710-00-00 Advertising

3

4

5
Accounts Payable 310-00-00 Accounts
Payable
Discounts 490-00-00 Discounts Taken

In Document Entry, if the GL posting table is TEL for the invoice being entered,
the system automatically defaults to 735-00-00 for the first GL number to be
expensed. The user also may perform a search to display all of the GL expense
numbers set up in the TEL GL posting table. In the example given, 735-00-00
telephone and 710-00-00 advertising are displayed.

Therefore, when a regular telephone bill is entered, the user may allow the
system to default to 735-00-00 telephone. However, when an occasional
advertising bill is entered, the user may search to see the other possible expense
GL numbers to use.

If the Post by Branch flag is set to Y in the AP static control record, the
Document Entry program automatically inserts the branch in the proper
position in the GL number when displaying the expense numbers of the GL
posting table.

Within each GL posting table there is also an account number for accounts
payable. This number is posted when entering an accounts payable document
or writing a check and paying it off. The discounts number is posted when a
discount is taken, i.e., when the payment is made and the check is written.
Discounts are not posted upon initial entry of the document, but when the
discount is entered when payment is made (i.e., when the discount is taken).
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If the user enters two bills for Southern Bell - a telephone bill for $350 and an
advertising bill for $150, the summary Document Entry Register GL
distribution using the GL posting table listed above would be as follows:

Debit Credit
310-00-00 Accounts payable -500.00
730-00-00 Telephone 350.00
710-00-00 Advertising 150.00

If the user pays the two bills and takes a 2% discount on the advertising bill, the
summary Check Register GL distribution using the GL posting table listed
above would be as follows:

Debit Credit

*100-00-00 Cash in Bank -497.00
310-00-00 Accounts Payable 500.00

490-00-00 Discounts Taken -3.00

* The cash G/L number comes from the Bank G/L number set up in the
Bank F/M in the banking and check system in system management.

If the Post by branch flag is set to Y in the AP static control record, the
Document Entry & Adjustments Register and Check Register automatically
insert the branch (assigned to each document) in the AP and discounts GL
numbers when posting to general ledger.

When setting up the GL Posting Tables, because they are user-defined, there is
no limit to the number set up. Any of the expense numbers may be entered as
defaults in the AP Document Entry. The AP and Discount G/L numbers are
mandatory numbers and may not be overridden during entry of current
payment selection or check writing.

If a loan is to be entered and the balance posts to Notes Payable rather than an
accounts payable account, when setting up GL posting tables, one may be set
up as follows:

GL Table LN

Loans

G/L# Description

* Expense 1
* 2
* 3
* 4
* 5
Accounts Payable 320-00-00 Notes Payable
Discounts 490-00-00 Discounts Taken

* If a GL posting table is set up with no expense accounts, the user has no
default expense numbers in Document Entry.
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The Document Entry program, Document Entry & Adj. Register and Check
Register programs use information stored in these records.
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Posting to Job Cost from Accounts Payable

During the Document Entry program the user may post any part of an invoice
(bill) to a job number, to post to Job Cost. If job cost information is entered the
default GL expense account number is no longer the number as set in the GL
posting table. The default GL expense account number comes from one of two
places. If the Post work-in-process flag is set to Y in the JC to GL Posting F/M
program, the default expense GL number is a work-in-process account number.
Depending on the Basis flag set in this record for work-in-process, the default
number is used or the work-in-process account number is assigned to the cost
type for the GL posting table assigned to the job. If the Post work-in-process
flag is set to N, the default expense GL number is the expense number assigned
to the cost code entered for the job.

The Document Entry & Adj. Register GL distribution posts to GL as follows:

Debit Credit
Work in-Process GL # Accounts Payable
or
Expense GL #

The work-in-process or expense GL number also posts into the JC Job Posting
Entry file. The Job Posting Register is then run which updates the WIP or
expense GL number to the Job Cost transaction file. This transaction file is used
for billing purposes.

Once billing takes place, the JC Invoice Register is printed along with the
Invoice Register GL distribution.

The GL distribution posts as follows:

Debit Credit
Accounts Receivable Sales
Tax
Freight
Cost of Sales Work in Process
or
Expense GL #

The WIP or expense GL number was originally debited in Accounts Payable
and in Job Cost is credited. This means the WIP or Expense number is a wash
account with the amount posting to the Cost of Sales GL account number.
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Standard Procedures

The standard procedures may vary depending on how your company's
business is conducted. The following three sections of standard procedures are
provided as a guideline:

1) Recommended Operating Procedures. An outline is provided of routine
procedures on a daily, weekly, period (month, if 12 periods are used) and
yearly basis.

2) End-of-Period Checklist. The end-of-period procedures are critical to the
proper functioning of the system. Certain programs must be run in a
specific order to close the accounts payable module accurately.

It is suggested that copies of the checklist be made and used for each
period close-out to be filed for future reference.

3) End-of-Period Checklist Explanation. A detailed account of the purpose
of each program on the checklist.

FACTS AP 1-17



System Overview

Recommended Operating Procedures

Daily Procedures (or as needed)

—_

VPN PN

Enter documents

Post Recurring Documents (if applicable)
Print/update Document Entry & Adjustments Register
Make payments

Print Payment Selection List

Print checks

Enter manual, void, non-invoice checks

Print/update Check Register

Print Cash Requirements Report

Period Procedures (or as heeded)

*1.
*2.
*3.
4.
5.
6.

7.
*8.
*9.
*10.
*11.
*12.
13.

Post Recurring Documents through last day of period (if applicable)
Print/update last PO Invoice Receipt Register (if used)
Print/update last Document Entry & Adjustments Register
Print/update last Check Register

Print Open Payables Report

Print Aged Payables Report

Run Vendor Ledgercards print

Print/update Period Check Register (if used)

Print/update Period Expense Distribution (if used)
Print/update Disbursement Distribution (if used)
Print/update Register History Report

Print/update Document Removal Register

Run Vendor Ledgercard Removal

*14a. Run 1099 Print after the last check run in December.
*14b. Run End-of-Period Update

Yearly Procedures

1.

Run the End-of-Period Update. (If you did this as part of your
period procedures do NOT run this program.) If your year ends in
December, remember to run the 1099 Print program after the last
check run and before the End-of Period Update. If you fail to run
the 1099 Print before you close out December, you will lose all
payroll information on contractors.

* indicates the procedure is required and must be performed in the time period
designated

1-18
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System Overview

End-of-Period Checklist - Accounts Payable

Period _ Year

User Date Menu

Recurring

PO Invoice

Doc Entry

Checks

Reports

Reports

Reports

EOP

EOP

EOP

EOP

EOP

EOP

EOP

EOP

FACTS AP

Description

1.

10.

11.

12.

13.

Post Recurring Documents through last day of
period

Print/update last PO Invoice Receipt Register
Receiving

Print/update last Document Entry Register
Print/update last Check Register

Print Open Payables Report (detail with
transactions)

Print Aged Payables Report (detail with
transactions)

Run Vendor Ledgercards print
Print/update Period Check Register
Print/update Period Expense Distribution
Print/update Disbursement Distribution
Print/update Register History Report
Print/update Document Removal Register

Run Vendor Ledgercard Removal

14a. If December, run 1099 Print program before you

close.

14b. Run End-of-Period Update
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End-Of-Period Checklist Explanation

1.

2-4.

5-6.

Post Recurring Documents through last day of period. If Recurring
Documents are used, in order to close the current period, this
procedure must be complete. The End-of-Period Update checks to
make sure that the last day posted is the last day of the month. The
reason for this check is to ensure that the user posts all recurring
documents in the correct period.

Print/update last PO Invoice Receipt Register, Document Entry &
Adjustments Register and Check Register. The PO Invoice Receipt
Register must be run before the AP End-of-Period Update. Running
this register is necessary to ensure that PO invoice receipts from the
current period are written to the Document Entry and Adjustment
File (APDOCM). The Document Entry & Adjustments Register and
the Check Register must be run to keep the AP balance up to date. If
either of these registers are run after the period is closed, the
documents and/ or checks are posted to the next period.

Print Open Payables Report and Aged Payables Report (detail
with transactions). These reports provide the user with a report of
all transactions that have taken place against all documents
including zero balance documents (paid down to zero). These
documents and transactions will be removed by the Document
Removal Register (#11). It is recommended that a hard copy of each
report be saved for future reference

Run Vendor Ledgercards print. If vendor ledgercards are used, this
program provides the user with a list of all transactions that have
occurred on vendor accounts. These transactions will be removed
by the Vendor Ledgercard Removal (#12). It is recommended that a
hard copy be saved for future reference.

Print Period Check Register. This register allows the user to obtain
a listing, grouped by bank, of all regular, manual, noninvoice and
void checks for the period. This register is a summary of the Check
Registers printed for the period. After the report prints, the user
should remove the records just printed to clear the file. If records
are not removed, they will appear on next period's register. All
Period Check Registers should be kept as an audit trail.

Print Period Expense Distribution. This report allows the user to
obtain a list of all general ledger expense distributions for the
period. This report is a summary of all general ledger expense
distributions from the Document Entry & Adjustments Registers for
the period. After the report prints, the user should remove the
records just printed to clear the file. If records are not removed, they
will appear on next period's register. All Expense Distribution
Reports should be kept as an audit trail.

Accounts Payable—7.7
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10.

11.

12.

13.

14a.

14b.

FACTS AP

Print Period Disbursement Distribution. This report allows the
user to obtain a list of all general ledger disbursements distributions
for the period. This report is a summary of the general ledger
distributions from the Check Registers for the period. After the
report prints, the user should remove the records just printed to
clear the file. If records are not removed, they will appear on next
period's register. All Disbursement Distribution Reports should be
kept as an audit trail.

Print Register History Report. This report allows the user to obtain
a list of all registers (Vendor Balancing, Document Entry &
Adjustments, Check) for the period and update the AP balance. This
report provides a trace of what transactions occurred to obtain the
current AP balance. After the report prints, the user should remove
the records just printed to clear the file. If records are not removed,
they will appear on next period's register. All Register History
Reports should be kept as an audit trail.

Print Document Removal Register. This register allows the user to
obtain a list of all documents that have been paid down to zero in
the current period. After the register prints, the user should remove
the records just printed to clear the file. If records are not removed,
they will appear on next period's register. During the removal of the
records, the program also updates the paid documents file. All
Document Removal Registers should be kept as an audit trail.

Run Vendor Ledgercard Removal. If Vendor Ledgercards are used,
this program is run to remove ledgercard information. The user
determines the cutoff date through which to remove ledgercard
information.

In December, run 1099 Print. Run this before you close December.
Otherwise, payroll information for contractors will be lost.

Run End-of-Period Update. This is the last step to closing the
accounts payable current period and should only be run after all of
the above procedures have been completed. The program removes
all temporary vendors with a zero balance, removes documents from
the paid documents file which are stored longer than the number of
periods specified in the AP company static control record, clears
month-to-date vendor information and closes the current period. If
it is the last period of the year, year-to-date figures are rolled to prior
year. When this program is complete, the user may begin daily
procedures in accounts payable in the new (current) period.
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CHAPTER 2

Document Entry

This menu is used for entering all open payables (invoices) into the Accounts
Payable system. Users enter documents through the Document Entry program
or the system can generate open payables through the Recurring Payables
Submodule.

When documents (payables, invoices) are entered through Document Entry,
each document must be expensed to one or more General Ledger account
number(s) (up to 999). Through the use of the Accounts Payable General
Ledger groups, default General Ledger expense account numbers may be set
up for each vendor (see section on General Ledger groups).

Documents that are entered will not update the open documents file until the
Document Entry & Adjustments Register has been run and updated.

Therefore, if a document has been entered incorrectly and has not been
updated, the user may use Document Entry to correct the invoice. The
Document Adjustment Entry program is used to adjust AP invoice amounts,
which have already been entered, updated, and are in the open documents file.
Adjustment entries are not updated until the Document Entry & Adjustments
Register is run and updated. The Document Change F/M allows the user to
change dates on invoices and will affect documents in the open documents file
without running the register.
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Document Entry (APE110)

Function

This program allows the user to enter vendor documents (invoices and credit
memos) into the Accounts Payable system.

The document entry screen consists of two sections. The upper portion of the
screen is called the header portion where the vendor number, invoice number,
etc. are entered. The lower portion is called the line-item portion where each
GL expense account number is entered.

After documents are entered, they stay in the document entry file until the
Document Entry & Adjustments Register is run and updated. This allows the
user to make changes to the document. The update following the register will
remove the documents from the document entry file and update the open
documents file. Note also that the vendor balance and the current AP balance
are not updated until the register is updated. Corrections to documents still in
the document entry file are entered through the Document Entry program.
Documents that have been updated to the Open Documents File are corrected
through the Document Adjustment Entry program.

Updating past open payables: The Accounts Payable section of the “Operational
Analysis Survey” asked the following question: Maximum # of invoices
entered per period? This number divided by four is the number of payables
that can be entered before you run the Document Entry Register. You may want
to temporarily expand the Document Entry File to avoid running out of file
space.

The Document Entry Screen consists of two sections: the header and line-item
entry. The upper section of the screen is the header. This is where you enter the
vendor number, invoice number, and other document particulars. The lower
portion of the screen is the line-item entry section where you enter each general
ledger expense account number.

Once documents have been entered, they remain in the Document Entry File
until someone runs the Document Entry & Adjustments Register. If you need to
make changes to any of the documents and no one has run the register yet, use
the Document Entry program to edit the documents.

The update that follows the register removes the documents from the
Document Entry File and updates the Open Documents File. Note also that the
vendor balance and the current AP balance do not update until someone runs
and updates the register. Documents that have been updated to the Open
Documents File need to be corrected in the Document Adjustment Entry
Program.

Access this program by choosing Accounts Payable ?Document Entry ?Document Entry.
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User Fields

The following fields are involved in entering an accounts payable document:
1. Period

Enter the period (PPYY) the expense account distribution should be posted to in GL. Press Enter
(CR) or the E icon to set the document to the current AP period. The period entered may be either
the current or next GL period.

2. Vendor

Enter the vendor number for this document. If the vendor number is not a valid vendor number,
you can add a new vendor by answering yes when the system asks if you want to add a new
vendor. If the user chooses to add the vendor, the program proceeds to the Vendor F/M screen.
After the addition is complete, the system returns you to the Document Entry screen. Entry of a
valid number displays the name, address, GL posting table, document group, branch, terms code,

and message for this vendor. If the vendor is inactive, the entry is refused. Press the 'J--:I icon or F3
to perform a document search (i.e., documents entered into the document entry file, but not yet
updated to the open documents file).

3. Document Number
Enter the document number (up to 10 characters). This entry is checked against the past and open
document files. If the entered document number is a duplicate for this vendor, a message is
displayed and the entry refused. If the document has been currently entered and is in the

document entry file, the system will display the document on the screen and the user may make
any changes needed.

4. PO Number (Purchase Order Number)
Enter the purchase order number (up to 12 characters). Press Enter (CR) to default to 000000000000
for the PO number.

5. GL Tbl (General Ledger Table)

Enter the GL posting table. The entry must be a valid posting table. Press Enter (CR) to default to

the value already displayed, initially the posting table assigned to the vendor. Press ~—* or F2 to
search.

6. Doc Grp (Document Group)
Enter the document group (up to 2 characters). Press Enter (CR) to default to the value already
displayed, initially the document group assigned to the vendor in Vendor F/M.

7. Branch

Enter the branch number. The entry must be a valid branch. Press Enter (CR) to default to the
branch assigned to the terminal entering the document. Press —% or F2 to search.

8. Terms (Code)
Enter the payment terms code. The entry must be a valid terms code. Press Enter (CR) to default to
the value already displayed, initially the terms code assigned to the vendor in the vendor file. An

M (manual) terms code will force the user to enter due dates and discount amount. Press —= or F2
to search.

9. Document Amount
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10.

11.

12.

13.

14.

15.

16.

Enter the document amount (+/-9999999.99). Zero amounts are not accepted. A negative number
indicates a credit memo or credit adjustment.

Discountable Amount

Enter the amount to compute the discount on (+/- 9999999.99), i.e., freight may be included in the
document amount, however, not eligible for discount. Press Enter (CR) to default to document
amount.

Document Date

Enter the date of the document. The entry must be a date prior or equal to a date in the next GL
period. CR defaults to the system date.

Due Date

Enter the due date. Press Enter (CR) or the E icon to automatically calculate the due date,
discount amount and date based on the Terms Code. If the due date is calculated, skip to field #15.
If the terms code is M (manual), fields #12-14 must be entered.

Discount

This may be entered as an amount or as a percent of the document amount. Enter the discount as a
dollar amount or as a percent. If entering as a percentage, type the number required and a percent
(%) sign.

Discount Due Date

Enter the discount due date.

Memo

Enter any memo (up to 25 characters). This memo will print on the check stub in the Comments
column. Press F4 to back up to the discount due date.

This concludes the header portion of the Document Entry program. After the header record is
created, all previous fields except #1-3 are accessible through the change header routine. Fields #1-
3 can only be changed by deleting and re-entering the document.

The line-item portion of the program allows entry of up to 999 line-items.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999.

G/L Number

Enter the GL expense account number to which this document will be distributed. If the entire
amount of the document is not to be distributed to this account, enter other account numbers in
subsequent line-items. The number entered must be a valid GL number. If the GL posting table for
this document has preset expense accounts, CR defaults to the first GL account number in the GL
posting table. Press F2 to view all GL numbers listed for the GL posting table assigned to this
document and their descriptions.

If this entry is to post to Job Cost, press F2 or the @ icon to display Job Posting Entry screen,
where you can enter the job number and proceed to the next field. If you are not entering Job Cost
information, proceed to field # 25.
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Job Posting Entry Screen
Refer to fields 17-24 to enter job cost information.
17. Job Number

Enter the valid job number to post this entry against. Entering a valid job number displays the job
name, customer number and name, and billing type. Press Enter (CR) to default to the last job

number entered (if any). Press — or F2 to search.

18. Price Message

If the billing type for the job entered is fixed, contract or time and material, this field is skipped. If
the billing type is cost + (plus) or no charge, the program displays the price (bill rate) that will be
used to calculate the extension. If the job is no charge, then the markup method can be changed if
the Allow billing override flag for the cost code is set to Y and neither the bill rate nor extension
will be affected. Press Enter (CR) to continue.

19. Cost Code

Enter a valid cost code (up to 4 characters). Entering a valid cost code displays the cost code
description and the cost type. If the cost code is not set up to use units (unit of measure field is
blank in Cost Code F/M), the program displays a message displaying this information. The cost
code sets the defaults for markup method (for all jobs that are not billed as cost plus) and the
billing rate for jobs that are billed as a fixed contract or as time and material. If the billing type is
not cost plus, the cost code also determines whether the user is able to override the markup

method and/ or bill rate. Press —% or F2 to search.
The item entry determines the units, unit of measure and cost rate/extension.
20. Markup

This field is initially skipped and set to the markup assigned to the cost code. This may only be
entered for jobs which are time and materials or fixed contracts and the Allow override of billing
flag is set to Y in the cost code record. This may also be changed for no charge jobs but the bill rate
is not affected.

Enter the markup method to use for this posting entry. The user has the following options:

# - Enter the markup amount (0-9999999.99%). Entering a number tells the system to mark up
the cost by a dollar amount. The system marks up the cost rate by the dollar amount and
calculates the bill extension.

#+% - Enter the percentage (0-9999999.99%) to mark up the cost. To enter a percentage, the user
must enter an amount and then the percentage sign. If no percentage sign is present, the
system assumes the entered amount is a dollar amount. The system marks up the cost rate
by the percentage amount and calculates the bill extension.

M - Enter the bill rate manually. Entering M displays the word MANUAL and the program
proceeds to the bill rate field (#21).

The fixed markup method is unavailable for selection, but can be used. To utilize the fixed method,
select a cost code whose markup method is fixed.

Press Enter (CR) to initially default to the markup method (amount/percentage) from the cost code
record.

21. Bill Rate

This field is unavailable if the Allow billing override flag is set to N in the Cost Code F/M. This
field is initially skipped unless the markup method of the cost code is manual. Enter the price per
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displayed unit of measure. The bill extension is calculated and displayed. Press Enter (CR) to
initially default to 0.

22. Memo

Enter the memo (to print on invoice - see next field) for this posting entry (up to 30 characters).
Press Enter (CR) to initially default to blanks.

23. Print memo on job cost invoice?

This field is initially skipped if the print order for invoice transactions flag in the jobs file is not set
to A. Enter N or Y to indicate whether to print the memo on the job cost invoice. Press Enter (CR)
to initially default to N.

24. General Ledger Number

Enter the GL expense account to which this document will be distributed. The number entered
must be a valid GL number. If the GL posting table for this document has preset expense accounts,
press Enter to default to the first GL account number in the GL posting table and all of the GL
posting table may be displayed by pressing F2-search. This search displays all GL numbers listed
for the GL posting table assigned to this document along with the GL numbers description. If the
Post by branch flag is set to Y in the static control record and the account number is selected from
the initial search, the GL account expense numbers assigned to the GL posting table are displayed
with the branch assigned to the document (field #7) inserted in the branch position. Select the line
number of the GL account number to expense to. F2 allows a GL numbers alpha search. Any
account number may be typed in place of the standard numbers from the GL posting table. If you
access the full GL account search feature or manually enter the account number the system does
not insert the branch. If the entire amount of the document is not distributed to this account, the
next account number will be entered on line 002. This continues until the document amount is
distributed.

25. Amount

Enter the amount to be distributed to this GL number (+/-9999999.99). This may be entered as an
amount or as a percent of the original undistributed amount (document amount). If entering a
percentage, type the number required and a percent (%) sign. Zero amounts are not accepted. Press

Enter (CR) or E to default to the document amount not yet distributed (undistributed). The
ending routine may not be accessed until the entire document amount has been distributed.

If you entered a job number in the G/L number field to post this entry to a job, the system supplies
the amount from the Cost ext field in the Job Posting Entry window. In this case, the Amount field
is initially skipped. Then, the system asks for the expense GL account number. Press Enter (CR) to
default to the account number from Job Cost.

This concludes the line-item portion of the Document Entry program. Press F3 or the (%) icon to
end line-item entry and access a number of functions:

L

7. Changes the highlighted line-item
EE:' - Adds a line-item
H - Deletes the document

 Inserts a line item above the highlighted line in the browser.
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After you complete line item entry processing and select the (% icon, you can press the Header

button to access the Header Detail screen where you can review header details and modify the
document amount or header memo.

Press the Done button to complete the document entry.

T 01-FACTS 7.7 Development, Document Entry (APE110} - Infor — |E||ﬂ
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How to enter an AP Document header

1.
2.

10.

11.

12.

Access this program by choosing Accounts Payable->Document Entry->Document Entry.

Enter the Period (PPYY) in which the expense account distribution should be posted in the

General Ledger. Press Enter (CR) or the I;—-l icon to set the document to the current AP period.
to the current accounts payable period. The period entered may be either the current or next
general ledger period.

Enter the Vendor Number for this document. If the vendor number is not a valid vendor
number, there is an option to add the vendor. If the user chooses to add the vendor, the
program proceeds to the Vendor F/M screen. After the addition is complete, it will return to the
Document Entry screen. Entry of a valid number displays the name, address, General Ledger
posting table, document group, branch, terms code, and message for this vendor. If the vendor
is inactive, the entry is refused. Press F3 to perform a document search (i.e., documents entered
into the document entry file, but not yet updated to the open documents file).

Enter the Document Number (up to 10 characters). This entry is checked against the past and
open document files. If the entered document number is a duplicate for this vendor, a message
is displayed and the entry refused. If the document has been currently entered and is in the
document entry file, the system will display the document on the screen and the user may make
any changes needed.

Enter the Purchase Order Number (up to 12 characters). The PO number can be alphanumeric.
Press Enter (CR) to default to 000000000000 for the PO number.

Enter the General Ledger Posting Table. The entry must be a valid AP General Ledger posting
table. Press ENTER (CR) to accept the value already displayed, initially the GL posting table
assigned to the vendor. Press —% or F2 to search.

Enter the Document Group (up to 2 characters). Press ENTER (CR) default to the value already
displayed, initially the document group assigned to the vendor in the vendor file.

Enter the Branch Number. The entry must be a valid branch. Press Enter (CR) to default to the
branch assigned to the terminal entering the document. Press — or F2 to search.

Enter the payment Terms code. The entry must be a valid terms code. Press Enter (CR) to

default to the value already displayed. Initially the terms code assigned to the vendor in the
vendor file. An M (manual) terms code forces you to enter due dates and discount amount.

Press —% or F2 to search.

Enter the Document Amount (+/-9999999.99). The system does not accept zero amounts. A
negative number indicates a credit memo or credit adjustment.

Enter the Discount Amount, which is the amount to compute the discount on (+/- 9999999.99).
For example, the document amount may include, but freight may not be eligible for discount.
So the document amount minus the freight would be the discount amount. Press Enter (CR) to
default to the document amount.

Enter the Document Date. The entry must be a date prior or equal to a date in the next GL
period. Press Enter (CR) to default to the system date.
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13.  Enter the Due Date. Press Enter (CR) or the E icon to automatically calculate the due date,
discount amount and discount date based on the Terms Code. If the due date is calculated, skip
to Step 15 and enter the Memo. If the terms code is M (manual), enter the information required
in Steps 12-14.

14.  Enter the Discount. This can be a dollar amount or a percent of the document amount. Press
Enter (CR) if you want to enter the discount in terms of dollars. To enter the discount as a
percentage, type the number followed by the percent (%) sign. The system automatically
calculates the discount in terms of dollars.

If a discount doesn’t apply, press F1 to skip this entry.

15.  Enter the Discount Due Date. This is the date by which the invoice has to be paid in order to
receive the discount. If a discount doesn’t apply to this document, press F1 to skip the entry.

16.  Enter any Memo up to 25 characters. This memo prints on the check stub in the Comments
column. F4 backs up to the discount due date.

5 To enter line items for AP documents, refer to the Entering AP Document line-items topics.
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How to enter AP Document line-items

1. Access this program by choosing Accounts Payable>Document Entry->Document Entry. For
existing documents, enter the period, vendor and document number. For new documents,
complete the header information; refer to the How to enter an AP Document header procedure
for details.

The line-item portion of the program enables you to post the document amount to as many as
999 GL numbers.

The system automatically assigns line numbers beginning with 001.

2. Enter the GL Expense Account Number (If this entry is to post to Job Cost, press F2 or the N
icon to display Job Posting Entry screen) to which this document amount will be distributed. If
you want the entire amount of the document is not to be distributed to this account, enter other
account numbers in subsequent line-items. The number entered must be a valid GL number. If
the general ledger posting table for this document has preset expense accounts, the system

displays the first GL account number in the GL posting table as the default. Press F2 or — to
view all GL numbers listed for the GL posting table assigned to this document and their
descriptions. This search displays all GL numbers listed for the GL posting table assigned to
this document along with the GL numbers description. If the Post by branch flag is set to Y in
the static control record and the account number is selected from the initial search, the GL
account expense numbers assigned to the GL posting table are displayed with the branch
assigned to the document (field #7) inserted in the branch position. Select the line number of the
GL account number to expense to. F2 allows a GL numbers alpha search. Any account number
may be typed in place of the standard numbers from the GL posting table. If you access the full
GL account search feature or manually enter the account number the system does not insert the
branch. If the entire amount of the document is not distributed to this account, the next account
number will be entered on line 002. This continues until the document amount is distributed.

If this entry needs to post to Job Cost, enter ] to enter the job number and refer to the Job Posting
Entry topic for field descriptions.

3. Enter the Amount that you want to distribute to this GL number (+/-9999999.99). You can enter
an amount or as a percent of the original undistributed amount (document amount). To enter a
percentage, type the number required and a percent (%) sign. You cannot enter zero as an

amount. Press Enter (CR) or E to default to the document amount not yet distributed
(undistributed). The ending routine may not be accessed until the entire document amount has
been distributed.

If you entered a job number in the G/L number field to post this entry to a job, the system
supplies the amount from the Cost ext field in the Job Posting Entry window. In this case, the
system initially skips the Amount field. Then, the system asks for the expense general ledger
account number; press Enter (CR) to default to the account number from Job Cost.

Press Enter (CR) to accept the line.

4. Press F3 or the (% when you are finished entering line-items. Once you have completed the
header and the line-item entry sections, the following functions are available.
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. Changes the highlighted line-item
EII}' - Adds a line-item
R - Deletes the document

@ Inserts a line item above the highlighted line in the browser.

5. After you complete line item entry processing and select the (% icon, you can press the Header
button to access the Header Detail screen where you can review header details and modify the
document amount or header memo.

Press F3 or the Done button and the system returns you to Vendor field so you can specify a
vendor and enter additional AP documents in the displayed period. You can enter a vendor
code, press F4 to back up to the Period field and modify the period, press F3 or the Done button
to exit the program.
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Document Adjustment Entry (APE120)

Function

This program allows the user to enter adjustments to documents in the open
documents file.

Adjustments made to the current amount may be either positive or negative.
This amount is distributed into General Ledger account(s). The changes are
written to the document entry file and no updates are done at this time in the
open documents file. The vendor’s balance and the open documents are not
updated (along with the General Ledger) until the optional update following
the Document Entry & Adjustments Register. The Document Entry &
Adjustments Register will provide an audit trail of adjustments made in this
program.

Access this program by choosing Accounts Payable 2>Document Entry >Document Adjustment Entry.

User fields

The following fields are involved in entering an adjustment.
1. Period

Enter the period (PPYY) to which the general ledger distribution should be posted. Press Enter

(CR) or the = icon to default to the current accounts payable period. The period entered may be
either the current or next general ledger period.

2. Vendor

Enter the vendor number for the requested document. Press —= or F2 to search. Press the o icon
or F3 to perform a document search, (i.e., adjustments entered into the document entry file, but not
yet updated to the open documents file).

3. Document number

Enter the document number for the adjustment. The number must be on file for this vendor in the
open documents file. If another adjustment was previously made, and not yet updated, the
adjustment is displayed and the program proceeds to the Prompt-selection field. When you enter a
valid document number, the system displays the PO number, general ledger posting table,
document group, branch, original amount and current amount. If the document is on hold, the
system displays a message to this effect and you must press Enter (CR) to return to the field. Press

F2 or the —% icon to perform a search of open documents for the displayed vendor.

4. Adjustment amount
Enter the amount of the adjustment (+/-9999999.99). The original, current and adjusted amount of
the document is displayed.

5. Memo

Enter the adjustment memo (up to 25 characters). This memo prints on the Document Entry &
Adjustments Register.

‘& This concludes the header portion of the Adjustment Entry program. After the
header record is created, the adjustment amount and memo are accessible
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through the change header routine in the Prompt-selection field. Fields #1-3 can
only be changed by adjusting the document to a zero balance and re-entering the
document through the entry program with a different document number.

Line numbers are assigned automatically beginning with 001 and incrementing by
one for each additional line-item up to 999. In the rare case that 999 line-items
have been entered on a single document, the program advances to the Prompt-
selection field.

6. G/L number, Job number

Enter the GL expense account number to which this document will be distributed. If the entire
amount of the document is not to be distributed to this account, enter other account numbers in
subsequent line-items. The number entered must be a valid GL number. If the GL posting table for
this document has preset expense accounts, CR defaults to the first GL account number in the GL

posting table. Press —% or F2 to view all GL numbers listed for the GL posting table assigned to this
document and their descriptions.

If this entry needs to post to Job Cost, enter J to enter the job number and refer to the Job Posting
Entry topic for field descriptions.

7. Amount

Enter the amount to be distributed to this general ledger number (+/-9999999.99). You cannot enter

zero amounts. Press Enter (CR) defaults or the = icon to set the document to default to the
adjustment amount not yet distributed. You cannot access the ending routine until the entire
adjustment amount is distributed.

8. This concludes the line-item portion of the Document Adjustment Entry program. Press F3 or the@
to end entries of line-items and allows the user to perform a number of functions:

[ Changes the highlighted line-item
I:II:II:| - Adds a line-item
H - Deletes the document

" Inserts a line item above the highlighted line in the browser.

9. After you complete line item entry processing and select the (%) icon, you can press the Header
button to access the Header Detail screen where you can review header details and modify the
document amount or header memo.

10. Press F3 or the Done button and the system returns you to Vendor field so you can specify a
vendor and enter additional AP documents in the displayed period. You can enter a vendor code,
press F4 to back up to the Period field and modify the period, press F3 or the Done button to exit
the program.
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T 01-FACTS 7.7 Development, Document Adjustment Entry (APE120) - Infor - |D|ﬂ
File Edit ©Options GoTo Help

Feriod | ooizo04

AP CP=09/2004 SEP
Yendar V113 Document I:I

Balance

Atlanta Crane & Haists PO¥ Qriginal
147 3. Dekalh Drive GLTbl | 005 Current
Doraville, GA 30341 DocGrp | o oI
Branch 01 Adjust Amount
Memo | |
o ol — = |
g | BL# | Description Amount Job # |

Undistributed: .00
[ Header | [ Done
Enter docurment number, F2-Open Doc Search |2 WEEK LEAD TIME

FACTS AP 2-15



Document Entry Accounts Payable—7.7

How to enter adjustments to AP documents

1. Access this program by choosing Accounts Payable> Document Entry->Document Adjustment
Entry.

2. In the Period field, enter the period (PPYY) to which the general ledger distribution should be

posted. Press Enter (CR) or the E icon to default to the current accounts payable period.

3. In the Vendor field, enter the vendor number for the requested document. Press % or F2 to

search. Press the 'LJ icon or F3 to perform a document search, (i.e., adjustments entered into the
document entry file, but not yet updated to the open documents file).

4. In the Document field, enter the document number for the adjustment. The number must be on
file for this vendor in the open documents file.

If another adjustment was previously made, and not yet updated, the adjustment is displayed,
and the program proceeds to the Prompt-selection field.

When you enter a valid document number, the system displays the PO number, general ledger
posting table, document group, branch, original amount and current amount. If the document is
on hold, the system displays a message to this effect and you must press Enter (CR) to return to

the field. Press —% or F2 to perform a search of open documents for the displayed vendor.

5. Enter the amount of the adjustment (+/-9999999.99). The original, current and adjusted amount
of the document is displayed.

6. Enter the adjustment memo (up to 25 characters). This memo prints on the Document Entry &
Adjustments Register.

,&‘ This concludes the header portion of the Adjustment Entry program. After the header record is
created, the adjustment amount and memo are accessible through the change header routine in
the Prompt-selection field. Fields #1-3 can only be changed by adjusting the document to a zero
balance and re-entering the document through the entry program with a different document
number.

7. In the G/L# field, enter the GL expense account number to which this document will be
distributed. If the entire amount of the document is not to be distributed to this account, enter
other account numbers in subsequent line-items. The number entered must be a valid GL
number. If the GL posting table for this document has preset expense accounts, CR defaults to

the first GL account number in the GL posting table. Press F2 or the = icon to view all GL
numbers listed for the GL posting table assigned to this document and their descriptions.

If this entry needs to post to Job Cost, press @ to enter the job number and refer to the Job
Posting Entry topic for field descriptions.

8. In the Amount field, enter the amount to be distributed to this general ledger number (+/-

9999999.99). You cannot enter zero amounts. Press Enter (CR) or the Ii—-l icon to default to the
adjustment amount not yet distributed. You cannot access the ending routine until the entire
adjustment amount is distributed.
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Press Enter (CR) to accept the line.

9. This concludes the line-item portion of the Document Adjustment Entry program. Press F3 or

the @ icon to end line-item entry, and the program advances to the Prompt-selection field that
allows the user to perform a number of functions:

g Changes the highlighted line-item

AP . Adds a line-item

R - Deletes the document

@ Inserts a line item above the highlighted line in the browser.

10.  When you have completed your changes to the document, press F3 or the Done button. The
system returns you to Vendor field so you can specify a vendor and enter additional AP
documents in the displayed period. You can enter a vendor code, press F4 to back up to the
Period field and modify the period, or press Done or F3 to exit the program.
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Document Change F/M (APF110)

Function

This program allows the user to change the following information about a
document in the open documents file.

e  Current discount

e Purchase order number
e Entry date

e Due date

e Discount due date

e Entry period

e Memo

e Document group

The fields above may be changed without affecting the amount of the
document or the GL distribution. In order to make amount changes to the
document or GL expense distribution, the user must use the Document
Adjustment Entry program and run the Document Entry & Adjustments
Register.

Access this program by choosing Accounts Payable ?Document Entry Document Change F/M.

User fields

To modify a new vendor/document combination, select I_E New.

1. Vendor #

You can scroll through documents by vendor and document number combination. Press F3 or id

to view the first record on file. Press Enter (CR) or [ to or scroll to the next record. Press F2 or —
to search by vendor number.

2. Document #

You can scroll through documents by vendor and document number combination. Press F3 or id

to view the first record on file. Press Enter (CR) or > to or scroll to the next record. Press F2 or —=
to search by document number.

3. The following information appears for each document but cannot be changed from this program:

Document type Last sequence number
Original amount Register Number
Original discount GL Table

Current amount Branch

4. Current Discount

The current discount associated with this document. (0.00 to invoice amount).
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5.PO #

The purchase order number associated with this document. You can enter up to 12 characters.
6. Entry date

The entry date for this document.
6. Due date

The due date associated with this document.

7. Discount due date

The new due date for any discounts.

6. Entry period

The period in which the document was entered (PPYY). The entry period must coincide with the
entry date.

7. Memo

The memo that appears in the header portion on the check. You can enter up to 25 characters.
8. Document group

The document group code (up to 2 characters) for this character. Document groups are established
in Vendor F/M.

You can select:
HSave to save or changes.
HDelete to delete the vendor and document number record information.
Exit to exit the program.

LZENew to open a different document.
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Document Entry & Adjustment Register (APR110)

Function

This program allows the user to list all documents and adjustments in the
current or next period entered since the last Document Entry & Adjustments
Register was run.

The user has the option to:

Print a listing of all documents entered and adjustments made.
Build and print a General Ledger distribution, if desired.

Post to General Ledger, if a General Ledger distribution is built.
Update the open documents file and the vendor balance.

Update the monthly expense distribution file.

Update the company accounts payable balance, clear the document
entry file and update the appropriate control records.

Note that the AP Document Entry and Adjustment Register now
requires an escape code for a user to get out of an error which occurred
during the update portion of the register.

Information on this register includes the following;:

Document Entries: Period, branch(es) selected, vendor number and
name, document number, branch, GL posting table, PO number, entry
date, due date and discount date, gross amount, allowable discount
amount, GL account number and the posting amount.

Document Adjustments: Vendor number and name, document number,
current amount, adjustment amount, new current amount, memo, GL
account number and the posting amount.

A recap is given of the AP balance including the following: the beginning
balance, entry total, adjustment total, ending balance and total documents listed
on the register. Depending on the flag in the AP static control record, the user
may obtain a general ledger distribution printout.

Access this program by choosing Accounts Payable ?Document Entry >Document Entry and Adjustment
Register.

User Fields

The following fields are involved in printing and updating the Document Entry & Adjustments
Register:

1. Period

Enter whether to print Current period or Next period documents. Press Enter (CR) to default to C.
2. Branch

Enter the branch number. The entry must be a valid branch. Press Enter (CR) or " to default to
ALL. Press F2 or — to search.
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The General Ledger distribution is built during the printing of the Document Entry & Adjustments
Register according to the entries made in the Document and Adjustment Entry programs and the
information entered in the general ledger posting tables.

e If you have FACTS set to print GL distribution, the following message appears:

Check register. OK to print GL distribution?

After printing the Document Entry & Adjustments Register, verify the printout. If you need to
change information in the register, select Cancel to exit the program. After you make the necessary
corrections, run the register again.

If the register is correct, select OK to continue. The program then prints the GL distribution. Once
the GL distribution is printed, the systems asks you:

Check GL distribution. OK to update?
Verify the GL distribution printout. If everything is correct, select OK to continue. The program
proceeds with the update. If you find errors, select Cancel to exit the program.

After you make the necessary corrections, run the register again from the beginning. This will give
you another register print as well as another GL distribution print.

e For users not printing the GL distribution (check the AP Static GL Distribution control if you're
not sure), the system gives you this message:

Check register. OK to update?

After printing the Document Entry & Adjustments Register, verify the printout. If you need to
change information in the register, select Cancel to exit the program. Make the correction and run
the register again.

If everything is correct, select OK to continue.

i o1-raCTS 7.7 Development, Document Entry & Adj Register (APR - |EI|5|
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Document Entry

How to run the AP Document Entry & Adjustment
Register

1.

Access this program by choosing Account Payable>Document Entry—> AP
Document Entry & Adjustment Register.

In the Period field, select C-Current Period Documents to run the register for the
current period or N-Next Period Documents to run the register for next period
documents. Press Enter (CR) to default to C-Current Period Documents.

In the Branch field, enter the branch to use for the Document Entry & Adjustment
Register. Press Enter (CR) or select the <D icon to process all branches for the
register. Press F2 or — to search for branches.

Select the OK button to print the report. The General Ledger distribution is built
during the printing of the Document Entry & Adjustments Register according to
the entries made in the Document and Adjustment Entry programs and the
information entered in the general ledger posting tables.

If you have FACTS set to print GL distribution, the system displays the following
message: Document Entry & Adjustment Register. OK to Print GL Distribution?

After printing the Document Entry & Adjustment Register, verify the printout. If
you need to correct the register data, select Cancel to exit the program. After you
make the correction, you can rerun the Document Entry & Adjustment Register. If
everything is correct, select OK to continue. The program then prints the GL
distribution.

Once the GL distribution is printed, the program displays the message: Check GL
Distribution. OK to Update?

After printing the distribution, verify the printout. If everything is correct, select
OK to continue. The program proceeds with the update. If you need to make a
correction, select Cancel to exit the program. After you correct the information
the correction is made, re-run the entire register process —meaning run the
register first, then print the GL distribution, followed by the optional update.
Note that the AP Document Entry and Adjustment Register now requires an
escape code for a user to get out of an error which occurred during the update
portion of the register.

OR

If you are not printing the GL distribution, the program displays the message:
Document Entry & Adjustments Register. OK to Update?

After printing the Document Entry & Adjustments Register, verify the printout.
If you need to make a correction, select Cancel to exit the program. After you
make corrections, rerun the register. If everything is correct, select OK to
continue.
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iNTfam Infor ERP FACTS
CHAPTER 3

Recurring Documents

This sub-module is used to process invoices that are recurring (such as rent or
loan payments). It allows you to set up the liability one time and then the
system will automatically post it to the payables system for each month that
you designate. It also allows you to set up a cutoff so the monthly payables
will stop at a predetermined time. As with regular document entry, all
recurring documents must be expensed to the proper GL account number(s).
The Recurring Document Review program provides the user with a way of
changing the amount to post each month without affecting the permanent
recurring payable. The listing will provide you with options to print out the
different types of recurring payables (expired, unexpired, etc.).

The Post Recurring Documents program must be run to update any recurring
payables. However, this program does not post invoices directly into the open
documents file but rather into the Document Entry & Adjustments file which is
used in printing the Document Entry & Adjustments Register. By posting this
way, the user has an audit trail of all documents entered that will update the
open documents file and update the accounts payable balance.
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Recurring Document Entry (APE130)

Function

This program allows the user to enter and maintain documents (invoices)
which will post to the open documents file on a periodic basis (monthly,
quarterly, yearly, etc.).

The user may set up standard monthly bills such as utilities and rent or
periodic entries such as lease and note payments. This will relieve the burden
of the entry each period. The program may also be used to change header or
line-item information for existing documents.

The recurring payables entry screen consists of two sections. The upper portion
of the screen is called the header portion where the vendor number, document
amount, etc. are entered. The lower portion is called line-item portion where
each GL expense account number is entered.

After documents are entered, the amount may be changed for the current
month without affecting the standard amount through the Recurring Document
Review program. A list may be printed at any time through the Recurring
Document Listing. The document will post to the Document Entry &
Adjustments file when the Post Recurring Documents program is run. It will
then be treated like any other document in the document entry system. The
vendor’s balance and the open documents file are updated along with the GL in
the update following the Document Entry & Adjustments Register print.

Access this program by choosing Accounts Payable >Recurring Documents >Recurring Document Entry.

User Fields

The following fields are involved in using the Recurring Document Entry program:
1. Vendor

Enter the vendor number for this document. Entry of a valid vendor number displays the name,
address, general ledger posting table, document group and terms code for this vendor. Press F2 or

« to search. Press F3 or s to search for recurring documents already on file.

2. Seq # (sequence number)

Enter the sequence number (01-99). The sequence number allows you to enter up to 99 different
recurring documents per vendor. For example, if there are two loans to be paid to the same bank,
sequence numbers 01 and 02 are used. Each time you refer to this document, you must use the
sequence number. The system will default to the sequence number 01. Entry of an already existing
sequence number for this vendor displays all the information about this recurring document and
proceeds to the PO # field.

3. PO number (purchase order number)

Enter the purchase order number (up to 12 characters). Press Enter (CR) to default to 000000000000
as the PO number.
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4. GL Tbl (general ledger table)
Enter the general ledger posting table. The entry must be a valid AP general ledger posting table.
Press Enter (CR) to default to the value already displayed; initially the GL posting table assigned to
the vendor in the vendor file. Press F2 or —* to search.

5. Doc Grp (document group)
Enter the document group (up to 2 characters). Press Enter (CR) to default to the value already
displayed, initially the document group assigned to the vendor in the vendor file.

6. Branch

Enter the branch number. The entry must be a valid branch. Press Enter (CR) to default to the

branch assigned to the terminal entering the document. Press F2 or —% to search.
7. Terms (code)

Enter the payment terms code. The entry must be a valid terms code. Press Enter (CR) to default to
the value already displayed, initially the terms code assigned to the vendor in the vendor file. Press

F2 or — to search.
8. Months

Enter a string of numbers designating the periods of the calendar year to post this document to. For
example, if it is a yearly document and only posts in December, and December is the company’s

12th period, enter 12. If this document is to post quarterly, enter 03060912. Press Enter (CR) or
to default to ALL.

9. Doc Amt (document amount)

Enter the document amount to update the open documents file each time the document is posted
(+/-9999999.99). You cannot a zero amount for the document amount.

10. Post day

Enter the day the document should post to in the document entry & adjustments file (01-31). This
will be used to determine when to post this document and also to determine which day of the
month to use for the document date. For example, if this were set to 15 and it was being posted for
February, the document date would be posted as February 15. The terms code automatically
determines the due date, discount amount and discount due date based on the post day (document
date).

11. Cutoff type

Enter whether to base the cutoff (time when a document stops being a recurring payable) on a
Date, Number of postings, or Amount. Press Enter (CR) to D.

12. Cutoff

This depends on the cutoff type specified. Enter one of the following:
D - Date. Enter the cutoff period (PPYY), i.e., the last period documents are to post.

N - Number of postings. Enter the cutoff number of postings (2-99).

A - Amount. Enter the cutoff total amount (+/-9999999.99). If the next posting of the
document exceeds this amount, the document will not post.
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13. Memo

Enter the memo (up to 25 characters). This memo prints on the check stub in the comments column.

A&This concludes the header portion of the Recurring Document Entry program. After you create this
header record, you can change all previous fields except the vendor number and the sequence number.
The only way you can change the vendor number and the sequence number by deleting and re-
entering the document. To enter line items in recurring documents, complete steps 14-16.

Use the following fields to enter line items in recurring documents:
Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. When you enter a new document or edit an existing one the system

places you in add mode so you can enter recurring document lines. Press a to stop line item
addition.

14. General Ledger number

Enter the number of the general ledger expense account to which the payment will be distributed.
The number entered must be a valid GL number in the general ledger account file. If the general
ledger posting table for this vendor has preset expense accounts, press Enter (CR) to default to the
first GL account number in the GL posting table. Press F2 or —* (search) to display all G/L
numbers listed for the GL posting table assigned to this document along with the G/L number’s
description. Select the line number to expense to. You can enter any account number in place of the
standard numbers from the general ledger group. If the entire amount of the document is not

distributed to this account, enter the next account number on line 002. This process continues until
the document amount is distributed.

15. Amount

Enter the amount to be distributed to this general ledger account (+/- 9999999.99). You cannot
enter zero for this amount. Press Enter (CR) to default to the document amount not yet distributed.
The ending routine may not be accessed until the entire document amount has been distributed.

16. This concludes the line-item portion of the Document Entry program. Press F4 or the @ icon to
end line-item entry. You can:

LE Adds a line-item

3 Deletes the document

@ Inserts a line item above the highlighted line in the browser.
[ Changes the highlighted line-item

After you complete line item entry processing select the (% icon.

Press the Done button to complete the document entry.
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10.

11.

How to enter recurring AP documents

Access this program by choosing Accounts Payable ?Recurring Document >Recurring Document
Entry.

In the Vendor field, enter the vendor number for this document. Entry of a valid vendor
number displays the name, address, general ledger posting table, document group, terms code

and branch for this vendor. Press F2 or % to search. Press F3 or s to search for recurring
documents already on file.

In the Seq # field, enter the sequence number (01-99). The sequence number allows you to enter
up to 99 different recurring documents per vendor. For example, if there are two loans to be
paid to the same bank, sequence numbers 01 and 02 are used. Each time you refer to this
document, you must use the sequence number. The system will default to the sequence number
01 if only one document is entered per vendor. Entry of an already existing sequence number
for this vendor displays all the information about this recurring document and proceeds to the
PO field.

In the PO#, enter the purchase order number (up to 12 characters). Press Enter (CR) to default
to 000000000000 as the PO number.

In the GL Tbl fields, enter the general ledger posting table. The entry must be a valid AP general
ledger posting table. Press Enter (CR) to default to the value already displayed; initially the GL

posting table assigned to the vendor in the vendor file. Press F2 or —% to search.

In the Doc Grp field enter the document group (up to 2 characters). Press Enter (CR) to default
to the value already displayed, initially the document group assigned to the vendor in the
vendor file.

In the Branch field, enter the branch number. The entry must be a valid branch. Press Enter

(CR) to default to the branch assigned to the terminal entering the document. Press F2 or — to
search.

In the Terms field, enter the payment terms code. The entry must be a valid terms code. Press
Enter (CR) to default to the value already displayed, initially the terms code assigned to the

vendor in the vendor file. Press F2 or % to search.

In the Months field, enter a string of numbers designating the periods of the calendar year to
post this document to. For example, if it is a yearly document and only posts in December, and
December is the company’s 12th period, enter 12. If this document is to post quarterly, enter

03060912. Press Enter (CR) or o to default to ALL and will display every period of the
calendar year.

In the Doc Amt (document amount) field, enter the document amount to update the open
documents file each time the document is posted (+/-9999999.99). You cannot a zero amount
for the document amount.

In the Post Day field, enter the day the document should post to in the document entry &
adjustments file (01-31). This will be used to determine when to post this document and also to
determine which day of the month to use for the document date. For example, if this were set to
15 and it was being posted for February, the document date would be posted as February 15.
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The terms code automatically determines the due date, discount amount and discount due date
based on the post day (document date).

In the Cutoff field, enter whether to base the cutoff (time when a document stops being a
recurring payable) on a Date, Number of postings, or Amount. Press Enter (CR) to D.

In the second Cutoff field, depending on the cutoff type specified, enter one of the following:
D -Date. Enter the cutoff period (PPYY), i.e., the last period documents are to post.
N -Number of postings. Enter the cutoff number of postings (2-99).

A -Amount. Enter the cutoff total amount (+/-999999.99). If the next posting of the document
exceeds this amount, the document will not post.

In the Memo field, enter the memo (up to 25 characters). This memo prints on the check stub in
the comments column.

.& This concludes the header portion of the Recurring Document Entry program. After you
create this header record, you can change all previous fields except the vendor number and the
sequence number.. The only way you can change the vendor number and the sequence number
by deleting and re-entering the document. To enter line items in recurring documents, complete
steps 14-16.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. When you enter a new document or edit an existing one the

system places you in add mode so you can enter recurring document lines. Press a to stop
line item addition.

In the G/L# field, enter the number of the general ledger expense account to which the
payment will be distributed. The number entered must be a valid GL number in the general
ledger account file. If the general ledger posting table for this vendor has preset expense
accounts, press Enter (CR) to default to the first GL account number in the GL posting table.

Press F2 or —= (search) to display all G/L numbers listed for the GL posting table assigned to
this document along with the G/L number’s description. Select the line number to expense to.
You can enter any account number in place of the standard numbers from the general ledger
group. If the entire amount of the document is not distributed to this account, enter the next
account number on line 002. This process continues until the document amount is distributed.

In the Amount field, enter the amount to be distributed to this general ledger account (+/-
9999999.99). You cannot enter zero for this amount. Press Enter (CR) to default to the document
amount not yet distributed. Press Enter (CR) to accept the line.

This concludes the line-item portion of the Document Entry program. Press F4 or the (X icon to
end line-item entry. You can select:

EII}' - Adds a line-item
w - Deletes the document

@ Inserts a line item above the highlighted line in the browser.

3-8
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17.

. Changes the highlighted line-item

After you complete line item entry processing select the (%) icon.

Press the Done button to complete the document entry. The system returns you to Vendor field
so you can specify a vendor and enter additional AP documents in the displayed period. You
can enter a vendor code or press Done to exit the program.

FACTS AP
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Recurring Document Review (APE140)

Function

Use this program to change the amounts to post for specific recurring
documents. This change will be reflected in the posting for the current period.
However, the document amount will return to its original value after the
posting.

Each document in the recurring entry file has a standard amount and a current
period amount. The current period amount is initially set to the standard
amount. The standard is changed in the Recurring Document Entry program.

The Recurring Document Review program changes the current amount (the
amount to post in the current period) and enables you to change the total
document amount and the distributed amounts to each General Ledger
account. New GL expense accounts may not be added; only the original
expense account amounts are changed.

Recurring documents are initially entered in the Recurring Document Entry
program.

Recurring documents can be listed using in the Recurring Document Listing
program, and they are posted to the document entry & adjustments file by the
Post Recurring Documents program.

Access this program by choosing Accounts Payable 2Recurring Document >Recurring Document Review.

User Fields

The following fields are involved in entering the amounts for the current period:
1. Vendor
Enter the vendor number for this document. Entry of a valid vendor number displays the name,
address, general ledger posting table, document group, terms code and branch for this vendor.
Press F2 or —% to search. Press F3 or Ll to search for recurring documents already on file.
2. Sequence number
Enter the sequence number of the document (01-99). The sequence number must be on file for this

vendor in the Recurring Payables file. Field of a valid sequence number for this vendor will display
all screen information about this document. Press Enter (CR) to default to 01.

The system displays the header information for the document. You can modify t e following:
3. Doc Amt (document amount)

The document amount to update the open documents file each time the document is posted (+/-
9999999.99). You cannot enter a zero amount for the document amount.

4. Memo

The document memo (up to 25 characters). This memo prints on the check stub in the comments
column.
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5. You can select:
oA Adds a line-item
3 Deletes the document
[ Changes the highlighted line-item

" Inserts a line item above the highlighted line in the browser.

To add, insert or edit document line items, enter or modify the following;:

TIP: To change the amount for this period, change the document amount in the
header, enter a memo (if needed), and expense the same amount to the appropriate
general ledger number(s).

6. General Ledger number

Enter the number of the general ledger expense account to which the payment will be distributed.
The number entered must be a valid GL number in the general ledger account file. If the general
ledger posting table for this vendor has preset expense accounts, press Enter (CR) to default to the

first GL account number in the GL posting table. Press F2 or —* (search) to display all G/L
numbers listed for the GL posting table assigned to this document along with the G/L number’s
description. Select the line number to expense to. You can enter any account number in place of the
standard numbers from the general ledger group. If the entire amount of the document is not
distributed to this account, enter the next account number on line 002. This process continues until
the document amount is distributed.

7. Amount

Enter the amount to be distributed to this general ledger account (+/- 99999999.99). You cannot
enter zero for this amount. Press Enter (CR) to default to the document amount not yet distributed.
The ending routine may not be accessed until the entire document amount has been distributed.

After you complete line item entry processing select the (% icon.
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How to change posting amounts for recurring
documents for the current period

Access this program by choosing Accounts Payable 2Recurring Document >Recurring Document
Review.

Enter the vendor number for this document. Entry of a valid vendor number displays the name,
address, general ledger posting table, document group, terms code and branch for this vendor.

Press F2 or —% to search. Press F3 or s to search for recurring documents already on file.

In the Seq# field, enter the sequence number of the document (01-99). The sequence number
must be on file for this vendor in the Recurring Payables file. Field of a valid sequence number
for this vendor will display all screen information about this document. Press Enter (CR) to
default to 01.

You can select from a number of functions:

EII}' - Adds a line-item

ﬂ - Deletes the document

@ Inserts a line item above the highlighted line in the browser.

g Changes the highlighted line-item

To change the amount for this period, change the document amount in the header, enter a
memo (if needed), and the line-item section, change the lines necessary to expense the same
amount to the appropriate general ledger number(s).

After you complete line item entry processing select the @ icon. When you are finished press
Done to end the change process.

The system returns you to the Vendor field where you can enter another vendor or press Done
to exit the program.

FACTS AP

3-13



Recurring Documents Accounts Payable—7.7

Recurring Document Listing (APR120)

Function

This program allows the user to print a list of recurring payables to verify proper entry, to
project future expiration, postings for a specific period and to verify proper amounts for the
current period.

The user has the option to:

e Select a beginning and ending vendor.
e Select ending post date.

e Select documents to print.

e Select branch to print.

Report information includes the following: vendor number, name, sequence number,
document group, GL posting table, terms code, branch number, purchase order number,
posting day, months to post, standard posting amount, this period amount, cutoff, number of
postings to date, amount posted to date, memo and status. The number of documents printed
is included along with an index of the captions of the report.

Access this program by choosing Accounts Payable >Recurring Documents >Recurring Document
Listing.

User Fields

The following fields are involved in printing the Recurring Document Listing;:

1. Beginning vendor

Enter the beginning vendor number to print. Press Enter (CR) or L to default to FIRST. Press F2
or —= to search.

2. Ending vendor

Enter the ending vendor number to print. Press Enter (CR) or i to default to LAST.
3. Ending post date

Enter the ending post date of the month to print. It must be within the current or next GL period

and after the last date recurring documents were posted. Press Enter (CR) or id to default to the
system date.

4. Status
Indicate whether you want to print All documents, documents to be posted this Period, documents

Completed this period, Expired documents, or Unexpired documents. Press Enter (CR) to default
to ALL.

5. Branch

Enter the branch. All documents assigned to this branch print. The entry must be a valid branch.
Press Enter (CR) or " to default to ALL.
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6. Check listing. OK to remove these records?

If only expired documents are printed, the user has the option to remove the printed records from
the file. Select OK to remove printed records from the recurring document file. Select Cancel if you

don’t want to update.
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Post Recurring Documents (APU110)

Function

This program allows the user to post recurring documents to the document entry &
adjustments file.

This program will post recurring documents to the document entry & adjustments file.
Documents then print on the next Document Entry & Adjustments Register. When the
Document Entry & Adjustments Register is updated, the recurring payables will post to the
open documents file. This program does not post recurring payables into the open
documents file, but rather into the document entry & adjustments file where an audit trail
will be traced.

Posting through day 31 will close out the current month for recurring payables.

Access this program by choosing Accounts Payable >Recurring Documents >Post Recurring Documents.

User Fields

The following fields are involved in posting recurring documents:
1. Post Through

Enter the date through which to post recurring documents. It must be within the current or
next GL period within 30 days and after the last date posted. Pressing Enter (CR) defaults to
the system date.

2. Listing Run
Enter N or Y to indicate whether a Recurring Document Listing has been run. Pressing Enter

(CR) defaults to N and notifies the user that the listing needs to be printed and verified before
documents are posted.
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How to post recurring documents

1.

Access this program by choosing Accounts Payable-->Recurring
Document-->Post Recurring Documents.

In the Post Through field, enter the date through which to post recurring
documents. It must be within the current or next GL period within 30
days and after the last date posted. Press Enter (CR) to default to the
system date.

In the Listing Run field, enter N or YES to indicate whether a Recurring
Document Listing has been run. Press Enter (CR) to default to N; the
system notifies you that the listing needs to be printed and verified before
documents are posted.

Accounts Payable—7.7
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Payment & Hold Selection

The Payment & Hold Subsystem is used to select invoices for payment. It is a very flexible
system that can adapt to any office environment. All payables must be selected and the
Payment Selection List must be printed before the user can print checks.

There are two programs used to make payment selection. If an office always pays accounts
payable invoices on time or always pays invoices in time to take the discount, then the
Payment Selection by Date program should be used. This program will select the invoices to
be paid based on the parameters the user has chosen (i.e., are payments based on due date or
discount date — what is the check date?, etc.). By using this program, a user does not need to
worry about missing or overlooking an invoice. The other program used to make payment
selection is Individual Payment Selection. This is used by an office which selectively picks
which invoices it wants to pay. This program can also be used in addition to the Payment
Selection by Date program. For example, if the system does not pick an invoice the user
wishes to pay, the user can selectively choose any additional invoice to pay.

When invoices have been selected for payment, the Payment Selection List should be run to
provide a list of all payments. Payments may then be deleted or corrected through Individual
Payment Selection or unselected by vendor through Unselect Payments. Payments may be
selected or deselected up until the time checks are printed. (See next section.)

Specific documents may be placed on hold and released from hold in the Hold Selection.
Documents on hold may be viewed by printing the Hold List.

Once checks have been printed but not updated by the Check Register, the payment selection
process may begin again. The system keeps track of invoices paid by the previous (not yet
updated) batch of checks.
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Payment Selection by Date (APU210)

Function

This program allows the user to determine which documents shall be selected for payment.
The program runs through the open documents file and selects the invoice to pay based on
the parameters set by the user.

The user has the option to:

o Select the order to pay - vendor, alpha or vendor class.
e Select the beginning and ending order choice.

e Select the document group(s) to select.

e Select by due or discount date.

o  Select the date to pay through.

o Select the lead time.

e Select a minimum invoice balance to pay.

e Select the branch.

This program only determines which documents will be paid the next time checks are
printed. No documents are updated in the open documents file until the checks are printed
and the check register is printed and updated. Documents on hold will not be chosen for
payment. The payment type will be based on the vendor’s default payment type, but if the
default type is ACH and no pre-notification is approved, the payment type will be set to
paper check.

The Payment Selection List program prints a report of all documents chosen for payment and
the Unselect Payments program may be used to unselect any documents chosen by the
Payment Selection programs for payment. Individual payments may be changed or selected
through the Individual Payment Selection program.

Access this program by choosing Accounts Payable >Payment & Hold Selection >Payment Selection by
Date.

User Fields

The following fields are involved in Payment Selection by Date:

1. Order
Select the order in which payment selection is to be made. Payment selection can be done in
vendor, alpha or vendor class order.

2. Beginning order choice
Select the beginning order choice to pay. For instance, if you choose to select payments according
to vendor class, enter the vendor class that you want the system to start with. Press F2 or select the

» icon to perform a search. Select the id icon or F1 to start with the first code on file for the last
order choice for payment

3. Ending order choice
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Select the ending order choice to pay. For instance, if you choose to select payments according to
vendor class, enter the vendor class that you want the system to end with. Press F2 or select the
icon to perform a search. Select the M icon or F1 to end with the last order choice for payment.

4. Document group

Enter up to ten 2-character document groups side by side. Press Enter, F1 or the <D icon to process
all document groups.

5. Due/Discount
Enter whether selection should be based on DU-due date or DI-discount date. Press Enter (CR) to
default to DUE DATE.

6. Check date

esae ]
Enter the date on which checks will print. Press Enter (CR), F1 or -J to default to the system date.
The program compares this date to the due/discount date so it can prioritize invoice selection. This
date does not determine the actual date that will appear on checks.

7. Lead time
Enter the number of days lead time (0-99). This may be the number of days until the next check
print. The program adds the lead-time value to the check date to prioritize invoice selection. Press
Enter (CR) to default to the Automatic Increment setting in the AP Static Control F/M. For

example, if checks will not be printed again for seven days, all documents due within the next
seven days will be selected for payment. The Auto Increment setting defaults to 7.

8. Minimum

Enter the minimum invoice balance to be selected (+/- 9999999.99). For instance, you may not want

to pay an invoice for $.02, so you might enter a minimum balance of $10. Press Enter (CR) or %= to
default to no minimum.

9. Branch

Enter the branch to select payments for. The entry must be a valid branch. Only documents
assigned to the branch entered will be selected for payment. Press Enter (CR), F1 or o to
default to ALL. Press F2 or select the —% icon to perform a search.

10. Payment Type

Enter the payment type. You can select from Paper Checks, ACH, Wire Transfer, or All. Press F1 or
@0 default to ALL.
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@ 01-FACTS 7.7 Development, Payment Selection By Date (APU210) - Infor S|
Template Help

Order | ERETETETE ~| Beginning (Bd] ] First
Ending Last

Fropertias
Document Groups | | @ All
DuefDiscount Date | o - pus Date |
CheckDate [ | System Date
Lead Time _?|
Minirmum | None
Branch ?' Atlanta Branch
Payment Type | - il |

Template

Select inwendor, alpha, orvendor class order
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How to select AP documents for payment

10.

11.

12.

Access this program by choosing Accounts Payable-->Payment & Hold Selection-->Payment
Selection by Date.

In the Order field, select the order in which payment selection is to be made. Payment selection
can be done in vendor, alpha or vendor class order.

In the Beginning order choice field, select the beginning order choice to pay. For instance, if you
choose to select payments according to vendor class, enter the vendor class that you want the
system to start with. Press F2 or select the —% icon to perform a search. Select the id icon to
start with the first code on file for the last order choice for payment

In the Ending order choice field, select the ending order choice to pay. For instance, if you
choose to select payments according to vendor class, enter the vendor class that you want the
system to end with. . Press F2 or select the —% icon to perform a search. Select the Pl icon to
end with the last order choice for payment.

In the Document group field, enter up to ten 2-character document groups side by side. Press
Enter (CR) tor " to default to ALL.

in the Due/Discount field, enter whether selection should be based on DU-due date or DI-
discount date. Press Enter (CR) to default to DUE DATE.

In the Check date field, enter the date on which checks will print. Press Enter (CR) to default to
the system date. The program compares this date to the due/discount date so it can prioritize
invoice selection. This date does not determine the actual date that will appear on checks.

In the Lead time field, enter the number of days lead time (0-99). This may be the number of
days until the next check print. The program adds the lead-time value to the check date to
prioritize invoice selection.

Press Enter (CR) to default to the Automatic Increment setting in the AP Static Control F/M.
For example, if checks will not be printed again for seven days, all documents due within the
next seven days will be selected for payment. The Auto Increment setting defaults to 7.

In the Minimum field, enter the minimum invoice balance to be selected (+/- 9999999.99). For
instance, you may not want to pay an invoice for $.02, so you might enter a minimum balance
of $10. Press Enter (CR) or %= to default to no minimum.

In the Branch field, enter the branch to select payments for. The entry must be a valid branch.
Only documents assigned to the branch entered will be selected for payment. Press Enter (CR)

or & to default to ALL. . Press F2 or select the % icon to perform a search.

In the Payment Type field, enter the payment type. You can select from Paper Checks, ACH,
Wire Transfer, or All. Press F1 or a'to default to ALL.

Press Enter (CR) to start the payment processing.

The system displays the processing criteria in the upper portion of the screen and processing
information in the lower portion of the screen.
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13.  When the processing is complete message displays, press OK to exit the program.
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Individual Payment Selection (APE220)

Function

This program allows FACTS users to select documents for payment by vendor.

Invoices can be selected for payment after you printed a batch of checks but before you update the
Payment Register. Keep in mind that you cannot select documents that have been put on hold. (Use
the Hold Selection program to take documents off of hold status.)

You can use this program when you want to select or deselect certain invoices that were not picked
up by the Payment Selection by Date program.

You can also use this program if you want to make a partial payment on an invoice or override a
discount amount. This program displays the total discount and payment amount for each vendor.

Individual Payment Selection only determines which documents will be paid the next time you
print checks. Documents are not updated until you print and update checks in the Check Register.

As you are selecting invoices to be paid, the payment types will be set based on the vendor’s default
payment type. The payment type will be based on the vendor’s default payment type, but if the
default type is ACH and no pre-notification is approved, the payment type will be set to paper
check.

Use the Payment Selection List to print a report of all invoices selected for payment in this program
and the Payment Selection by Date program.

Access this program by choosing Accounts Payable >Payment & Hold Selection Individual Payment
Selection.

User Fields

The following fields are involved in Individual Payment Selection:

1. Branch
The system displays the branch for the user as the default. You can press P> to advance to the next
branch. Press F2 or — to search for branches or <D to select payments for all branches.

2. Discount cutoff date

Wiy,

Enter the date on or before discounts will automatically be taken. Press Enter (CR) or |"“! to default
to the current date. The user may always override the discount.

3. Vendor number
Enter the vendor number for selection. Press Enter (CR) to default to the first vendor on file. You
can press P to advance to the next vendor. Press F2 or — to search for vendors.
The system displays open documents for the selected vendor in the browser in the lower
portion of the screen. You can select from the following pay all documents, delete payment
for all documents, individually select or deselect documents to pay, continue listing
documents, bring up the next vendor or backup.
Filters: The hypertext link, “Filters...”, on the top portion of the main screen allows you to set filters to limit what is
shown in the browser area of the screen.
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In the Select For Payment dialog, select the Check, ACH, or Wire Transfer checkboxes to display the documents to be
paid by each. In the Currently Paid section, FACTS indicates which payment types are currently displayed for payment--
Check, ACH, or Wire Transfer.

Options allow you to only see invoices flagged for payment, only invoices flagged for payment of a specific type,
invoices previously printed or submitted or all invoices. For vendors who do not accept electronic payments, this link
will be disabled/removed and the not selected and check filters will automatically be set to “yes”.

You can select from the following to perform the listed functions:

Pay All Pays all documents for this vendor that have not been previously placed on hold or paid
will be selected for payment. The discounts (where applicable) will be taken if the discount
due date is after the discount cutoff date entered. Each payment amount and discount
amount is displayed. The totals are displayed in the header portion of the screen.

Delete All Deletes all documents for this vendor previously selected for payment will be
unselected.

Pay Pays the highlighted document in the browser.

Payment Type--For vendors who accept electronic payments, this function displays the Select for
Payment dialog box that allows individual invoices to be changed between electronic payment and
paper check. Select the Payment Type. You can select between: C-Check, A-ACH (only available if a
pre-notification has been approved), W--Wire Transfer (always available if vendor is set up in
Vendor EFT.

[ . Changes a line-item payment or discount information. Enter the Payment Amount or
select to enter the current amount as the payment amount. Enter the Discount Amount as
needed. Press = to access the calculator to determine the discount.

ﬂ - Deletes line-items

a Stops line-item entry

¥ Accesses Note Entry (SME710) for the vendor notes for the highlighted in document in the line
item browser.

Done Ends Individual Payment Selection.
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5 7.7 Development, Indi

idual Payment Selection {APE220) - Infor

Accounts Payable—7.7

File ‘iew Options Help
. Selected Far Paymen Currently Paid
granch |”! atiantabranch Eilters.. | wotSelected  ves Check  Yes
Discount Cutoff Date  [02/04/2008 150} Check  Yes ACH  Yes
ACH  Yes WWire  Yes
“endar %100 General Industrial MFG Wire  Yes
Payment Amount 0.00 C] Discount Amount 0.00 E] Balance 52000 ‘

Document | Br | Entny Date | Due Date Dizc Due Current Amt | Current Disc Fayment Dizcount Tuype Chedh# Haold Elec -

112 01 <} 04
333 01 09/30/2004 09/30/2004 09/30/2004 10.00 .00 “oid 0000000045
345 01 09/20/2004 10/30/2004  10/10/2004 1850.96 47.02 1850.96 0.00 Wiire
1112 01 09/01/2004 10/30/2004 10/M0/2004 Q973609999 1234487 .89 Manual 0000000045 ®
1794 01 09/04/2004 10/30/2004  10/10/2004 477.07 9.54
2222 01 09/042004 10/30/2004  10/10/2004 100.00 2.00 100.00 0.00 ACH
10223 01 08/09/2004 10/30/2004  10/10/2004 1200.00 24.00 1200.00 0.00 ACH
44334 01 09/30/2004  141/30/2004  11/10/2004 401.78 8.04
007154 01 10/15/2004  44/30/2004  11/10/2004 45.02 kel 45.02 0.00 Reg  000000G120 ®
1786-A 01 08/30/2004  11/30/2004  11/M0/2004 480,23 9.60 ﬂ
Amaount: 10693.98 Discount: 0.00
Eay | [ Pavan | [ peletean ][ PrtType | [ Done |
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How to select individual documents for
payment by vendor

1. Access this program by choosing Accounts Payable > Payment & Hold Selection > Individual
Payment Selection.

2. The system displays the branch for the user as the default. You can press P 6 advance to the

next branch. Press F2 or % to search for branches or <D to select payments for all branches.

3. In the Discount Cutoff Date field, enter the date on or before discounts will automatically be

m
taken. Press Enter (CR) or L) to default to the current date.

4. In the Vendor Number field, enter the vendor number for selection. Press Enter (CR) to default
to the first vendor on file. You can press | g to advance to the next vendor. Press F2 or — to
search for vendors.

5. The system displays open documents for the selected vendor in the browser in the lower
portion of the screen. You can select from the following pay all documents, delete payment for
all documents, individually select or deselect documents to pay, continue listing documents,
bring up the next vendor or backup:

Pay All Pays all documents for this vendor that have not been previously placed on hold or
paid will be selected for payment. The discounts (where applicable) will be taken if the
discount due date is after the discount cutoff date entered. Each payment amount and
discount amount is displayed. The totals are displayed in the header portion of the
screen.

Delete All Deletes all documents for this vendor previously selected for payment will be
unselected.

Pay Pays the highlighted document in the browser.
You can select from the following to perform the listed functions:

I g Changes a line-item payment or discount information. Enter the Payment Amount or select

to enter the current amount as the payment amount. Enter the Discount Amount as needed.

Press E—-l to access the calculator to determine the discount.

w - Deletes line-items

a Stops line-item entry

¥ Accesses Note Entry (SME710) for the vendor notes for the highlighted in document in the
line item browser.

Done Ends Individual Payment Selection.
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Payment Selection List (APR210)

Function

This program allows users to obtain a list of documents selected for payment.

This program may be used as an edit list prior to the check print. It is useful to determine the
total amount of the checks to be printed and to determine if additional documents should be
released for payment or unselected. Documents appear on this report only after being
selected for payment in the Payment Selection by Date or Individual Payment Selection
programs. This selection list should be printed prior to printing checks. The user may
include invoices paid by a previous batch of checks not yet updated by the Check Register.

Report information includes the following: vendor number and name, document number,
document group, entry date, due date, discount date, current amount and discount, and
payment amount and discount. If vendor totals are to be included, the total payment amount
and discount amount for each vendor is printed. Report totals are included along with total
documents listed. An asterisk indicates the invoice was paid in the previous batch of checks,
not yet updated by the Check Register.

Access this program by choosing Accounts Payable 2Payment & Hold Selection >Payment Selection List.

User Fields

The following fields are involved in printing the Payment Selection List:
1. Order
Select the order in which you want the report to print. The options are Vendor, Alpha or Vendor

Class.

2. Beginning order choice

Select the beginning order choice to print. Press Enter (CR) or 1] to default to FIRST. Press F2 or
» to search.

3. Ending order choice

Select the ending order choice to print. Press Enter (CR) or i to default to LAST. Press F2 or —= to
search.

4. Document group

If you entered document groups in the Vendor F/M vendor records, enter up to 10 two-character

document groups side by side to print. Press Enter (CR) or id to default to ALL.
5. Vendor totals

Indicate whether totals by vendor will print. The default is not to totals by vendor.
6. Branch

Enter the branch number to print. The entry must be a valid branch. Only documents assigned to
the branch entered will print. Press Enter (CR) or & to default to ALL. Press F2 or — to search.
7. Include
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Indicate whether or not to include payments that have already been printed on a previous batch of
checks but have not yet been updated by the Check Register. The default is not included.

8. Print Separate

Indicate whether to print all vendors and invoices that are to be paid by paper check first then all
vendors and invoices that will be paid electronically. Each will have it's own subtotal and then a

total for the report.

@ 01-FACTS 7.7 Development, Payment Selection List (APR210) - Infor,
Template Print Options  Help
CP=092004 Sep

Beginning m First
Ending Last

| (4] an

Properties

Document Groups |
vendor Totals [ ]

Branch Atlanta Branch

Include

Frint Separate

Template Printer

Mone Wind+ Laser

Select print order
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Unselect Payments (APU220)

Function

This program allows the user to unselect payments established in the Payment Selection by
Date program or the Individual Payment Selection program.

The user may choose a beginning and ending vendor to be processed and the branch number.
All documents selected for payment for the chosen vendors will be unselected. Invoices
already paid by checks not yet updated by the Check Register may not be unselected.

Access this program by choosing Accounts Payable 2Payment & Hold Selection >Unselect Payments.

User Fields

The following fields are involved in unselecting documents for payment:

1. Beginning vendor

Enter the beginning vendor. Press F2 or select the —% icon to perform a search. Select the id icon to
start with the first vendor on file.

2. Ending vendor

Enter the ending vendor. Press F2 or select the —% icon to perform a search. Select the P icon to
end with the last vendor on file.

3. Branch

Enter the branch in which you want to deselect payments. The entry must be a valid branch. Only
documents assigned to the branch entered will be unselected. Select the @ icon to process all

branches for the Unselect Payments program. Select the = to search for branch.

o o1-racTS 7.7 Development, Unseleck Payments (APLUZZ0) - |EI|E|

Template  Help |

Beginning Yendar m First
Ending Yendor Last
Branch o1 Atlanta Branch

Template

Mone cancel

Enter beginning wendor, F1-First, F2-Search
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How to deselect documents tagged for
payment

1. Access this program by choosing Accounts Payable-->Payment & Hold Selection-->Unselect
Payments.

2. In the Beginning vendor field, enter the beginning vendor. Press F2 or select the —= icon to
perform a search. Select the 1] icon to start with the first vendor on file.

3. In the Ending vendor field, enter the ending vendor. Press F2 or select the —% icon to perform a
search. Select the M icon to end with the last vendor on file.

4. In the Branch vendor field, enter the branch in which you want to deselect payments. The entry
must be a valid branch. Only documents assigned to the branch entered will be unselected.
Select the & icon to process all branches for the Unselect Payments program. Select the == to
search for branch.

5. Press Enter (CR) to continue with processing.

6. The system displays the processing criteria in the upper portion of the screen and processing
information in the lower portion of the screen.

7. When the processing is complete message displays, press OK to exit the program.
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Hold Selection (APE240)

Function
Use this program to place documents not currently in the payment selection file on hold.

Documents on hold cannot be selected for payment by any of the payment selection programs.
Documents with payments assigned cannot be placed on hold. You can enter any memo to appear on
the Hold List and remove holds at any time. Documents on hold will remain on hold until someone
removes the hold through this program.

Access this program by choosing Accounts Payable 2Payment & Hold Selection 2Hold Selection.

Use the following fields to place payments on hold status and to remove them from hold
status:

1. Vendor

Enter the vendor number for hold selection. Press Enter (CR) to default to the first vendor on file.

Press F2 or — to search. Press F3 or 'J--J to access the hold document search, which allows you to
search and display all vendors with documents on hold.

Note the Vendor is on Hold checkbox (display-only) is selected for vendors placed on hold on the
Miscellaneous tab of Vendor F/M (APF910).

The system displays all documents for the selected vendor in the browser in the lower portion of
the screen. Document number, entry date, due date, hold status, memo and branch information is
displays for each vendor document.

In the List From field, you can enter the document number to begin the display in the browser or

you can select id to display the first 9999 records for the vendor or [ 4 to display the next set of
9999 documents for the vendor.

You can highlight a document and then select the Toggle Hold button to change the hold status

from Yes to No. Note for Vendors with the Vendor is on Hold checkbox (display-only) selected,
you can only place orders on hold.

2. Memo

When you change a hold status, the system displays the Enter Hold Memo dialog box. Enter the
hold memo in the Memo field.

Press the Next Vendor button to automatically enters the next vendor who has open documents.

Press Done to exit the screen.
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T 01-FACTS 7.7 Development, Hold Selection (APE240) - Infor j =000 ]
File Edit ‘iew Help

“endar w100 Bm
[

Document Entry Due Amount Discount | Hold | Memo Branch -
1 In nt fi 0

76 02£30/2007 09/30/2007 -20.00 -10.00 Mo 01 Atlanta Branch
123 07042007 02/31/2007 1000.00 10.00 Mo In payment file 01 Atlanta Branch
222 09904/2004 A10/30/2002 S0.00 .20 Ho 01 Atlanta Branch
1111 0904/2004 10/30/2004 1234457 .80 2469136 Mo Inpaymentfile 01 Atlanta Branch
1112 0242004 10/30/2004 2992292 .92 1234567.89  Yes 01 Atlanta Branch
1212 0903072009 1153002004 1000.00 Z0.00 Mo 01 Atlanta Branch
1548 1000172009 1152002004 274 2. Ho  In payment file 01 Atlanta Branch
1867 09/30/2004 11/30/2004 1100.00 2200  Ho 01 Atlanta Branch
1632 1000172009 1153002005 100.00 2.00 Ho 01 Atlanta Branch
2442 08523002004 A0/2002004 12.00 04 Mo Inpaymentfile 01 Atlanta Branch
2452 0FMZ2004 02/20/2004 000,00 100,00 Mo 01 Atlanta Branch

4355 0252004 10/30/2004 400,00 200  Ho 01 Atlanta Branch b
12232 120172003 01/230/2004 121.00 2.42 Mo In payment file 01 Atlanta Branch
12322 09404/2004 10/20/2004 2.00 .04 Ho 01 Atlanta Branch

23423 10/03/2004 11/30/2004 2000 A0 Ho 01 Atlanta Branch LI
24224 ANSESONA A% nmnna AREAO_ AN OOEAA kL fA MM ards Drarch

List From ToggieHo | [ Done |
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How to place documents on hold

Note: Documents currently in the payment selection file or with payments already assigned cannot
be placed on hold. Documents on hold cannot be selected for payment by any of the payment
selection programs.

1. Access this program by choosing Accounts Payable-->Payment & Hold Selection-->Hold Selection.

2. In the Vendor field, enter the vendor number for hold selection. Press F2 or —% to search. Press

F3 or Ll to access the hold document search, which allows you to search and display all
vendors with documents on hold.

Note the Vendor is on Hold checkbox (display-only) is selected for vendors placed on hold on
the Miscellaneous tab of Vendor F/M (APF910).

3. If there are open documents on file for the vendor, the documents are displayed in the browser.
In the List From field, you can enter the document number to begin the display in the browser
or you can select LU display the first 9999 records for the vendor or P o display the next set

of 9999 documents for the vendor.

4. You can highlight a document and then select the Toggle Hold button to change the hold status
from No to Yes. Note for Vendors with the Vendor is on Hold checkbox (display-only) selected,
you can only place orders on hold.

5. When you change a hold status, the system displays the Enter Hold Memo dialog box. Enter the
hold memo in the Memo field.

6. Press the Next Vendor button to automatically enter the next vendor who has open documents
and complete steps 3-5.

7. Press Done to exit the screen.
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How to delete document holds

Access this program by choosing Accounts Payable 2Payment & Hold Selection 2Hold Selection.

In the Vendor field, enter the vendor number for hold selection. Press F2 or % to search. Press

F3 or I to access the hold document search, which allows you to search and display all
vendors with documents on hold.

Note the Vendor is on Hold checkbox (display-only) is selected for vendors placed on hold on
the Miscellaneous tab of Vendor F/M (APF910).

If there are open documents on file for the vendor, the documents are displayed in the browser.
In the List From field, you can enter the document number to begin the display in the browser
or you can select id to display the first 9999 records for the vendor or P to display the next set

of 9999 documents for the vendor.

You can highlight a document and then select the Toggle Hold button to change the hold status
from Yes to No. Note for Vendors with the Vendor is on Hold checkbox (display-only) selected,
you can only place orders on hold--not delete holds.

When you change a hold status, the system displays the Enter Hold Memo dialog box. Enter the
hold memo in the Memo field.

Press the Next Vendor button to automatically enter the next vendor who has open documents
and complete steps 3-5.

Press Done to exit the screen.
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Hold List (APR220)

Function

This program allows the user to obtain a printout of all documents on hold.

Documents appear on this report after being placed on hold by the Hold Selection program.
The Hold Selection program is also used to remove documents from hold status. Vendors
may be placed on hold through the Vendor F/M. If a vendor is on hold, all documents for
that vendor will print on the Hold List. The hold memo prints * vendor on hold *.

The user has the option to:

Select the order to print.

Select the document group(s) to print.
Print vendor totals.

Select the branch to print.

Report information includes the following: vendor number and name, document number,
document group, entry date, due date, discount date, amount, discount amount and the hold
memo. If vendor totals are included, the total amount and discount on hold for each vendor
are printed. Report totals are included along with total document(s) listed.

Access this program by choosing Accounts Payable >Payment & Hold Selection Hold List.

User Fields

The following fields are involved in printing the Hold List:
1. Order

Select the order the report is to print.

2. Beginning order choice

Enter the beginning order choice to print. Press Enter (CR) or id to default to FIRST. Press F2 or
» to search.

3. Ending order choice

Enter the ending order choice to print. Press Enter (CR) or i to default to LAST. Press F2 or — to
search.

4. Document groups

Enter up to ten 2-character document groups side by side to print. Press Enter (CR) or o to
default to ALL.

5. Vendor totals

Indicate whether to print totals by vendor. Press Enter (CR) to default to not print totals by
vendor.

6. Branch

Enter branch number to print. The entry must be a valid branch. Only documents assigned to the
branch entered will print. Press Enter (CR) or & to default to ALL. Press F2 or — to search.
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I o01-FACTS 7.7 Development, Hold List (APRZ20) - Infor E - |EI|5|
Template Print Opkions  Help

CP=09/2004 SEP

Bedinning First
Ending Last
Dacument Groups

| | Al
vendor Totals [ ]
Branch Atlanta Branch

Ok
Template Printer =
Naone Windx Laser

Select print order

Froperties
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CHAPTER 5

Checks

The Accounts Payable System consists of six types of checks: printed, manual, void, and
noninvoice and EFT (electronic funds transfer) transactions and wire transfer.

The Check Print program is used to print checks generated from the Payment Selection List.
When you are satisfied with the list and ready to print checks, uses the Check Print program.
One check prints for each vendor and pays the documents listed on the Payment Selection
List.

The Manual Check Entry program allows you to enter and record manual checks (written
manually by the user to pay invoices in the open documents file). Manual checks are usually
entered after the check has been written. Enter the vendor, manual check number, date and
amount and then select the documents paid by the manual check.

The Void Check Entry program is used to void out (system generated or manual) checks
updated by the Check Register. Enter the check number and the number of the invoice that
was paid off by the check. Void checks are not updated until the Check Register is updated, at
which point the documents (invoices) go back into the open documents file.

The Noninvoice Check Entry program is used to pay an invoice not in the open documents
file, e.g., you are entering the invoice(s), expensing the invoice(s) and recording payment of
the invoice(s) at the same time.

The EFT Approval (APE340) program is used to approve the electronic payments that have
been submitted in the EFT Submission (APR320) program.

The EFT Submission (APR320) program, is used to submit documents that are to be paid by
ACH and invoices that are to be paid by wire transfer for approval. Documents flagged to be
paid on paper checks will be skipped.

Use the EFT Payment Batch Status program to indicate when an EFT Payment Batch has been
accepted or rejected by the bank. All batches that have not yet been updated through the
Payment Register display on this screen.

System-generated electronic payments and (printed), manual and noninvoice checks are not
updated until the Payment Register has been run and updated. Checks can be reprinted and
manual and noninvoice checks may be deleted or corrected until the time when the register is
updated. If the register is incorrect, you can choose not to update. It is possible to reprint and
update after corrections have been made. You can print multiple batches of checks before you
print and update the Payment Register.
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Electronic Payments Processing Overview

If a vendor accepts electronic payments, their invoices can be selected to be paid either electronically or
by paper checks. The Payment Selection by Date and Individual Payment Selection programs default
all of the vendor’s invoices to be paid by a new default payment type. You can modify an invoice to be
paid by check, EFT or wire in Individual Payment Selection.

The Payment Selection List program optionally print payments to be made electronically separate from
payments to be made by check.

The EFT Submission (APR320) program allows you to process electronic payments. Invoices flagged
for electronic payment are consolidated by vendor and submitted for approval. Vouchers are
optionally printed for the electronic payments. The Check Print Control F/M contains a setting for
printing electronic payment vouchers.

Electronic payments must be approved before they can be submitted to the bank for processing. This is
analogous to someone signing the paper checks. The EFT Approval (APE340) programs allows you to
approve or reject a vendor’s payment that is submitted for electronic payment.

Rejecting a payment clears any indications that the invoices were submitted for payment and remove
the invoices from the payment file The invoices can be re-selected through Payment Selection by Date
or Individual Payment Selection programs.

Once payments are approved, you can select to create a batch payment file for transmission to the bank
with the approved payments in the EFT Approval (APE340) program. Finally, before the payments
appear on the Payment Register, the user must confirm that the electronic payment batch was accepted
by the bank using the Payment Batch Status (APE350) program. After approval, the Payment Register
report will show what payments were made and the invoices that were paid. Additionally, the
remittance advice can be printed or be emailed to the vendors letting them know that the payments
have been sent.

If a payment batch file is rejected by the bank and processed through the Payment Batch Status
(APE350), the payments will be returned to the EFT Approval screen where the payment batch could
be recreated in a different format or rejected so they can be selected for a paper check.

If the bank accepts the file and then later rejects one of the payment transactions, you can access go to
the Void Check Entry program and void the electronic check and update each invoice originally paid.

When you run the AP End-of-Period Update, the program checks to determine if there are any
payment batches that have been transmitted to the bank but not yet accepted by the bank. If this is the
case, the system displays a message and the update will not be able to be run. If there are submitted or
approved payments that have not yet been created into a batch, those payments remain, and the end of
period update proceeds.
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Checks

Check Print (APP310)

Fu

nction

This program allows the user to prepare checks to be printed and then prints
the checks on check forms. The program also allows the same checks to be
reprinted, if, for example, the printer jams and a number of checks print off
alignment. When checks are reprinted, the original check to be printed is
automatically voided. The reprint check process may be used as often as
needed until the Check Register update is run. Once a check is updated by the
Check Register, the check may only be reprinted after the check has been
voided. When the check print is performed, the system skips all invoices
flagged to be paid electronically.

The program first prepares all the checks. When preparation is complete, the
checks are printed. The preparation of the checks is based on the documents
selected for payment in the Payment Selection subsystem. The Payment
Selection List should be printed for review prior to printing checks. The Check
Print prints the checks by first printing the stub of the check (comments, invoice
number, date, etc.) and then the actual check. If the check is paying more
invoices than can fit on one stub, the system automatically voids the first check
and continues with the second stub. The checks are printed on the standard
check forms based on the Bank F/M (Banking and Check System in System
Management) and the Check Print Control F/M programs.

NOTE: Checks are created and printed. However, no updating occurs in the
open documents file until the Check Register is printed and updated.

Plain Paper Vouchers

Plain paper vouchers print only for the checks that are currently being printed.
A second check run without first posting already printed checks will not
produce vouchers for checks from both check runs.

Unform Archiving
The AP Check Print program can archive information to Unform.

The check and the separate voucher are linked in Archive. The document type for both checks
and separate vouchers is the same, Check, but the document ID differs by appending "-Vch"
to the bank code and check number for the voucher.

When archiving to UnForm, the following Bank Code:{Bank code}, Check Date:{date
YYYYMMDD}, and Sequencing sub-ids print at the conclusion of both the check print and the
separate voucher print:.

[To print an alignment (or test page) in graphical mode, select Print Options
> Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

Access this program by choosing Accounts Payable >Checks >Check Print.

Accounts Payable—7.7
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User Fields

The following fields are involved when printing a check:

1. Bank code

Enter a bank code for this check run. The entry must be a valid bank code. The bank code will
display the bank name and the last check number printed. Press Enter (CR) to default to the first

bank on file. Press F2 or ~—+to search.

2. Branch
Enter the branch to print checks. Press Enter (CR) to default to the branch assigned to the terminal.
Press F2 or ““to search. Press #to default to ALL.

3. Check date
Enter the date to print on the check. The date must be within the current or next general ledger
period and not before the current AP period. Press Enter (CR) or [ ““Ito default to the system date.

4. Beginning check number
Enter the beginning check number to print. This must be determined by looking at the check forms
in the printer. The first check is always skipped (unless you attach a forms leader to the top check).
5. Void checks

Indicate whether to void the checks displayed. This field is skipped if the first check to print is the
next number after the last check printed. If the first check to print is not the next number after the
last check printed, the system asks if you want to void the checks in between. If you select the
checkbox, the system records all the checks as void. If you do not select the checkbox, the system
will not void any unused checks. Press Enter (CR) to default to selected.

FACTS does not allow you to void a check that’s in the Manual/Void Check File, the Check
Reconciliation File, or the Non-Invoice Check File.

If you are reprinting checks,
6. Reprint checks

Indicate that you want to print checks by either selecting the check box. The default entry is
unselected.

If you are printing a batch of checks for the first time,

7. Vendor alpha order
This program automatically prints checks in check number order. You must select Vendor alpha
order to change this setting.

8. From
Enter the first check to reprint. You should read the check number from the previously printed
check and field that number. This will be the first check to reprint. Press Enter (CR) or Mo default
to the FIRST check previously printed.

9. Thru

Enter the last check to reprint. Press Enter (CR) or Plto default to the LAST check previously
printed.
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How to print checks

1.
2.

Access this program by choosing Account Payable-->Checks-->Check Print.

In the Bank field, enter a bank code for this check run. The entry must be a valid bank code. The
bank code will display the bank name and the last check number printed. Press Enter (CR) to
default to the first bank on file.

In the Branch field, enter the branch to use for the Document Entry & Adjustment Register.
Press Enter (CR) to default to ALL. Select the <D icon to process all branches for the register.

Select the % to search for branches.

In the Check date field, enter the date to print on the check. The date must be within the current

L]
or next general ledger period and not before the current AP period. Press Enter (CR) or L2l to
default to the system date.

In the Beginning check number field, enter the beginning check number to print. This must be
determined by looking at the check forms in the printer. The first check is always skipped
(unless you attach a forms leader to the top check).

Select the Void checks checkbox to indicate whether to void the checks displayed. This field is
skipped if the first check to print is the next number after the last check printed. If the first check
to print is not the next number after the last check printed, the system asks if you want to void
the checks in between. If you select this option, the system records all the checks as void. If you
do not select, the system will not void any unused checks. Press Enter (CR) to default to
selected.

FACTS does not allow you to void a check that’s in the Manual/Void Check File, the Check
Reconciliation File, or the Non-Invoice Check File.

If you are reprinting checks, select Reprint Checks checkbox to reprint check. Then in the From
field, enter the first check to reprint. You should read the check number from the previously
printed check and field that number. This will be the first check to reprint. Press Enter (CR) or

id to default to the FIRST check previously printed. In the To field, enter the last check to
reprint. Press Enter (CR)or i to default to the LAST check previously printed.
If you are printing a batch of checks for the first time, select the Vendor Alpha Order checkbox

to print the checks by vendor. Otherwise, this program automatically prints checks in check
number order.

Select the OK to start the check run or the Cancel button to stop this process.
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EFT Submission (APR320)

In this program, documents that are to be paid by ACH and invoices that are to be paid by wire
transfer are submitted for approval. Documents flagged to be paid on paper checks will be skipped.

Vouchers will print for these electronic payments based on the Vouchers for Electronic Payments
setting in Check Print Control F/M.

Documents to be paid electronically as ACH transactions will be grouped together by the vendor. If no
account pre-notifications are approved, the payment will not be created and the invoices will remain
selected in the payment file. The user will receive a message identifying the vendor. Otherwise, the
payment will be assigned the next ACH number as the “check” number. The check type will be set to
“A--ACH”.

Documents to be paid electronically as wire transfers will be grouped together by the vendor and
assigned the next wire transfer number as their “check” number. The check type will be set to “W-Wire
Transfers”.

The program assigns the vendor’s default routing and account number. For vendors with multiple
accounts, alternate bank accounts can be selected in the EFT approval program.

The Consumer Payment setting defaults from the vendor EFT file but can be changed in the EFT
Approval program.

Vouchers, in the same format as the plain paper vouchers, will optionally print for the electronic
payments. All plain paper vouchers print a page number and a report total page, whether they are for
electronic payments or for paper checks. The check/payment date, check/payment number and
vendor information also print on the line. Plain paper vouchers print only for the EFT submissions that
are currently being posted.

If the program is run when there are already submitted electronic payments on file for a specific
vendor, FACTS submits a second payment for that vendor for the additional invoices. This process
occurs whether the existing payments have been approved or are still submitted. If the user wishes all
invoices to be combined into a single payment record, they can reject the first payment then reselect the
invoices and submit all invoices at one time.

Use the following fields to submit electronic funds transfers:
1. Bank
Enter bank for this payment submission, Press F2 or = to search.
The system displays the name for the bank.
2. Branch

Enter the branch for the selected bank. The system displays the branch name. Press F2 or —* to

search. Press F3 or @ to enter all branches for the selected bank. The system displays the branch
name.

Press OK to submit the electronic fund transfers or Cancel to exit the program without any
processing.

Processing notes:

Documents to be paid electronically as ACH transactions are grouped together by the vendor. If no
account pre-notifications are approved, the payment is not created and the invoices remain selected
in the payment file. The system displays a message identifying the vendor. Otherwise, the payment
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is assigned the next ACH number as the “check” number. The check type is set to “A”.

Documents to be paid electronically as wire transfers will be grouped together by the vendor and
assigned the next wire transfer number as their “check” number. The check type will be set to “W”.

The vendor’s default routing and account number will be assigned. For vendors with multiple
accounts, alternate bank accounts can be selected in the EFT approval program.

The consumer payment flag will default from the vendor EFT file but can be changed in the EFT
Approval program.

Vouchers, in the same format as the current plain paper vouchers, will optionally print for the
electronic payments. All plain paper vouchers will be changed to print a page number and a report
total page, whether they are for electronic payments or for paper checks. The check/payment date
will be added to the line with check/payment number and vendor information

If the program is run when there are already submitted electronic payments on file for a specific
vendor, a second payment will be submitted for that vendor for the additional invoices. This will be
the case whether the existing payments have been approved or are still submitted. If the user wishes
all invoices to be combined into a single payment record, they can reject the first payment then
reselect the invoices and submit all invoices at one time.

T o1-FACTS 7.7 Development, EFT Submission (APR320) - Infor
Template Print Options  Help

AP CP=09i2004 Sep

) _ GL CP=09/2004 Sep
Bank 01 S] First Hational Bank of Atlanta
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Ternplate Printer "
stk Hull Printer

Run the report
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How to submit electronic funds transfer

Access this program by choosing Account Payable--> Checks-->EFT Submission.

In the Bank field, enter the bank number on which the electronic funds transfer was written.
The entry must be a valid bank. Press Enter (CR) to default to the first bank on file. Press F2 or

« to search.
3. In the Branch field, enter the branch number for the electronic funds transfer. Press F2 or —* to
search; press F3 or ] for all banks.

4. Press OK to submit the electronic funds transfers or Cancel to remove the information and
return to the Bank field.
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Manual Check Entry (APE310)

Function

This program allows the user to enter handwritten checks into the Accounts Payable system
and bypass the check print portion of processing. A manual check must be written to pay off
documents in the open documents file, such as purchase orders, customer refunds, etc. A
manual check used to pay off a document that is not in the open documents file is entered
through the Noninvoice Check Entry; i.e., if an invoice comes in C.O.D. and never existed in
the open documents file. The manual check number entered cannot be the same number
found in the manual and void check file, check reconciliation file or regular check file.
Manual checks may not be entered for vendors on hold.

Complete check information must be entered including the following: bank number, check
number, vendor number, check date, check amount, each document (invoice) paid by the
check and the payment and discount amounts.

The Manual Check Entry program consists of two sections. The upper portion of the screen is
called the header portion where the vendor number, check date, etc. are entered. The lower
portion is called the line-item portion where each invoice, amount, etc. is entered.

Manual check information appears on the next Check Register and all applicable files are
updated during the optional Check Register update. No updating occurs in the open
documents file during entry of a manual check.

User Fields

The following fields are involved in entering a manual check:
1. Bank

Enter the bank number on which the check was written. Press Enter (CR) to default to the first

bank on file. Press F2 or — to search.
2. Check Number

Enter the manual check number (1-999999). Press Enter (CR) or | 4 to default to the next check

number after the number displayed as last manual check. Press F2 or —% to list manual checks
already entered but not yet updated by the Check Register. If a check is selected, the check details
are displayed in the middle portion of the screen.

3. Vendor

Enter the vendor number for this check. The vendor number, name, address and balance are
displayed. Press F2 or —= to search.

4. Date
Enter the date of the manual check. The date must be within the current or next GL period and not
prior to the current AP period. Press Enter (CR) to default to the system date.
5. Check Amount

Enter the dollar amount of this check (.01-9999999.99). A message is displayed if the amount is
greater than the vendor balance.
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You can select from the following;:
Apply Check to display all open documents for this vendor.

Delete Check to delete the all records of this manual check. If you answer YES to the Are you sure
you want to delete check? prompt, the system clears the screen and returns to the check number field.
The displayed field of last manual check number used is updated. However, the deleted check
number may be used again.

Done to exit the program.

6. If you select Apply Check the system displays a dialog listing the documents to which the check can
be applied. You can select:

Auto apply to allow the system to automatically pay open documents. It begins with the first
displayed document and continues paying off documents until the check amount is distributed. If
the check date is before or on the discount due date, any applicable discounts are taken. The
payment amount and discount amount are displayed; the distributed amount is displayed in the
header.

Pay to apply the entire check amount to the highlighted document line in the browser. (Note the
check amount must be less than or equal to the Current Amount for the document. You can select
Unpay to remove the Payment Amount applied to the highlighted document line in the browser.

-OR-
Complete 7-10.

7. You can select a document to which the check can be applied and press 1:'?

8. Invoice Payment Amount
Manually enter in the payment amount (i.e., allowing for partial payments).

9. Invoice Discount Amount
Enter the discount amount (i.e., allowing a discount to be taken after the discount due date) in the

Invoice Discount Amount field.

10. Press = to save your changes. Press a to cancel the line entry. You must continue processing
payments for the check until the Check Amount and the Distributed Amount are equal. When you
have distributed the manual check, press Done to exit the program.
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T 01-FACTS 7.7 Development, Manual Check Entry {APE310) - Infor - |EI|5|
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How to enter manual checks
1. Access this program by choosing Accounts Payable-->Checks-->Manual Check Entry.

2. In the Bank field, enter the bank number on which the check was written. Press Enter (CR) to

default to the first bank on file. Press F2 or —% to search.

3. In the Check Number field, enter the manual check number (1-999999). Press Enter (CR) or [ 4
to default to the next check number after the number displayed as last manual check. Press F2

or —= to list manual checks already entered but not yet updated by the Check Register. If a
check is selected, the check details are displayed in the middle portion of the screen.

4. In the Vendor field, enter the vendor number for this check. The vendor number, name, address

and balance are displayed. Press F2 or —* to search.

5. In the Date field, enter the date of the manual check. The date must be within the current or
next GL period and not prior to the current AP period. Press Enter (CR) to default to the system
date.

6. In the Check Amount field, enter the dollar amount of this check (.01-9999999.99). A message is
displayed if the amount is greater than the vendor balance.

1& This concludes the header portion of the Manual Check Entry program. At this time, the
system creates a header record; once the header is created, you can change all header fields —
except the bank, check number and vendor fields.

7. You can select from the following;:
Apply Check to display all open documents for this vendor.

Delete Check to delete the all records of this manual check. If you answer YES to the Are you
sure you want to delete check? prompt, the system clears the screen and returns to the check
number field. The displayed field of last manual check number used is updated. However, the
deleted check number may be used again.

Done to exit the program.

8. If you select Apply Check the system displays a dialog listing the documents to which the
check can be applied.

You can select:

Auto apply to allow the system to automatically pay open documents. It begins with the first
displayed document and continues paying off documents until the check amount is distributed.
If the check date is before or on the discount due date, any applicable discounts are taken. The
payment amount and discount amount are displayed; the distributed amount is displayed in
the header.

Pay to apply the entire check amount to the highlighted document line in the browser. (Note
the check amount must be less than or equal to the Current Amount for the document. You can
select Unpay to remove the Payment Amount applied to the highlighted document line in the
browser.
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10.

-OR-

You can select a document to which the check can be applied and press & . In the Invoice
Payment Amount field, you can manually enter in the payment amount (i.e., allowing for
partial payments) and enter the discount amount (i.e., allowing a discount to be taken after the

discount due date) in the Invoice Discount Amount field. Press H to save your changes. Press
a to cancel the line entry.

You must continue processing payments for the check until the Check Amount and the
Distributed Amount are equal.

When you have distributed the manual check, press Done to exit the program.
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Void Check Entry (APE320)

Function

Use this program to record as void any system or manual check previously
updated by the Check Register. In order to void a check, it must be in the bank
transaction file. The program displays the vendor number, check date, check
amount and discount amount from the bank record.

If the check is not in the bank transaction file, FACTS displays a message
indicating this and gives you the option to add the check anyway. After
entering the number of the check to be voided, enter the number of each
document originally paid by the check.

If there are one or more bank transactions with this check number from the AP
module, you can select which check you want to use. If the check number did
not come from the AP system, the check is already voided or the bank uses
reconciliation and the check is cleared or reconciled, you cannot void that check
number.

Void check information appears on the next Check Register. Each document
previously paid by the void check goes back into the Open Documents file and
the vendor’s balance increases accordingly.

Access this program by choosing Accounts Payable >Checks >Void Check Entry.

User Fields

The following fields are involved in entering a void check:
1. Bank

Enter the bank number on which the check was written. The entry must be a valid bank. Press
Enter (CR) to default to the first bank on file. Press F2 or —* to search.
2. Check number

Enter the number of the check to be voided. This check must be in the check reconciliation file.
When you enter a valid check number, the system displays the vendor number and name, address,

balance, check amount, discount amount and check date. Press F2 or — to list any voided checks
entered since the last Check Register. Once checks are listed, enter the beginning check to list if not
already displayed, press Enter (CR) to continue listing documents or enter the line number of the
check to display in detail.

3. Is this correct check to void?
Select Yes or No to indicate whether you wish to void the displayed check. Press Enter (CR)
defaults to Yes.

4. Document number
Enter the invoice number of each document originally paid by this check. Entry of a document

number still existing in the open documents file displays the document entry date, due date,
discount due date, document amount, discount amount and new balance and the system returns to

this field. Press F3 or a to end entries.
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U UIf the document no longer exists in the Open Documents file (it has been removed by the Document
Removal Register), and you need to add it to the file. Select Yes to indicate whether this document
should be added to the file and complete fields 5-12.

[1UIf you are voiding a noninvoice check, you must enter a document number (that is not on file) so
that the check can be correctly voided. Complete fields 5-12 to add the document number to the open
documents file. The void for the noninvoice check can then be correctly processed through the system,
including posting to General Ledger.

5. Document entry date

Enter the date the document was entered.

6. Document due date

Enter the due date of the document.

7. Document discount due date

Enter the due date of the document discount.

8. Void payment amount
Enter the amount paid to be voided by the check (+/- 9999999.99). (This will be the amount of the
document when updated to the open documents file.)

9. Void discount amount
Enter the amount to be the allowable discount amount when the document is updated to the open
documents file (+/- 9999999.99).

10. Branch

Enter a valid branch number. Press Enter (CR) to default to the branch assigned to the terminal.
Press F2 or — to search. The AP Check Register uses this entry to post voided checks by branch.
11. Memo
Enter the document memo (up to 25 characters). This memo will appear in the comments column
of the check stub when this invoice is paid off.
Once you've entered all the documents that need to be voided, the check amount must equal the
distributed amount and the discounts must equal the distributed discount amount to end entries. Press

F3 or a to end the entry process.

12. You can perform the following functions:

Change a document - Information can be changed for documents added to the open documents
file during Void Check Entry. In the browser in the lower portion of the screen highlight the

document number to be changed and click I to edit the line item information. You can
change fields #5-11.

Delete a document. In the browser in the lower portion of the screen highlight the document

number to be changed and click & to delete. You must then respond with YES to the Are
you sure you want to delete? prompt.

=
Add a document. Select the @& to add an invoice to the voided check. Complete fields #5-
11.

The distributed amount in the header is constantly updated as each line is entered. This
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distributed amount must equal the original check amount and the distributed discount
amount must equal the original discount amount to end the program. Press Done to clear
the screen and return to the check number field.

T 01-FACTS 7.7 Development, Yoid Check Entry (APE320) - Infor =10] =]

File Edit Yiew Help
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How to enter a void check

1.

® N o U

10.

11.

12.

In the Bank field, enter the bank number on which the check was written. The entry must be a

valid bank. Press Enter (CR) to default to the first bank on file. Press F2 or — to search.

In the Check number field, enter the number of the check to be voided. This check must be in
the check reconciliation file. When you enter a valid check number, the system displays the
vendor number and name, address, balance, check amount, discount amount and check date.

Press F2 or —= to list any voided checks entered since the last Check Register. Once checks are
listed, enter the beginning check to list if not already displayed, press Enter (CR) to continue
listing documents or enter the line number of the check to display in detail. If a check is
selected, the check is information displayed and displays the message: Is this correct check to
void? Select Yes or No to indicate whether you wish to void the displayed check. Press Enter
(CR) defaults to Y.

In the Document number, enter the invoice number of each document originally paid by this
check. Entry of a document number still existing in the open documents file displays the
document entry date, due date, discount due date, document amount, discount amount and

new balance and the system returns to this field. Press F3 or 9 to end entries.

U UIf the document no longer exists in the Open Documents file (it has been removed by the
Document Removal Register), and you need to add it to the file. Select Yes to indicate whether
this document should be added to the file and complete fields 5-12.

[1If you are voiding a noninvoice check, you must enter a document number (that is not on
file) so that the check can be correctly voided. Complete fields 5-12 to add the document
number to the open documents file. The void for the noninvoice check can then be correctly
processed through the system, including posting to General Ledger.

In the Document entry date field, enter the date the document was entered.
In the Document due date field, enter the due date of the document.
In the Document discount due date field, enter the due date of the document discount.

In the Void payment amount field, enter the amount paid to be voided by the check (+/-
9999999.99). (This will be the amount of the document when updated to the open documents
file.)

In the Void discount amount field, enter the amount to be the allowable discount amount when
the document is updated to the open documents file (+/- 9999999.99).

In the Branch field, enter a valid branch number. Press Enter (CR) to default to the branch
assigned to the terminal. Press F2 or —% to search. The AP Check Register uses this entry to
post voided checks by branch.

In the Memo field, enter the document memo (up to 25 characters). This memo will appear in
the comments column of the check stub when this invoice is paid off.

Once you've entered all the documents that need to be voided, the check amount must equal
the distributed amount and the discounts must equal the distributed discount amount to end
entries.

FACTS AP
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Press F3 or a to end the entry process.

You can perform the following functions:

Change a document - Information can be changed for documents added to the open
documents file during Void Check Entry. In the browser in the lower portion of the screen

highlight the document number to be changed and click ! g to edit the line item information.
You can change fields #5-11.

Delete a document. In the browser in the lower portion of the screen highlight the document

number to be changed and click # 1o delete. You must then respond with YES to the Are
you sure you want to delete? prompt.

=
Add a document. Select the @& to add an invoice to the voided check. Complete fields #5-
11.

The distributed amount in the header is constantly updated as each line is entered. This
distributed amount must equal the original check amount and the distributed discount
amount must equal the original discount amount to end the program. Press Done to clear
the screen and return to the check number field.

When you are finished, press F3 or a to clear the screen and return to the check number
field. Press Done to exit the program.
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Noninvoice Check Entry (APE330)

Function

Use this program to enter handwritten checks, which pay off invoices that are
not currently in the Open Documents file. This bypasses the Check Print
portion of processing.

You can use this program to enter an invoice and pay it off in the same entry
program, for instance an invoice comes in C.O.D. and someone in the
accounting department has to write out a manual check.

< If a handwritten check pays an existing document in the Open Documents
file, enter the check through the Manual Check Entry program.

The noninvoice manual check number entered cannot match any of the check
numbers in the bank transaction file. You cannot enter Noninvoice checks for
vendors on hold.

Complete check information must be entered including the following: bank
number, check number, vendor number, check date and check amount.
Complete document information must also be entered including document
number, invoice date, amount paid, discount taken, the general ledger expense
number(s) and memo.

The Noninvoice Check Entry screen consists of two sections. The upper portion
of the screen is called header portion where the vendor number, check date,
etc., are entered. The lower portion is called line-item portion where each
invoice, amount, etc., is entered.

Noninvoice check information appears on the next Check Register and is
updated during the optional Check Register update. A noninvoice check
updated by the register will create a zero balance open document in the open
documents file and a payment transaction in the transaction file.

Access this program by choosing Accounts Payable >Checks ?Noninvoice Check Entry.

User Fields

The following fields are involved in entering noninvoice checks:
1. Bank

Enter the bank on which the check was written. The entry must be a valid bank. Press Enter (CR)

defaults to the first bank on file. Press F2 or —% to search.
2. Check number

Enter the manual check number (1-999999). Press Enter (CR) or [ 4 to default to the next check

number after the number displayed as the last manual check. Press F2 or —% to list noninvoice
manual checks already entered but not yet updated by the Check Register. Once checks are listed,
enter the beginning check to list if not already displayed, press Enter (CR) to continue listing
documents or enter the line number of the check to display in detail.

3. Vendor
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Enter the vendor number for this check. The vendor number, name, address and balance are

displayed. Press F2 or —% to search.
4. Check date

Enter the date of the manual check. The date must be within the current or next general ledger
period and not prior to the current AP period. Press Enter (CR) to default to the system date.

5. Check amount

Enter the dollar amount of this check (.01-9999999.99). The check amount must be less than or
equal to the vendor balance.

This concludes the header portion of the Noninvoice Check Entry program. At this time, a header
record is created and all header fields except #1-3 are accessible through the change header routine.
Fields #1-3 can only be changed by deleting and re-entering the check. The line-item portion allows the
entry of up to 999 line-items to complete the check.

Use the following fields to enter invoices in the line item section:

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
individual line-item up to 999. In the rare case where 999 line-items have been entered on a single
check, the program refuses further entries.

6. Document

Enter the document (invoice) number (up to 10 characters). Press F3 or a to end the entry
process.

7. Invoice date

Enter the invoice date. Press Enter (CR) to default to the system date.
8. Amount paid

Enter the amount paid (+/-9999999.99). Press Enter (CR) to default to 0.

9. Discount taken

Enter the amount of the discount taken (+/- 9999999.99) not greater than the payment amount.
Press Enter (CR) to default to 0.

10. General ledger number

Enter the general ledger number to expense. The entry must be a valid general ledger number. If
the general ledger posting table assigned to this vendor has preset expense accounts, press Enter
(CR) to default to the GL account number in the GL posting table and all numbers of the GL

posting table may be displayed by pressing F2 or —= to search. This search displays all G/L #’s
listed for the GL posting table assigned to this document along with the G/L #’s description. Select
the line number of the GL account number to expense to.

If the document is to expense to more than one G/L #, each expense amount should be entered on
separate lines using the same document number. For example, if entering a $110 document (#12345
where $100 is to post to 620-00 office expense and $10 is to post to 640-00 - freight expense, enter as

two lines:
Ln # Document Invoice Amount Discount G/L#
Memo Date Paid Taken
001 12345 06/15/89 100.00 .00 620-00
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002 12345 06/15/89 10.00 .00 640-00

The system automatically creates one invoice expensing to two GL account numbers.
11. Memo

Enter the memo to appear on the Check Register (up to 30 characters). Press Enter (CR) to skip this
entry. When the memo is complete, the field returns to the document number (field #6).

12. You can perform the following functions:
Change a document - Information can be changed for documents added to the open documents
file during Void Check Entry. In the browser in the lower portion of the screen highlight the

-
document number to be changed and click [# to edit the line item information. You can change
fields #7-11.

Delete a document. In the browser in the lower portion of the screen highlight the document

number to be changed and click & to delete. You must then respond with YES to the Are you sure
you want to delete? prompt.

-
Add a document. Select the @& to add an invoice to the voided check. Complete fields #6-11.

Press F3 or Done to end check entry and returns to the Bank field

T 01-FACTS 7.7 Development, Mon-Invoice Check Entry {(APE330) - Infor - |EI|1|
File Edit Yiew Help

AF CP=09/2004 SEF
Bank | of First National Bank of Atlanta T

Check # 0oo4:50 Regular 003220 Manual 000449
Wendor I:I Balance 0.00

Date  |1z2/2002007

Check Amount Distributed oo

oo | |

E] L | Document| Inwaice [ate | Amountpaid| Discount Taken| GIL# | hlema |

B0

I

Done

Entervendor, F2-Search
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How to enter noninvoice checks

1.
2.

10.
11.

12.

13.

14.

15.

Access this program by choosing Accounts Payable-->Checks-->Noninvoice Check Entry.

In the Bank field, enter the bank on which the check was written. The entry must be a valid
bank. Press Enter (CR) to default to the first bank on file. Press F2 or — to search.

In the Check number field, enter the manual check number (1-999999). Press Enter (CR) to
default to the next check number after the number displayed as the last manual check. F2 lists
noninvoice manual checks already entered but not yet updated by the Check Register. Once
checks are listed, enter the beginning check to list if not already displayed, press Enter (CR) to
continue listing documents or enter the line number of the check to display in detail.

In the Vendor field, enter the vendor number for this check. The vendor number, name, address
and balance are displayed. Press F2 or — to search.

In the Check date field, enter the date of the manual check. The date must be within the current

or next general ledger period and not prior to the current AP period. Press Enter (CR) to default
to the system date.

In the Check amount field, enter the dollar amount of this check (.01-9999999.99).

This concludes the header portion of the Noninvoice Check Entry program. At this time, the
system creates a header record and all header fields except #1-3 are accessible through the
change header routine. Fields #1-3 can only be changed by deleting and re-entering the check.

To enter invoices complete the steps below.

In the Document field, enter the document (invoice) number (up to 10 characters). Press F3 or
a to end the entry process.

In the Invoice date field, enter the invoice date. Press Enter (CR) to default to the system date.

In the Amount paid field, enter the amount paid (+/-9999999.99). Press Enter (CR) to default to
0.

In the Discount taken field, enter the amount of the discount taken (+/- 9999999.99) not greater
than the payment amount. Press Enter (CR) to default to 0.

In the General ledger number field, enter the general ledger number to expense. The entry must
be a valid general ledger number. If the general ledger posting table assigned to this vendor has
preset expense accounts, press Enter (CR) to default to the GL account number in the GL

posting table. All numbers of the GL posting table may be displayed by pressing F2 or — to
search.-search.

In the Memo field, enter the memo to appear on the Check Register (up to 30 characters). Press
Enter (CR) to skip the entry. When the memo is complete, the field returns to the document
number field so you can enter another document line.

Press F3 or a to end the entry process. You can perform the following functions:

Change a document - Information can be changed for documents added to the open documents
file during Void Check Entry. In the browser in the lower portion of the screen highlight the
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document number to be changed and click & to edit the line item information. You can change
fields #5-11.

Delete a document. In the browser in the lower portion of the screen highlight the document

number to be changed and click & to delete. You must then respond with YES to the Are you
sure you want to delete? prompt.

=
Add a document. Select the & to add an invoice to the voided check. Complete fields #5-11.

F4 or Done Exits the program.
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EFT Approval (APE340)

In this program an authorized user approves the electronic payments that have been submitted.
Approving a payment means the user wishes to process the payment in the next batch to be sent to the
bank (for ACHs) or is ready to manually create the wire transfer.

Payments can also be rejected, which means they will be removed from the approval screen and not paid.
The invoices will be cleared from the payment file. Rejected payments will be recorded as rejected on the
Check/Payment Register.

Multiple payments to the same vendor and bank account will be combined in the payment batch file.
Optionally, based on the setting in Vendor EFT Entry, payments to different vendors that go to the same
bank account will also be combined in the batch file.

The approval process provides control over EFTs similar to the act of signing a check. If desired, you
could require one person to select the payments and a different person to approve them and generate the
batch file that would be sent to the bank.

If the user who selects this menu option is not authorized to approve AP EFT transactions in User Code
F/M, a message will be displayed and the program will return to the menu.

EFT Payment Processing Details

If payments are selected that are flagged as a consumer type, these will be written to a separate EFT
payment batch file from the non-consumer type payments. This is because each EFT payment batch file is
created in only one ACH entry class code format. The consumer payments will be built into a batch file
with the PPD entry class code format. All other payments will be build into a separate payment batch file
with the selected entry class code format.

All approved ACH payments to the same ACH entry class code will be in one EFT Payment Batch. Each
approved wire transfer will be in a separate EFT Payment Batch. This way, each wire transfer “batch” can
be accepted as it is manually created.

Multiple ACH payments for the same vendor to the same bank account in the same batch will combine
into one payment record in the EFT Payment Batch file. Optionally, multiple ACH payments to different
vendors with the same bank account in the same batch can also combine into one payment record in the
EFT Payment Batch file. When this happens, the single payment will be assigned the next ACH combined
payment number as the “check” number. This is what will be transmitted to the bank and show on the
user’s bank statement. When the register prints, the combined payment information will print and then
the individual checks that made up that payment will print.
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Use the following fields to approve electronic funds transfers:

1. Bank

Enter the bank for payment approval. Press F2 or ~* to search. The bank must be setup to support
electronic payments.

Note: If a password is required, you must supply it before the payments will display.

The line browser displays each electronic payment that has been submitted from the selected bank.
Payments that have already been approved but not yet created into a batch are also displayed. The
browser contains the following information:

- Payment number
-Date and user who approved the payment
Vendor number
Vendor Name/ City/State
Payment amount
- Discount amount
‘Payment type

- Account number: If the payment type is ACH, then this is the last 4 digits of the account
number. If the pre-note status is not approved, an asterisk will display after the account
number.

-Consumer payment: If the payment type is ACH and the vendor is flagged to receive
consumer payments in APVEFH, then “Yes” or “No” will display to indicate if this is to be
treated as a consumer payment.

You can highlight lines in the browser and select from the following functions:

Approve - Approves the highlighted electronic payment. Note: This button is only available if the
payment has not yet been approved and the account’s pre-note status is “A” for ACH payments.

Reject - Rejects all invoices for the highlighted payment.

Change Account - This button is only enabled for ACH payments to vendors with multiple bank
accounts that have approved pre-notifications. Displays the Change Account (APE341) screen,
showing all of the bank accounts with approved pre-notifications set up for this vendor.

Cons Payment--Toggles the Consumer Payment. This changes the consumer payment flag between
yes and no. This button is only be enabled for payments to a vendor who has been selected to receive
consumer payments in Vendor EFT Entry.

Process - If you select Process, FACTS checks for payments that have been approved for the
specified bank, completes the following for those payments:

0 Verifies that the pre-notification status on the selected account is “A” for all approved ACH
payments. If any fail, the system displays a message and returns you to the EFT Approval
screen, so you can resolve the payment by either changing the account or holding the
payment.

0 After the FACTS verifies the pre-notification status on the selected account is “A”, you can
enter the payment date, which must be in the current or next GL period and the ACH entry
class code. The ACH Entry Class will default from Bank F/M but can be changed by the user.
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0 For ACH type payments, this creates the EFT Payment Batch file. The EFT Payment Batch file
is the NACHA standard file that will be sent to the bank. The file naming convention defaults
to company-bank-batch-date-time with the extension being the ACH entry class code,
example 01-01-000001-YYYYMMDD-HHMM.CCD. The file name can be changed by the user.
The file will be created in the directory indicated in Bank F/M. For wire transfer type
payments, no EFT Payment Batch file will be created. If only wire transfer payments are
included in this run, the ACH Entry Class and Batch File Name fields will be excluded.

Done — Exits the program.

B 01-FACTS 7.7 Development, 01-FACTS 7.7 Development, EFT Approval {APE340) - Infor

File Options Help
Bank o First Hational Bank of Atlanta

Fayment # I Approved Wendor | Mame/CitwSt

Fayment DiscountI Type I Aot Consumer I
W10 Industrial Supply Distributars Atlanta, GA 94050 .00 ACH Mo
W eneral Industrial MF& Atlanta, GA 200032
W00 General Industrial MF& Atlanta, GA 3000.00 .00 ACH
Woo0002019 01/05/0 by ST W01 Industrial Supply Distributors Atlanta, GA 20000.00 00 ufire

][ Reject ][ Chy Acct ][ ][ Process ][ Done
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Change Account (APE341)

The Change Account (APE341) screen shows all of the bank accounts with approved pre-notifications set up for this vendor

Highlight the appropriate accounts in the browser and press the Select Acct button to select the one to use. Press Done to exit
the screen when you have selected the desired accounts.

T o1-FACTS 7.7 Development, Change Account (APE341) - Infor [_ =] |
Help
Yendor vioo  General Industrial MFG
Routing # Account # Primarny | Acct Mame/Dezcription Type
OTEA01251 B 04 ez Stephanie Keller
O7E401251 BO27721 Sammy Dawvis dr. Savlngs
075401251 G035529 Cheding
Select Acct ] [ Done
FACTS AP
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How to approve electronic funds transfers
1. Access this program by choosing Accounts Payable-->Checks-->EFT Approval

T 01-FACTS 7.7 Development, EFT Approval {APE340) - Infor
File Options Help

o x]

Bank o First National Bank of Atlanta
FPayment # Wendar Fayment Discount | Type | Acct | Multiple Consumer Pmt | Approved
___________ 00 ACH 8281 R
MWO00054022 w0z 26834 00 Wiire Mo 0022008 by STH
WiD00054024 W00 S0000.00 00 Wire Yes
[ Approwe ] [ Haold ] [ Reject ] [ Chyg Acct ] [ cons Pmt ] [ Process ] [ Lone ]

2. In the Bank field, Enter the bank for payment approval. Press F2 or —* to search. The bank must
be setup to support electronic payments.

Note: If a password is required, you must supply it before the payments will display.

3. The line browser displays each electronic payment that has been submitted from the selected
bank. Payments that have already been approved but not yet created into a batch are also
displayed. The browser contains the following information:

- Payment number
-Vendor number

Payment amount
- Discount amount

-Payment type

- Account number: If the payment type is ACH, then this is the last 4 digits of the account

number. If the pre-note status is not approved, an asterisk will display after the account
number.

Multiple accounts: If the vendor has multiple accounts set up in APVEFL, then “Yes” will
display

- Consumer payment: If the payment type is ACH and the vendor is flagged to receive

consumer payments in APVEFH, then “Yes” or “No” will display to indicate if this is to be
treated as a consumer payment.

-Date and user who approved the payment.

4. You can highlight lines in the browser and select from the following functions:

Approve - Approves the highlighted electronic payment. Note: This button is only available if
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the payment has not yet been approved and the account’s pre-note status is “A” for ACH
payments.

Hold - Resets the highlighted payment. This button will only be available if the payment has
already been approved.

Reject - Rejects all invoices for the highlighted payment.

Change Account - This button is only enabled for ACH payments to vendors with multiple
bank accounts that have approved pre-notifications. Displays the Change Account (APE341)
screen, showing all of the bank accounts with approved pre-notifications set up for this
vendor.

Cons Payment--Toggles the Consumer Payment. This changes the consumer payment flag
between yes and no. This button is only be enabled for payments to a vendor who has been
selected to receive consumer payments in Vendor EFT Entry.

Process - Once payments for the bank have been approved, the Process button is enabled and
selecting it will do the following:

0 Verifies that the pre-notification status on the selected account is “A” for all approved
ACH payments. If any fail, the system displays a message and returns you to the EFT
Approval screen, so you can resolve the payment by either changing the account or
holding the payment.

0 After the FACTS verifies the pre-notification status on the selected account is “A”, you
can enter the payment date, which must be in the current or next GL period and the
ACH entry class code. The ACH Entry Class will default from Bank F/M but can be
changed by the user.

0 For ACH type payments, this creates the EFT Payment Batch file. The EFT Payment
Batch file is the NACHA standard file that will be sent to the bank. The file naming
convention defaults to company-bank-batch-date-time with the extension being the
ACH entry class code, example 01-01-000001-YYYYMMDD-HHMM.CCD. The file
name can be changed by the user. The file will be created in the directory indicated in
Bank F/M. For wire transfer type payments, no EFT Payment Batch file will be created.
If only wire transfer payments are included in this run, the ACH Entry Class and Batch
File Name fields will be excluded.

Done — Exits the program.

FACTS AP
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Payment Batch Status (APE350)

Use the EFT Payment Batch Status program to indicate when an EFT Payment Batch has been accepted
or rejected by the bank. All batches that have not yet been updated through the Payment Register
display on this screen. Note that there may not be a user running the Payment Register when another
user enters the EFT Payment Batch Status program.

Use the following to accept or reject EFT Payment Batches:

In the browser in the lower portion of the screen, FACTS displays the following information:
-Bank

*Batch

Type - ACH or wire transfer

-Status - created, accepted, rejected

-Comment for Rejected batches

You can select from the following for any batch whose current status is created or accepted:

Accept - sets the batch status to accepted and displays a message indicating that remittances will be
sent to the vendors. You can select Yes to set the remittance date and send or print remittances, based
on vendor preference. Remittances contain the same information that is on the check voucher: EFT
number, FACTS vendor number and name, invoice date, number, amount, discount, paid and
comments. Select Cancel to return to the browser without accepting the batch or sending remittances.

Reject - sets the batch status to rejected and displays a message indicating that the payments in the
batch will go back into the EFT Approval program with the status reset to Submitted. You can enter a
comment indicating why the batch was rejected by the bank. Select Yes to send the payments back to
the EFT Approval program and reset the status of each to submitted, and the batch status to rejected.
Select Cancel to return to the browser without rejecting the batch.

5-32 FACTS AP



Accounts Payable—7.7 Checks

Payment Register (APR310)

Function

This program allows the user to obtain a report of all regular, manual, non-invoice and void
check information since the last Check Register was updated. The optional update following
the register updates all necessary files. As the register updates, FACTS writes each check or
electronic payment record and the detail of invoices being paid to the check history files.

This register is an audit trail of all check disbursements or voids and should be printed,
checked and updated each time regular checks are printed. It may also be printed after field
of manual, noninvoice or void checks. If the register is not printed directly after field of
manual, noninvoice or void checks, the information appears on the next register with regular
checks.

Information for the register comes from four programs - Check Print, Manual Check Entry,
Noninvoice Check Entry and Void Check Entry. Plain paper vouchers print only for the
checks or EFT submissions that are currently being printed. A second check run without first
posting already printed checks will not produce vouchers for checks from both check runs.

The user has the option to:

e Print a listing of all checks.

e  Select check types (regular and/or manual and void).

¢ Build and print a general ledger distribution, if needed.

e DPost to general ledger, if a general ledger distribution is built.

e Update the open documents file and vendor balance.

e Update the monthly disbursement distribution and check files

e Update the company accounts payable balance, clear the check files, and the
appropriate control records.

Register information includes the following: check number, check date, check amount, vendor
number and name. Information about each document paid by the check includes document
number, entry date, due date, payment amount, discount taken and memo.

Totals are printed for regular checks, manual and void checks and register. The register recap
prints the beginning AP balance, payments, discounts and ending AP balance. The total
number of regular, manual and void checks listed is also included. Depending on a flag set in
the AP static control record, the user may obtain a general ledger distribution.

Unform Archiving

The AP Payment Register can archive information to Unform. The program prints 2 documents: the
Register and the GL Distribution. These two documents are linked in Unform Archive. It is possible
for the user to print a register and not print an associated GL Distribution.

On the register, the system prints the following in the print stream to indicate that a GL distribution
should be expected: GL Distribution=true. If a GL Distribution should not be expected, we will print:
GL Distribution=false

The Unform document type CheckReg for both documents, but the document ID differs by appending
"-GL" to the register number for the GL Distribution. Only the last copy of a specific register # is be
kept on file.

When a register is reprinted, and it is overwriting an existing archive of that same register #, the
system updates the title of the associated GL Distribution to indicate that it is no longer valid.
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The Bank Code prints on the first page of the register. Combining it with the check number, gives a
link to Document Code APCK.

EFT Payment Batches

Note that EFT Payment Batches must be accepted by the bank before they will run through the
register program. There may not be any users in EFT Payment Batch Status program when another
user tries to run the Payment Register.

When the user selects OK to run the register, the program checks to determine if there are any
electronic payment batches that have been created but not yet accepted by the selected bank and
displays an entry window detailing these batches. The browser information includes, the Batch, Type,
Date batch was created, Time batch was created, User who created batch, and the Batch Amount. You
can select Proceed to continue without updating these open batches or Cancel to cancel the register
run and return to the menu.

The electronic payments print in a separate section on the AP Payment Register report and are
grouped by batch. For each EFT payment batch, the batch status information prints first. This shows
the user and date for when the batch was created and accepted. Then the payments and invoice
information prints. If a payment was combined with others in the payment batch file, the combined
payment number will also print. Payment numbers that were rejected in EFT Approval also print in
this section. Rejected batches also print the batch status information, showing the user and date for
when the batch was created and rejected. At the end of the section, there is a total of all electronic
payments.

User Fields

The following fields are involved in printing the Check Register:
1. Date

Enter the check register date. The date entered must be in the current or the next GL period and not

i,
prior to the current AP period. Press Enter (CR) or L2/ to default to the system date.
2. Bank

Enter the bank for which checks are to print. The entry must be a valid bank. Press Enter (CR) to
default to the first bank on file. Press F2 or —% to search. Press " to print for all banks.
3. Regular checks

Choose whether or not you want to print information regarding regular checks (checks generated
through the Check Print program). The program defaults to unselected if there are no regular
checks to print. However if the program cannot find manual and void checks to print, it defaults to
selected.

4. Manual and void checks
Choose whether or not you want to print information regarding manual and void checks. Press

Enter (CR) to default to unselected if there are no manual or void checks to print. However, if there
are no regular checks to print, it defaults to selected.

The Check Register prints by reading through the regular check file and the manual and void check
file. Information about each check prints as the general ledger distribution file is built.

[1[/For users printing the GL distribution, the following field is displayed:

5-34 FACTS AP



Accounts Payable—7.7 Checks

5a. Check register. OK to print GL distribution?

After printing the Check Register, verify the printout. If there is a correction to be made, select
Cancel to exit the program. After the correction is made, run the register again. If everything is
correct, select OK to continue. The program then prints the GL distribution. Once the GL
distribution prints, this message appears.

Check GL distribution. OK to update?

After printing the GL distribution, verify the printout. If everything is correct, select OK to

continue. The program proceeds with the update. If there is a correction to be made, select Cancel

to exit the program. After the correction is made, the entire register process begins again.
[ For users not printing the GL distribution, the following field is displayed:

5b. Check register. OK to update?

After printing the Check Register, verify the printout. If there is a correction to be made, select
Cancel to exit the program. After the correction is made, run the register again. If everything is
correct, select OK to continue so the program can proceed with the update.

¥ o1-FACTS 7.7 Development, Check Register (APR310) - Infor - |EI|5|

Template Print Opkions  Help

AP CP=09/2004 SEF

Date 7| system Date GL CP=0%2004 SEP

Bank Iy First National Bank of Atlanta
Regular Checks
Manual and Yaid Checks

Template Printer

[o] 24
Mone Wind Laser

Enter check register date, F1-System Date
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How to run the Payment Register

1. Access this program by choosing Account Payable--> Checks-->Payment Register.

2. In the Date field, enter the check register date. The date entered must be in the current or the
next GL period and not prior to the current AP period. Press Enter (CR) defaults to the system
esae ]

date. Select the L/ icon to field the system date.

.& The current AP and GL Periods appear in the upper left corner of the screen.

3. In the Bank field, enter the bank for which checks are to print. The entry must be a valid bank.

Press & to print for all banks. Press Enter (CR) defaults to the first bank on file. Select the —=
to search for banks.

4. Select the Regular Checks checkbox to indicate whether or not you want to print information
regarding regular checks (checks generated through the Check Print program). The program
defaults to unselected if there are no regular checks to print. However if the program cannot
find manual and void checks to print, it defaults to selected.

5. Select the Manual and Void checks checkboxes to indicate whether or not you want to print
information regarding manual and void checks. Press Enter (CR) to default to unselected if
there are no manual or void checks to print. However, if there are no regular checks to print, it
defaults to selected.

1& The Check Register prints by reading through the regular check file and the manual and
void check file. Information about each check prints as the general ledger distribution file is
built.

6. If you have FACTS set to print GL distribution, the system displays the following message:
Check Register. OK to Print GL Distribution?

7. After printing the Check Register, verify the printout. If you need to correct the register data,
select Cancel to exit the program. After you make the correction, you can rerun the Check
Register. If everything is correct, select OK to continue. The program then prints the GL
distribution.

Once the GL distribution is printed, the program displays the message: Check GL Distribution.
OK to Update?

After printing the distribution, verify the printout. If everything is correct, select OK to
continue. The program proceeds with the update. If you need to make a correction, select
Cancel to exit the program. After you correct the information the correction is made, re-run the
entire register process —meaning run the register first, then print the GL distribution, followed
by the optional update.

OR

If you are not printing the GL distribution, the program displays the message: Check Register.
OK to Update?

After printing the Check Register, verify the printout. If you need to make a correction, select
Cancel to exit the program. After you make corrections, rerun the register. If everything is
correct, select OK to continue.
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CHAPTER 6

Inquiries

The Accounts Payable inquiry allows the user to display information on
vendors on the screen without affecting any data in any files and without
locking any files. The Vendor Inquiry displays various information for
vendors. The information included is general, code, and activity, open/ detail
documents, paid documents, vendor notes, payment history, and ledgercard
information. (Notes are entered through this program.)

T Infor ERP FACTS - FACTS 7.7 Pre-release Demo - Master Menu =3
1naTo = ERP FACTS Infor Global Solutions (IN4/T2) [ &
111902009 - 12:41 pm ci77alpha 2 7 i sefings (@ Hep T

Yendor Inguiry

& £ S

Crocument Entry Fayment & Hold Checks Inquiries
Selection

= kil .

Reparts & Prints End of Periad File Maintenances

powared by 14 Fame
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Vendor Inquiry (API1610)

Function
Program Details

When you first access Vendor Inquiry, the upper portion of the screen contains a Go to field, which is
used locate specific vendors. The Go to field is case sensitive. This means that if you enter v100 to
lookup a vendor number when someone entered it as V100, the customer record you are looking for
will not appear in the browser.

You can select the T (filters) icon if you want to limit the number of records that appear in the inquiry
browser. Choose Option->Filter Values.

Sync Feature

Sync is a method of connecting the entry programs with information displayed in customer, item and
vendor inquiries. It is a helpful feature because it enables you to get real-time information such as
customer balances, vendor balances and warehouse quantities, while you are working in entry
programs.

You can select the & icon to change or update the information displayed in this inquiry. When you

use the Sync feature, the icon display changes to “#. Use this display to note whether your inquiry is
in Sync mode.

Inquiries are synchronized on a per user basis. In other words, if you are signed on to FACTS in one
window with one name and signed on in another window with another name, it will appear as if the
Sync function is not working,.

Processing

The Activity view displays by default. From the Windows menu, you can select other windows of
information to open.

The Vendor Inquiry program you can access seven views of information in the lower portion of the
screen. The available views are:

e Activity, which is used to display vendor activity information including month-to-date, year-to-
date and prior year figures for invoices, payments, discounts taken and allowable discount. Also
included are the account opening date, last invoice date, last payment date, highest balance
date, highest balance amount and 1099 balance.

e  Check History, which is used to view check history for the selected vendor. Information
displayed on this view includes: Check #, Bank, Check date, Check type, Check amount, and
Register #. The view can be sorted by: descending check number, ascending check number,
descending check date, and ascending check date. Select the Line Detail button to view the
details of an AP transaction that was paid by this check. On the Line Detail screen the browser
displays columns for: Document #, Status, Original amount, Document date, Current amount,
Transaction date, Payment amount, Discount amount, Memo, PO #, and Branch. The Doc Detail
button displays information that varies by document status: If the status of the transaction is
open, the system displays the same window as the line detail of the Open Docs view. If the
status of the transaction is past, the system displays the same window as the line detail of the
Paid Docs view. If the status of the transaction is deleted, the doc detail button will be disabled.
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e Code information, which is used to display code information including vendor class, terms
code, freight code and general ledger posting table.

e Contacts, which is used to display phone numbers, contacts, email addresses, customer
company website, and any message entered about the customer (on the Customer F/M
Invoicing screen).

¢ General information, which is used to display general information including phone number(s),
contact(s), message, vendor status, our customer number, our tax exempt number, normal
document group, 1099 ID, ship-from, store past PO’s flag and use ledgercards flag.

e Open/detail documents, which is used to display open documents, from oldest to newest, for
the selected vendor.

e Paid documents, which is used to display, for the vendor selected, paid documents that have
been removed from the open documents file by the Document Removal Register.

e Payment history, which is used to display the total of all payments made to the vendor for the
next period, current period and the 26-prior periods.

e Ledgercards, which is used to display all ledgercard information for the selected vendor.

e Notes, which is used to view notes for the specified vendor.
e  User-Defined, which is to display any user defined fields entered on the User Defined tab of
Vendor F/M (APF910).
< For more information about inquiry features, such as Sync, filters and
preferences, see Using FACTS.

To view vendor information:

1. Enter the vendor for which you want to view information.

Select whether to sort vendor records by vendor number, alpha lookup or
contact. Select a sort order by choosing Sort by from the menu bar.

Choose Options DFilter Values to select filters if you want to limit the number
of records in the inquiry browser.

Use the vertical scroll bar, up and down arrow keys or the Page Up and Page
Down keys through the list of displayed vendors.

2. Select a view.

Choose a view from the View menu option or select a view from the view bar.

View descriptions

General Displays general information including phone
number(s), contact(s), message, vendor status, our
customer number, our tax exempt number, normal
document group, 1099 ID, ship-from, store past PO’s
flag and use ledgercards flag.

Codes Displays code information including vendor class,
terms code, freight code and general ledger posting
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Activity

Check History

Open
Documents

table.

Displays vendor activity information including
month-to-date, year-to-date and prior year figures for
invoices, payments, discounts taken and allowable
discount. The account opening date, last invoice date,
last payment date, highest balance date, highest
balance amount and 1099 balance are also included.

Displays check history for the selected vendor.
Information displayed on this view includes: Check #,
Bank, Check date, Check type, Check amount, and
Register #. The view can be sorted by: descending
check number, ascending check number, descending
check date, and ascending check date. Select the Line
Detail button to view the details of an AP transaction
that was paid by this check. On the Line Detail screen
the browser displays columns for: Document #,
Status, Original amount, Document date, Current
amount, Transaction date, Payment amount, Discount
amount, Memo, PO #, and Branch. The Doc Detail
button displays information that varies by document
status: If the status of the transaction is open, the
system displays the same window as the line detail of
the Open Docs view. If the status of the transaction is
past, the system displays the same window as the line
detail of the Paid Docs view. If the status of the
transaction is deleted, the doc detail button will be
disabled.

Displays open documents, from oldest to newest, for
the selected vendor. Summary information includes
document number, document type (Invoice,
Noninvoice), purchase order number, register
number, entry period, date entered, date due, original
amount and current amount.

Getting more information on an open document:

In the view area, select the line and choose the Line
Detail button or double click the icon at the
beginning of that line.

Detail information displays summary plus the memo,
original and current discount amounts and any
transactions against the open documents. Transaction
information includes sequence number, transaction
date, entry period, register number, payment and
discount amounts and memo.

The Line Detail screen from the Open docs and Paid
Doc History and Check History views of Vendor
Inquiry contain the GL Posting button, which is
enabled when the transaction highlighted in the
browser is one that allows for drill back from the
source document to the GL posting that was created

Accounts Payable—7.7
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FACTS AP

Paid
Documents

Payment
History

Inquiries

by the register. If the GL posting records can be
found, then the inquiry will display defaulting to
showing transactions for this document only.

Displays, for the vendor selected, paid documents
that have been removed from the open documents file
by the Document Removal Register. Information
includes document number, original amount and
discount, entry period and register number,
document removal register number, last check
number and purchase order number.

Getting more information on a paid document:

In the view area, select the line and choose the Line
Detail button or double click the icon at the
beginning of that line.

Detailed transaction information includes sequence
number, transaction date and period, register
number, payment amount, discount amount and a
memo. Memo information displays check type
(Manual, Regular) and check number.

The Line Detail screen from the Open docs and Paid
Doc History and Check History views of Vendor
Inquiry contain the GL Posting button, which is
enabled when the transaction highlighted in the
browser is one that allows for drill back from the
source document to the GL posting that was created
by the register. If the GL posting records can be
found, then the inquiry will display defaulting to
showing transactions for this document only.

Displays the total of all payments made to the vendor

for the next period, current period and the 26-prior
periods.
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Ledgercards

Notes

User-Defined

Accounts Payable—7.7

Displays all ledgercard information for the selected
vendor.

The inquiry lists ledgercards from newest to oldest by
default. To view oldest to newest:

Click on the Date column header. (You can also click
on any other column header to resort ledgercards.)

In either order, select the beginning date to view.
Information includes date, debit amount, credit
amount, balance, transaction register name, document
and register number.

Select the View Doc button at the bottom of the
screen to display additional document detail
information.

The system checks to see if detail info exists for
currently highlighted ledgercard line for its
transaction type. For AP ledgercards there are 4
transaction types: B - Begin Balance, E - Doc Entry
Register, C - Check Register, and V - Vendor Balance.
Only ledgercards of type E will result in a drill down
to. Doc Entry Register type documents display
additional either the Open Docs line detail window
(API614) or the Paid Docs line detail window
(API615).

Displays notes for the specified vendor. In the
browser in the lower portion of the screen the system
displays the date the note was created, note category,
urgent note indicator, and subject. You can double
click a note line in the browser to display the View
Note screen, which lists the note subject and text,
note type, category, date created, and date edited.

You can access the Notes Entry (SME710) program
from the Options=>1 Vendor Note Entry to enter or
modify notes for the specified vendor.

The data that appears on the User-Defined view of
Vendor Inquiry comes from the User-Defined view of
Vendor F/M (APF910). Many users have a few
pieces of information about customers, vendors, and
items that are unique to their business that they
would like to enter into FACTS for reference
purposes. The User-Defined view displays user-
defined fields entered the major file maintenances
and makes them available in FACTS Inquiry

FACTS AP
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programs for information only. There are 5 user-
defined fields that can be entered on the User-
Defined screen of Vendor F/M (APF910). There
user-defined field must first be configured by a user
that has administrator privileges for User-defined
Fields setting on the Security tab of User Code F/M
(SMF410).

RM Contacts Displays contact information from the optional
Relationship Management module if it has been
purchased for your FACTS system.

RM Profile Displays profile information from the optional
Relationship Management module if it has been
purchased for your FACTS system

T 01-FACTS 7.6 Development, AP ¥endor Inquiry - Alpha Order (APIG10) - I - |EI|1|

Options  Wiew Sort By Export  Print  Help

GoTo |

Alpha Yendor Yendor Mame City, State -
ATLANTA CR U113 atlanta Crane & Hoists Doraville, GA
ATLANTA GA U111 Atlanta Gas Company Atlanta, GA v|
4 L3

6 m Codes Contacts General Ledgercards Open Docs

Date Balance
Opened 11302005 Last Payment Current 00
Last Invoice High Balance 1098 K
Invoices Fayments Disc Taken Disc Allowable
MTD 00 00 00 00
YTD 00 00 00 00
PYR 00 00 00 00

Exit

Enter beginning alpha to go to
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B 01-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Order (APIG10}) - I - |EI|1|

Options  Wiew Sort By Export  Print  Help

GoTo |

Alpha Yendor Yendar Mame City, State -

ATLANTA CR Doraville, GA
ATLANTA GA U111 Atlanta Gas Company

Atlanta, GA hd
4 *

a Activity m Contacts General

U113 Atlanta Crane & Hoists

Ledgercards

Yendor Class Hn  TEST
Terms Code 01 1% 10 Net 30
GL Table o001 Office

Freight Code  Prepaid

Open Docs

Enter beginning alpha to goto

01-EACTS, I.7 Development, AP Yendor Inguiry. - Alpha Order (AP1610) - Infor
COptions  Wiew Sort By Export  Print  Help

GoTo

Alpha Yendor Class Contact 1 Contact 2 ]
Richard Dickson

GEORGIA IH

GEDRGIA HE OFF Jim Anderson Arthur Lowe
GEDRGIA SH INU Michael Brooks Glenn Hornsby e
< | >

Activity W Codes Contacts General Ledgercards

Mo information for 118

Exit

Enter beginning alpha to goto
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T 01-FACTS 7.6 Development, AP ¥Yendor Inquiry - Alpha Drder {(AP1610) - In|
Options  Wiew Sort By Export  Print  Help

GoTo ||

Alpha

ATLANTA CR
ATLANTA GA

a Activity

Contact 1
E-mail

Contact 2
E-mail

Weh Site

Message

Wendor Wendor Name

City, State =

U113 Atlanta Crane & Hoists Doraville, GA
U111 Atlanta Gas Company Atlanta, GA =
o

in]
=4

des ontacts General Ledgercards

Fhaone

Fhaone

Open Docs

Enter beginning alpha to go to

T 01-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Drder (API610) - Inl

Options  Wiew Sort By Export  Print  Help

Use Ledgercards  Ho

GoTo ||
Alpha Yendar endar Mame City, State -
ATLAHNTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLANTA GA U111 Atlanta Gas Company Atlanta, GA v|
4 *
a Activity Coides Contacts Ledgercards Open Docs
Address 1 Wendor Status  Permanent
Address 2 Our Cust#
Address 3 Doc Group
Tax Exempt # Ship-Fram SAME
1089 1D # Store PastPO's  Ne

Enter beginning alpha to go to
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T D1-FACTS 7.6 Development, AP ¥endor Inquity

Options  Wiew Sort By Export  Print  Help

GoTo | |
Alpha | Yendar | endar Mame | City, State -
cue? N
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLAHTA GA U111 Atlanta Gas Compan Atlanta, GA =
»
6 Activity Codes Contacts General Open Docs
Date | Debitl Creditl BalancelTransaclion | Doc#l IF
071 0/2003 28788 00 Check Register 45127889631
071052003 259.93 287.88 Check Renister 321981

1

StartFrom [Nevestwooeen W[ ]

(@, viewpor |[B  Ext |

T 01-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Drder (API610) - Inl

Options  Wiew Sort By Export  Print  Help

GoTo || |
Alpha | endar | Yendar Mame | City, State -
cuwe? N
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLANTA GA U111 Atlanta Gas Compan Atlanta, GA =
*

RM Contacts Z-User Def

Paid Docs Payment Hist HNotes

Document#l T | PO # | Entry Date | Due Date | OrigAmtl CurrentAmtl Reog# | P
321981 | 000DBS — O9/282004 10/08/2004 259.93 .00 1512 20
4512789631 | B56321 09142004 097242004 287.88 .00 1508 20

|
Start From | Documert x|

[@, LneDetal |[W  Ext |

|Enter beginning alphato go to
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T 01-FACTS 7.6 Development, AP ¥Yendor Inquiry - Alpha Drder {(AP1610) - In| - |EI|1|

Options  Wiew Sort By Export  Print  Help

GoTo || |
Alpha | Yendar | endar Mame | City, State -
cue? N
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLAHTA GA U111 Atlanta Gas Compan Atlanta, GA =

3

Open Docs Payinent Hist Motes RM Contacts Z-User Def

Due Date | Doc#l OriginaIAmtl Original Discl Entry Perl Entry Reo# | Riml |
0852472004 4353698762 TEa.02 oo 20044058 1508 o059
091 7r2004 3161986198 22212 0o 2004/09 1505 0059
091 7r2004 3519819819 112.80 0o 2004/09 1505 0059
082152004 B262734852 210.28 oo 2004708 1499 0059
0gi21r2004 7236823582 438.56 0o 2004708 1499 0058
082052004 435734572 438.56 0o 200408 1501 0058
082052004 2624572457 22555 0o 200408 1501 0059
«| | »

StartFrom [Desomdng e pme [ |

(@, LireDetail | (W Exit

|Enter beginning alpha to go to

T 01-FACTS 7.6 Development, AP ¥endor Inquiry - Alpha Order (APIG10) - Infol - |EI|1|

Options  Wiew  Sort By Export  Print Help

GoTo | |
Alpha | endar | Yendar Mame | City, State -
cuwe? N
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLAHNTA GA U111 Atlanta Gas Compan Atlanta, GA =

3

Open Docs Paid Docs W Motes RM Contacts Z-User Def

Feriod Desc | Period | Paymentl 1=l
Mext Period 200410 OCT i
Current Period 2004509 SEP 2086.68 L |
Last Period 2004/08 AUG 87712
Previous Period 200407 JUL T46.40
Previous Period 2004006 JUMN BEE.04
Previous Period 200405 MAY 491.80
Previous Period 200404 APR 799.00
Previous Period 200403 MAR 534.04
Previnis Petind Nn4m: FER a1z i

Enter beginning alphato go to
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=101

1-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Order (APIG10}) - T

Options  Wiew Sort By Export  Print  Help

GoTo ||
| Alpha | Yendar | endar Mame City, State ;l
FIRST BAHK U189 First Bank of the South Atlanta, GA
GENERAL IH U188 General Industrial MFG Atlanta, GA
GEORGIA IN U118 Georgia Insurance Services Atlanta, GA hd
o

Open Docs Paid Docs Payinent Hist m RM Contacts Z-User Def

Date Created Category | Urgent | Subject

0240372005 General Information TEST IMFORT NOTE
02i03r2005 General Infarmation Y URGENT VENDOR NOTE
10952004 General Infarmation vendor note

1

Start From | Date id

(@, LireDetail | (W Exit

|Enter beginning alpha to go to

g [ 3

01-FACTS 7.6 Development, AP ¥Yendor Inquiry - Alpha Order (APIG10) - I

Options  Wiew Sort By Export  Print  Help

GoTo | |
| Alpha | Yendar endar Mame City, State ;[
aa vendor aa vendor aa .
801167 tim
vl 11 Vendor 11 o =
4 *
Open Docs Paid Docs Payment Hist HNotes RM Contacts Z-User Def

Mo information for 001167

T Display |[H_ Eat

Enter beginning alpha to go to
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1-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Order (APIG10}) - T

_(olx]
Options  Wiew Sort By Export  Print  Help

GoTo |

| Alpha | Wendor Wendor Name

aa vendor aa vendor aa N

801167 tim

v 11 Vendor 11 o =

4 5
Open Docs Paid Docs Payinent Hist Motes RM Contacts W

Size s

WtV wwEEEeEeERER

Mumeric field

Enter beginning alpha to go to

1-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Order (APIG10}) - T - |EI|1|
Options  Wiew Sort By Export  Print  Help

GoTo

Alpha
TEST UENDOD U999 WHOS

TRADE SERV TRADE_SERV Trade Services
UVENDOR 8 8 UENDOR 8

endar Mame City, State

WHOUILLE, KY
San Diego, CA

_'l_I
DAILLAE W 4 RM Profile | E]

Paid Docs Payiment Hist Motes RM Contacts

Mo information for Y399

ExporttoExcel |[T ClipBoard | (Bl Ext

Enter beginning alpha to go to
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How to view vendor information

1. Access this program by choosing Accounts Payable->Inquiries=> Vendor Inquiry.
2. Enter the vendor code for which you want to view information.

Select whether to sort vendor records by vendor number, alpha lookup or contact. In GUI mode,
select a sort order by choosing Sort by from the menu bar.

Select filters if you want to limit the number of records in the inquiry browser. In GUI, choose
Options—>Filter Values. Use the up and down arrow keys or the Page Up and Page Down keys
through the list of displayed vendors. (You can also use the vertical scroll bar.)

3. Choose a view from the View menu option or select a view from the view bar.
View descriptions

General  Displays general information including phone number(s), contact(s), message,
vendor status, our customer number, our tax exempt number, normal document
group, 1099 ID, ship-from, store past PO’s flag and use ledgercards flag.

Codes Displays code information including vendor class, terms code, freight code and
general ledger posting table.

Contacts  Display phone numbers, contacts, email addresses, customer company website, and
any message entered about the customer (on the Customer F/M Invoicing screen).

Activity  Displays vendor activity information including month-to-date, year-to-date and
prior year figures for invoices, payments, discounts taken and allowable discount.
Also included are the account opening date, last invoice date, last payment date,
highest balance date, highest balance amount and 1099 balance.

Open Documents Displays open documents, from oldest to newest, for the selected
vendor. Summary information includes document number, document type (Invoice,
Noninvoice), purchase order number, register number, entry period, date entered,
date due, original amount and current amount.

Getting more information on an open document: in the view area, select the line and
choose the Line Detail button or double click the icon at the beginning of that line.

Detail information displays summary plus the memo, original and current discount
amounts and any transactions against the open documents. Transaction information
includes sequence number, transaction date, entry period, register number, payment
and discount amounts and memo.

Paid Documents Displays, for the vendor selected, paid documents that have been
removed from the open documents file by the Document Removal Register.
Information includes document number, original amount and discount, entry period
and register number, document removal register number, last check number and
purchase order number.
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Getting more information on a paid document: In the view area, select the line and
choose the Line Detail button or double click the icon at the beginning of that line.

Detailed transaction information includes sequence number, transaction date and period,
register number, payment amount, discount amount and a memo. Memo information
displays check type (Manual, Regular) and check number.

Payment History Displays the total of all payments made to the vendor for the next
period, current period and the 26-prior periods.

Ledgercards  Displays all ledgercard information for the selected vendor. The inquiry lists
ledgercards from newest to oldest by default. To view oldest to newest: Click on the
Date column header. (You can also click on any other column header to resort
ledgercards.)

In either order, select the beginning date to view. Information includes date, debit
amount, credit amount, balance, transaction register name, document and register
number.

Notes Displays notes for the specified vendor. In the browser in the lower portion of the screen
the system displays the date the note was created, note category, urgent note indicator,
and subject. You can double click a note line in the browser to display the View Note
screen, which lists the note subject and text, note type, category, date created, and date
edited.

You can access the Notes Entry (SME710) program from the Options=>1 Vendor Note
Entry to enter or modify notes for the specified vendor.

User-Defined The data that appears on the User-Defined view of Vendor Inquiry comes from
the User-Defined view of Vendor F/M (APF910). Many users have a few pieces of
information about customers, vendors, and items that are unique to their business that
they would like to enter into FACTS for reference purposes. The User-Defined view
displays user-defined fields entered the major file maintenances and makes them
available in FACTS Inquiry programs for information only. There are 5 user-defined
fields that can be entered on the User-Defined screen of Vendor F/M (APF910). There
user-defined field must first be configured by a user that has administrator privileges for
User-defined Fields setting on the Security tab of User Code F/M (SMF410).

RM Contacts  Displays contact information from the optional Relationship Management
module if it has been purchased for your FACTS system.

RM Profile Displays profile information from the optional Relationship Management
module if it has been purchased for your FACTS system

4. When you are finished reviewing information for vendors, select the F4 or the Done button to
close the Vendor Inquiry program.
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CHAPTER 7

Reports & Prints

Most Accounts Payable reports have the option of printing in vendor number,
alphabetical or vendor class order. In addition to the order, the user may
choose the range to be printed. For example, if the order selected is vendor
number, field of the beginning/ending vendor is required.

1.

FACTS AP

The Cash Requirements Report prints up to six time periods of cash
requirements for invoice payment. The periods of time are
determined by the user as well as whether the documents are to print
based on due date or discount date. The report may be printed in
summary (total amount due to each vendor within the specified time
periods) or detail (information on each document due to each vendor
within the specified time periods).

The Open Payables Report prints a list of open payables, zero balance
documents or both. The options are to print in summary (vendors and
their balances), detail (vendors and information on each document
due) or detail with transactions (vendors, and all transactions against
each document).

The Aged Payables Report prints a report of open payables in aging
columns as of a specified aging date. The user may also specify how
many days past due an invoice must be before appearing on the report
and whether to include contact information and purchase information.
The report may be printed in summary (vendor and balance) or detail
(vendor and information on each invoice due to the vendor).

The Inactive Vendor Listing prints a list of all vendors who have been
inactive as of a specified cutoff. Purchase history figures may be
included in the report. This report will not update any files but may
be useful in allowing the user to delete inactive vendors.

The Vendor Listing prints a report of either general or historical
information on vendors. The vendor’s address, phone number,
and/or contact may print on either report.

The Vendor Ledgercards Report prints a list of the transaction types
chosen that have affected the vendor’s balance.

The Vendor Label Print program prints up to 99 labels per vendor and
may be sorted by zip code.

The Rolodex Vendor Card Print program prints up to 99 rolodex cards
per vendor and may be sorted alphabetically.
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9.

10.

11.

12.

13.

14.

The Purchase History Report prints various purchase history
information from the vendor’s history. The user may select month-to-
date, year-to-date or prior year information and determine the
minimum purchases to print. The user has the option to select specific
document groups to print.

The Payment History Report prints total payments made to vendors
for up to 6 periods.

The 1099 Print prints the non-employee compensation statements. The
user chooses the beginning and ending vendor and the document
group(s) to print. The forms used are the standard 1099 forms
distributed by the IRS.

The Vendor Balancing Register is run only when the vendor’s balance
does not agree with the invoices for that vendor (i.e., very unlikely - if
there is a power failure in the middle of an update, etc.). The register
prints all out-of-balance vendors. The optional update will correct
each vendor balance and the total AP balance.

The Check History Report prints information from the check history
file. The report can be printed for one or all vendors and in check date
or check number order.

.The AP Code List prints a listing of the various AP codes: vendor
classes, terms codes and GL posting tables.

Accounts Payable—7.7
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Accounts Payable—7.7 Reports & Prints

T Infor ERP FACTS - FACTS 7.7 Development - Master. Menu

inTom ERPFACTS Leigh Waddell (JLW/TOi) [ ]

P

10/26/2009 - B:47 prn m:77 leigh @ v i setings @ Hep ¥

) en k.

g o Aged Trial Balance

L" Zales History Report
SlepiTerr Sales Repoart

Inwoice Processing Cazh & Credit Returned Chedks Dunning Letters FPayment Histary Report

Application Inactive Customer Listing

Customer Listing

Customer Ledgercards

Customer Label Print

Rolodex Custorner Card Print

Ship-To Report

Ship-To Label Print

Customer Balancing Register

d \.; @ @ Check Payment History Report
éa & AR Gode List

Inquiries Repors & Prints End of Period File Maintenances

powared by |~ Fio s

FACTS AP 7-3



Reports & Prints Accounts Payable—7.7

Cash Requirements Report (APR710)

Function

This program allows the user to obtain a report showing cash requirements for
invoice payments for specified time periods.

The user has the option to:

e Select the order to print - vendor, alpha, or vendor class.

o Select the beginning and ending order choice.

e Select the branch(es) to print.

e Select the document group(s) to print.

e Select due date or discount due date as the date to determine in which
time period the document falls.

e Determine if documents on hold will print.

e Select a detail or summary version of the report.

e Select the status to print: active, inactive or all.

e Print up to six time groupings.

e Select up to 99 days to be used for automatic date increments.

e Select the dates for the time groupings.

If the report is printed based on discount due date, the report will deduct the
allowable discount from the invoice.

Report information includes the following;:

e Summary: The total amount due to each vendor within the specified
time periods and the total balance for the vendor.

e Detail: For each vendor, all open documents that are due within the
time periods specified. Each document number, due date , discount due
date, amount and allowable discount are printed.

Totals are included for each vendor and time period. Report totals are also
included for each time period and all vendors listed. The total number of
vendors listed is also included.

User Fields

The following fields are involved in printing the Cash Requirements Report:
1. Order
Select the order in which to print the report. Order options are vendor, alpha, or vendor class.

2. Beginning order choice

Select the beginning order choice to print. Press F1 or B4 i default to FIRST. Press to F2 search for
vendors and vendor classes.

3. Ending order choice

Select the ending order choice to print. Press F1 or i to default to LAST. Press F2 or — to search
for vendors and vendor classes.
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4. Branch

Enter the branch. The entry must be a valid branch. The program defaults to the branch assigned to
the terminal. Press F1 or <D to default to ALL. Press F2 or —* to search.
5. Document group

Enter up to 10 two-character document groups side by side to print. Press F1 or " to default to
ALL. Note that you may also select "Documents that have no document group" for this option.
Document groups are established in Vendor F/M on the Miscellaneous tab.

6. Due/Discount
Enter whether documents should be grouped based on DUe date or DIscount date. The program
defaults to DU.

7. Holds

Indicate whether to include documents on hold. The program defaults to selected.

8. Scope

Enter whether to print the report in Summary or Detail form. The program defaults to Summary.
9. Status

Enter whether to print Active, Inactive vendors. Press Enter (CR) or & for all vendors. The
program defaults to ALL.

10. Groupings

Enter the number of date groupings to print (2 to 6). The program defaults to 6.
11. Auto increment

Enter the number of days to be used for automatic date increments (0-99). The program defaults to

_'I
the value stored in the AP Static Control F/M. Press F1 or @& to manually type in all ending dates
of time groupings. Most common values are 14 or 30 days.

12. Dates
Enter the ending date for the first date grouping. Select 1] or F1 to default to the system date. If

automatic increments are to be used, the next groups calculate automatically. If automatic
increments are not used, enter each group ending date up to the number of groups selected.
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Open Payables Report (APR720)

Function
This program allows the user to:

e Obtain a list of open payables, zero balance documents or both.
e Review all transactions made against each document.
e View the company accounts payable balance.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

e Select beginning and ending order choice.

e Select the branch(es) to print.

o Select the document group(s )to print.

e Select open documents, zero balance documents or both to print.
e Print next period documents and transactions.

e  Select the status to print - active, inactive or all.

e Select summary, detail or detail with transactions print format.

Report information includes the following;:

e Summary: Vendor number, name and balance.

e Detail: Vendor number, name, document number, document group,
entry period, entry date, original amount and discount, transaction total
amount and current document balance.

e Detail with transactions: Detail plus the transaction date, register
number, type, amount and discount in addition to most of the previous
detail information.

Totals are included for each vendor. Report totals include the total of all
vendors. The total number of vendors listed is also included.

User Fields

The following fields are involved in printing the Open Payables Report:
1. Order

Select the order in which the report should print. Options are vendor, alpha or vendor class.
2. Beginning order choice

Select the beginning order choice to print. Press F1 or id to default to FIRST. Press F2 or ~% to
search for vendors and vendor classes.

3. Ending order choice

Select the ending order choice to print. Press F1 or PH i default to LAST. Press F2 or “ to search
for vendors and vendor classes.

4. Branch
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Enter the branch to print. The entry must be a valid branch. The program defaults to the branch
assigned to the terminal. Press F1 or <D to default to ALL. Press F2 or % to search.

5. Document groups

Enter up to 10 two-character document groups side by side to print. Press F1 or & to default to
ALL. Note that you may also select "Documents that have no document group" for this option.
Document groups are established in Vendor F/M on the Miscellaneous tab.

6. Balance
Enter whether the report should include All documents, Open documents, or Zero balance
documents. The program defaults to ALL.

7. Next period
Indicate whether documents and transactions posted to the next AP period should be included.
The program defaults to selected.

8. Status
Enter whether to print Active, Inactive, or press Enter (CR) for all vendors. The program defaults
to ALL.

9. Scope

Enter whether the report is to print Summary, Detail, or detail with Transactions information. The
program defaults to S.
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Aged Payables Report (APR730)

Function

This program allows the user to obtain a printout of open payables grouped
into aging columns. It may also be used to print only past due amounts.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select beginning and ending order choice.

e Select the branch(es) to print.

e Select the document group(s) to print.

e Enter the aging date.

e  Select up to 999 days past due to print.

e Print next period’s information.

e Print vendor phone numbers and contacts.

e Print year-to-date and prior year figures.

e Print in summary or detail format.

The headings of the aging columns are determined by the company AP static
control record.

Report information includes the following;:

e Summary: Vendor number, name, date of last payment, balance,
current amount and the total amount in each aging column.

e Detail: Vendor number, name and date of last payment. Then
information regarding each open document for the vendor is printed
including document number, entry date, due date and the invoice
amount. Phone numbers, contacts and historical data may be included
on either the summary or detail formats.

Report totals are included for each time period and total vendors listed. The
total number of vendors listed is also included.
FACTS Report Formatter and Multiple Output Options

This report has access to the FACTS Report Formatter and Multiple Output
options. The Multiple Output option allows you to print to more than one
output for each instance of a report. For example, a report can print to Excel,
the viewer, and to a printer all in one print run. To access the multiple output
feature simply choose the Multiple option from the Print Options screen. The
FACTS Report Formatter allows users to expand reporting capabilities beyond
defining a printer (in Printer F/M). To access the FACTS Report Formatter,
select Custom Report Layout-> Customize Report from the menu bar.

User Fields

The following fields are involved in printing the Aged Payables Report:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.
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2. Beginning order choice

Enter the beginning order choice to print. Press F1 or B4 i default to FIRST. Press F2 or “ to
search for vendors and vendor classes.

3. Ending order choice

Enter the ending order choice to print. Press F1 or i to default to LAST. Press F2 or —* to search
for vendors and vendor classes.

4. Branch

Enter branch number to print. The entry must be a valid branch. The program defaults to the
branch assigned to the terminal. Press F1 or <D to default to ALL. Press F2 or % to search.
5. Document groups

Enter up to 10 two-character document groups side by side to print. Press F1 or & to default to
ALL. Note that you may also select "Documents that have no document group" for this option.
Document groups are established in Vendor F/M on the Miscellaneous tab.

6. Aging date

Enter the aging date to be used in determining which column an invoice belongs to. Press id to
default to the system date.

7. Days past due

Enter the number of days past due an invoice must be to appear on this report (0 - 999). Select @
for no cutoff (NONE), in which case all documents, including current invoices, will print.

8. Next period
Indicate whether documents and transactions posted to the next AP period should be included.
The program defaults to selected.

9. Contact information
Indicate whether to print the vendor’s phone number and contact. This information may be useful
in making calls about invoices or payments. The program defaults to unselected.

10. Purchase information
Indicate whether to print year-to-date and prior year invoice totals for each vendor. The program
defaults to unselected.

11. Scope

Enter whether the report is to print Summary or Detail information. The program defaults to S.
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Inactive Vendor Listing (APR740)

Function

This program allows the user to obtain a list of vendors with no activity since a
specified date or who have had activity less than a specified dollar amount.
This program may be used to list vendors who may need to be removed from
the vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select the beginning and ending order choice.

e Select the document group(s) to print.

e Base activity on last payment date or dollar volume.

o Select either a cutoff date or cutoff dollar amount.

e Print year-to-date and prior year purchase history.

Report information includes the following: vendor number and name, vendor
class, document group, last purchase date, last payment date, date opened, date
and amount of highest balance and current vendor balance. This information
may also include year-to-date and prior year purchase history. The total
number of vendors listed is also included.

User Fields

The following fields are involved in printing the Inactive Vendor Listing;:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.

2. Beginning order choice

Enter the beginning order choice to print. Press F1 or B4 i default to FIRST. Press F2 or “ to
search for vendors and vendor classes.

3. Ending order choice

Enter the ending order choice to print. Press F1 or i to default to LAST. Press F2 or —* to search
for vendors and vendor classes.

4. Document groups

Enter up to 10 2-character document groups side by side to print. Press F1 or " to default to ALL.
Document groups are established in Vendor F/M on the Miscellaneous tab.

5. Cutoff basis
Enter whether to base inactivity on last payment Date or dollar Volume. The program defaults to
Date.

6. Cutoff
If cutoff is to be based on last payment date (if D was entered in the Cutoff basis field), enter the
date. Vendors with last payment dates after the chosen date will be excluded from this report.
Press Enter (CR) or 1] to default to the system date. If cutoff date is to be based on volume (if V
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was entered in the Cutoff basis field), enter the year-to-date purchase volume (+/-9999999.99). The

program defaults to the system date.
7. Purchase history

Indicate whether or not to print year-to-date and prior year purchase history. The program defaults
to unselected.
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Vendor Listing (APR750)

Function

This program allows the user to print out vendor information.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

e Select the beginning and ending order choice.

e Select the code range to print - terms code, GL posting table, document
group or no code range.

e Select the beginning and ending code range to print.

e Print either general or historical information.

e Include address, phone and/or contact information.

e Select whether to print active, inactive or all vendors.

e  Skip up to nine lines between vendors.

Report information includes the following: vendor number, name, alphabetical
sort key, vendor class, terms codes, document group and GL posting table.
Also indicated is whether the vendor is on hold, if it is a permanent or
temporary vendor, customer number and tax exempt number. Historical
information includes: vendor number, name, balance, date of last invoice, date
of last payment, date account opened, date of highest balance, highest balance
amount and whether the vendor is on hold.

The vendor address, phone number, and/or contact may also print on either
report. The total number of vendors listed is also included.

FACTS Report Formatter and Multiple Output Options

This report has access to the FACTS Report Formatter and Multiple Output
options. The Multiple Output option allows you to print to more than one
output for each instance of a report. For example, a report can print to Excel,
the viewer, and to a printer all in one print run. To access the multiple output
feature simply choose the Multiple option from the Print Options screen. The
FACTS Report Formatter allows users to expand reporting capabilities beyond
defining a printer (in Printer F/M). To access the FACTS Report Formatter,
select Custom Report Layout-> Customize Report from the menu bar.

User Fields

The following fields are involved in printing the Vendor Listing:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.

2. Beginning order choice

Select the beginning order choice to print. Press F1 or id to default to FIRST. Press F2 or ~% to
search for vendors and vendor classes.
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3. Ending order choice

Select the ending order choice to print. Press F1 or PH i default to LAST. Press F2 or “ to search
for vendors and vendor classes.

4. Code range
The list may be printed for a specific range of terms codes, GL posting tables or document groups.
Only vendors with the chosen codes will print. Enter Terms code, GL posting table, or Document

group to determine which codes will print. If no code range is desired, press Enter (CR) to skip this
and the Beginning/Ending code range fields.

5. Beginning code range

If a code was chosen in the Code range field, enter the beginning code range to print. For example,
if terms code was chosen above, enter the beginning terms code to print. Press F1 or id to default
to FIRST. Press F2 or —= to search.

6. Ending code range

If a code was chosen in the Code range field, enter the ending code range to print. For example, if
terms code was chosen above, enter the ending terms code to print. Press F1 or Di to default to
LAST. Press F2 or —= to search.

7. Info (general or history)

Enter General or Historical to indicate the type of information to print. The program defaults to G.

8. Include (information to include)

Enter any combination of A-vendor address, P-phone number and/or C-contact to print on the
report. Press F1 or @ to default to NONE. Press F3 or " to default to ALL.
9. Status

Enter whether to print Active, Inactive, or press Enter (CR) for all vendors. The program defaults
to ALL.
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Vendor Ledgercards (APR755)

Function

This program allows the user to obtain a printout of ledgercards and related
information stored in the ledgercard file. Vendor Ledgercards provide a
detailed history of every transaction for each vendor. The Ledgercard File is
optional. History is stored if the Use Ledgercards flag is set to Y in the Vendor
File.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
e Select the beginning and ending order choice.

o Select the date range to print.

e Select the transaction type to print.

Report information includes the following: vendor number and name,
transaction date and type, debit and credit amount, document number and
register number. This report also includes ending balance and total number of
vendors listed.

User Fields

The following fields are involved in printing the Vendor Ledgercards:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.

2. Beginning order choice

Select the beginning order choice to print. Press F1 or B4 i default to FIRST. Press F2 or “ to
search.

3. Ending order choice

Select the ending order choice to print. Press F1 or i to default to LAST. Press F2 or — to search.
4. Date Order

Enter date order in which to print: Newest date to oldest date or Oldest date to newest date. The
program defaults to newest to oldest.

5. Beginning date

Enter the beginning date to print. Press F1 or id to default to FIRST.
6. Ending date

Enter the ending date to print. Press F1 or i to default to LAST.
7. Type

Press to select transaction types. Enter whether to print Beginning balance, document Entry,
Check register and/or Vendor balance transaction types. Press Enter (CR) or " to default to ALL.
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Vendor Label Print (APP710)

Function

This program allows you to print labels from the information stored in the
vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

o Select the beginning and ending order choice.

e  Print the labels in zip code order.

e Select whether to print vendor number, contact #1, or contact #2.
e  Select the number of labels to print for each vendor.

e Print an alignment check.

Label information includes the following: vendor name, address, city, state, zip
code and either contacts #1 or #2, or the vendor number. The program prints
on 11-1/2 x 15 inch paper and prints (4) labels across (see forms information in
the installation manual).

To print an alignment (or test page) in graphical mode, select Print Options
>Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Fields

The following fields are involved in printing the vendor labels:
1. Order

Select the order in which to print labels. Options are vendor, alpha or vendor class.
2. Beginning order choice

Select the beginning order choice to print. Press F1 or id to default to FIRST. Press F2 or % to
search for vendors and vendor classes.

3. Ending order choice

Select the ending order choice to print. Press F1 or i to default to LAST. Press F2 or ~* to search
for vendors and vendor classes.

4. Zip Code sort

Indicate whether to sort the vendors by zip code. The program defaults to unselected.
5. Vendor #/Contact

Enter whether to print on all labels contact #1, contact #2 or #-vendor number. The program
defaults to NONE.

6. Number of labels

Enter the number of labels to print per vendor (1-99). The program defaults to 1.
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Rolodex Vendor Card Print (APP720)

Function

This program allows the user to print vendor rolodex cards from the
information stored in the vendor file.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.
o Select the beginning and ending order choice.

e Select to print alpha (if print order other than alpha).

e Select number of cards to print for each vendor.

e Select to print active, inactive or all vendors.

e Print an alignment check.

Rolodex card information includes the following: vendor number, name,
address, phone number, contact #1 and #2 and vendor class code. For
information on the size of the forms, please see the forms section in the
installation manual.

To print an alignment (or test page) in graphical mode, select Print Options
>Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Fields

The following fields are involved in printing the Rolodex vendor cards:
1. Order

Select the order in which to print Rolodex cards. Options are vendor, alpha or vendor class.

2. Beginning order choice

Enter the beginning order choice to print. Press F1 or B4 i default to FIRST. Press F2 or “ to
search for vendors and vendor classes.

3. Ending order choice

Enter the ending order choice to print. Press F1 or i to default to LAST. Press F2 or % to search
for vendors and vendor classes.

4. Alpha sort

If the order choice was vendor or vendor class order, indicate whether to sort vendors
alphabetically within the print order. If you select Alpha order, the program skips this output. The
program defaults to unselected.

5. # of cards

Enter the number of cards to print for each customer (1 to 99). The program defaults to 1.
6. Status

Enter whether to print Active, Inactive, or press Enter (CR)-all vendors. The program defaults to
ALL.
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Technical Notes

Printing proceeds by reading through the chosen file - vendor (APVEND),
alpha (APVALX) or vendor class (APCLSX). The vendor file is then checked
for the information needed to print Rolodex cards. If the order choice was not
alphabetical and vendors are to be sorted alphabetically within the order
choice, then the program creates a temporary sort file (SMSRT?) which sorts the
vendors into the correct order.

FILES USED - SMCNTL, APVEND, APVALX, APCLSX
FILES UPDATED - SMSRT
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Purchase History Report (APR760)

Function

This program allows the user to obtain a Purchase History Report for all
vendors.

The user has the option to:

Select the order to print - vendor, alpha or vendor class.
Select the beginning and ending order choice.

Select the document group(s) to print.

Select the comparison and cutoff.

Report information includes the following: vendor number, vendor name, date
opened, last purchase date. The year-to-date and prior year information
include purchases, payments and discounts. Report totals are also included for
year-to-date and prior year and the total number of vendors listed.

User Fields

The following fields are involved in printing the Purchase History Report:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.

2. Beginning order choice

Select the beginning order choice to print. Press F1 or id to default to FIRST. Press F2 or ~% to
search for vendors and vendor classes.

3. Ending order choice

Select the ending order choice to print. Press F1 or PH i default to LAST. Press F2 or “ to search
for vendors and vendor classes.

4. Document groups

Enter up to 10 two-character document groups side by side to print. Press F1 or " to default to
ALL. Document groups are established in Vendor F/M on the Miscellaneous tab.

5. Cutoff
Enter whether there is No cutoff or to exclude vendors Above or Below cutoff. The program
defaults to unselected and skips to the Amount field.

6. Figures
If you entered N for the cutoff, the system skips this field. Otherwise, enter whether to use the
Month-to-date, Year-to-date or Prior year for the cutoff. Press Enter (CR) to default to M.

7. Amount
If you entered N for the Cutoff field, this program skips this field. Otherwise, enter the (MTD, YTD

or PYR as chosen in the Figures field) amount below or above (as chosen in the Cutoff field) which
vendors will not print. For example, if B was selected for cutoff and M was selected for figures,
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enter the MTD purchases below which vendors will not print; i.e., if 100 is entered, no vendors
with a MTD purchase figure of below 100 will print on the report.

% o01-FACTS 7.7 Development, Purchase History Report (APRT60) - Infor : o ] 54
Template  Print Options | Help

Beginning First
Ending Last

Froperties

Document Groups | All

CUtoff | M- Mo Cutoff =||

Figures  [m-mMTD for cutert ||

(0] 4
Template Printer =
Mone Wind Laser

Select print order
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Payment History Report (APR770)

Function

This program allows the user to obtain a Payment History Report for all
vendors.

The user has the option to:

e Select the order to print - vendor, alpha or vendor class.

o Select the beginning and ending order choice.

e Select ending period and up to five periods prior to the ending period to
print.

e Determine a cutoff.

Report information includes the following: vendor number, vendor name,
payments made for each period included on the report, report totals and total
number of vendors listed. If the selected order to print is by class, then class
totals are also included.

User Fields

The following fields are involved in printing the Payment History Report:
1. Order

Select the order in which to print the report. Options are vendor, alpha or vendor class.

2. Beginning order choice

Select the beginning order choice to print. Press F1 or B4 i default to FIRST. Press F2 or “ to
search for vendors and vendor classes.

3. Ending order choice

Select the ending order choice to print. Press F1 or i to default to LAST. Press F2 or ~* to search
for vendors and vendor classes.

4. Ending period

- a
Enter the ending period to print (PPYY). Press F1 or B to default to CURRENT. Press F2 or P o
default to LAST.

5. Number of periods

Enter the number of periods to print, including the ending period (1-6). The program defaults to 1.
6. Cutoff

Enter the total minimum payment to print for each vendor (+/- 99999999.99). Press F1 or @ to
default to NONE.
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Reports & Prints
I o1-FraACTS 7.7 Development, Payment History Repork (APR770) - Infor - |EI|£|
Template  Prink Options | Help
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Froperties
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1099 Print (APP730)

Function
This program allows the user to print non-employee compensation statements
(1099’s).
The user has the option to:

e Select the beginning and ending vendor to print.
e Select document group(s) to print.
e Enter Federal ID number.

Print information includes the following: company name, address and federal
ID number, vendor name, address, and 1099 balance. The amount comes from
the purchase history in the vendor file and the field used is 1099 balance.

The forms used are the standard 1099 forms put out by the IRS.

To print an alignment (or test page) in graphical mode, select Print Options
2Alignment from the menu bar. In character mode, enter A at the selection
prompt and press return.

User Fields

The following fields are involved in printing 1099 forms:

1. Beginning vendor

Enter the beginning vendor number to print. Press Enter (CR) to default to FIRST. Press F2 or %
to search.

2. Ending vendor

Enter the ending vendor number to print. Press Enter (CR) to default to LAST. Press F2 or — to
search.

3. Document group

If you entered document groups in the Miscellaneous tab of the Vendor F/M program, enter up to
10 two-character document groups side by side to print. Press F1 or @ o default to ALL.
4. Federal ID

Enter contractor’s Federal Tax ID number (up to 10 characters).
5. Print When Less Than $600

Indicate whether to print 1099’s for vendors with a 1099 balance of less than $600.00.
6. Use Laser Form

Indicate whether to use laser form will be used for printing 1099 Forms.
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I o01-FACTS 7.7 Development, 1099 Print (APP730) - Infor
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Vendor Balancing Register (APR780)

Function

| NOTE: This register should be run by the System Administrator. |

This program allows the user to print a register of all vendors whose balance is
not equal to the total amount of their open documents. The optional update
will reset the vendor’s balance and the company AP balance.

This program is used only in the unlikely event (error condition, power failure)
of vendors becoming out of balance. If the report is updated, the printout
should be kept for future tracing of the AP balance. If an out of balance

condition is corrected by this register, a manual General Ledger journal entry
may be required.

Report information includes the following: the vendor number, name, new
balance (the calculated sum of open documents), current balance and the
difference. The report also includes the number of vendors.

User Fields

The following fields are involved in printing the Vendor Balancing Register:
1. Print register

Select the OK button to print the register
2. Check register. OK to update?

Once the register prints, check the information to make sure it is correct. Select OK to begin the
update. Select Cancel to exit the program without updating.

£ Yendor Balancing Register [APR780]

Template  Print Options

Thiz Program Will Print a Register of All Out-Of-Balance vendors. The
Optional Update 'Will Reset Each Wendor Balance Egual to the Total of
the Open Documents for that Vendor. [EWill Also Resetthe AP Balance
Enual to the Total of All Yendor Balances.

Template Printer

Mone Genicom Line Printer Cancel
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How to run the Vendor Balancing Register

1.  Access this program by choosing Account Payable->Reports & Print->Vendor Balancing
Register.

2. Select the OK button to print the report of all vendors whose balance is not equal to the total
amount of their open documents.

3. After printing the Vendor Balancing Register, verify the printout. If you need to reset the vendor
balance equal to the total open document balance for each vendor and set the AP balance equal
to the total of all vendor balances, select OK to continue. Select Cancel to exit the program
without updating.
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AP Code List (APR790)

Function

This program allows the user to print a listing of each of the following
Accounts Payable codes:

e Vendor class
e Terms code
e GL posting table

Each code above is entered into its own F/M program and is used in the
vendor file.

Report information includes each code and the information stored with the
code. The total number of codes listed is also included.

User Fields

The following fields are involved in printing the AP Code List:
1. Select number

Enter whether to print 1-vendor class, 2-terms code or 3-GL posting table information. The
program defaults to vendor class.

2. Beginning order choice

Select the beginning order choice to print of the field selected. Press F1 or B4 to default to FIRST.
Press F2 or — to search.

3. Ending order choice

Select the ending order choice to print of the field selected. Press F1 or P to default to LAST. Press

F2 or % to search.

T 01-FACTS 7.7 Development, AP Code List {APR790) - Infor . o ]

Templake Prink Options  Help

Selection

Beginning First
Ending Last

Template Printer
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MNane Wind Laser

Print in vendor class, terms code, or GL Posting Tahle?
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Check Payment History Report (APR775)

Use the Check History report to print information from the check history file.
The report can be printed for one or all vendors and in check date or check
number order.

Access this program by choosing Accounts Payable->Reports—>
Prints->Payment History Report.

Use the following fields to print the Payment History Report:

1. Vendor

Enter the vendor for the report. Press F2 or —% to search. Press <& to default to
ALL.

2. Order

Select the order in which to print the report. Options are C-Check Number or
D-Check Date.

3. Beginning order choice

Select the beginning order choice to print. Press F1 or id to default to FIRST.

4. Ending order choice

Select the ending order choice to print. Press F1 or i to default to LAST.

5. Bank

Enter the bank for the report. Press F1 or & to default to CURRENT. Press F2
or % to default to LAST.

@ 01-FACTS 7.7 Development, Check Payment History Report (APR775) - Infor 15X
Template  Print Options  Cuskom Report Layout  Help

Yendor All
Order  |C- Check number

Beginning First
Ending Last
Bank | | Al

QK
Template Printer Layout
Maone Windx Lasear Standard

Enter vendor to print, F1-All, F2-Search
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CHAPTER 8

End of Period

The End-of-Period Menu contains programs that should be run at the end of
each accounts payable period to close it correctly.

The Period Check Register provides a listing grouped by each bank of all
regular, manual, noninvoice and void checks issued this period. The Period
Expense Distribution provides a list of all GL expense distributions from the
Document Entry & Adjustments Register for the period. The Period
Disbursement Distribution provides a list of all GL Disbursement Distributions
from the Check Register for the period. All of the registers listed contain
optional updates that should be run to clear the files to start a new period. The
Register History Report provides a list of all register updates which affected the
AP balance during the period. The Document Removal Register provides a
report of all documents paid to zero during the period and removes them from
the open documents file. The Vendor Ledgercard Removal program removes
ledgercard information by vendor number, alphabetically, or by vendor class.

The End-of-Period Update will close the current Accounts Payable period by
deleting temporary vendors with zero balances, rolling period-to-date figures
to zero and incrementing the current period by one. If it is the end of the year,
year-to-date figures are rolled to prior year.
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Period Check Register (APR810)

Function

This program allows the user to obtain a listing, grouped by banks, of all
regular, manual, noninvoice and void checks for a period. Records on this
report are created during the update portion of the Check Register program if
the Use period check register flag in the company AP static control record is
setto Y.

The register should be printed at the end of the period as part of the monthly-
closing procedures. To prevent file overflow, the records should be removed
once a month after the register is run.

Report information includes the following: bank number and name, check
number, vendor number and name, check date, register number, discount
amount, check amount and type. (Types include void, noninvoice and blank
indicates a regular printed check.) Also included are totals for each bank, a
report total and the total number of checks listed for each bank.

User Fields

The following fields are involved in printing the Period Check Register:
1. Period

Enter the period to print (PPYY). Press F1 or 1] to default to the current AP period.
2. Beginning bank

Enter the number of the beginning bank to print. Press F1 or B4 i default to FIRST. Press F2 or “
to search.

3. Ending bank

Enter the number of the ending bank to print. Press F1 or i to default to LAST. Press F2 or % to
search.

4. Check register. Do you wish to remove records just printed?

Select OK to remove the records and update the system. Select Cancel to skip the update.
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T o1-racTs 7.7 Development, Period Check Register (APRE10) - Infor
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How to run the Period Check Register

1. Access this program by choosing Account Payable-=> End of Period ?Period Check
Register.

2. In the Period field, enter the period for this check register print. Press F1 to

default to the current AP period. Select the id to display the previous period. The
current period displays in the upper left corner of the screen.

3. In the Beginning Bank field, enter the number of the beginning bank to print.
Press F1 or id to default to FIRST. Select the % to press F2 search for banks.
Select the id to display the previous banks.

4. Inthe Ending Bank field, enter the number of the ending bank for the print
range. Press F1 or B4 i default to FIRST. Select the “ to press F2 search for
banks. Select the 1] to display the previous banks.

5. Select the OK button to start the check register or the Cancel button to stop this
process.

6. When the system displays the message: Check register. Do you wish to remove
records just printed?, select OK to remove the records and update the system.
Select Cancel to skip the update.
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Period Expense Distribution (APR820)

Function

This program allows the user to obtain a list of all expense distributions from
the Document Entry & Adjustments Register for the period. Records on this
report are created during the update portion of the Document Entry &
Adjustments register if the Use period expense report flag in the company AP
static control record is set to Y.

The Period Expense Distribution should be printed as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Report information includes the following:

e Summary: The GL number, description, debit amount and credit
amount. Report totals are included along with the total number of
accounts listed.

e Detail: Summary plus vendor number and name, document number
and register number.

User Fields

The following fields are involved in printing the Period Expense Distribution:

1. Period

Enter the period to print (PPYY). Press F1 or id to default to the current AP period.
2. Beginning G/L #

Enter the beginning general ledger number to print. Press F1 or id to default to FIRST. Press F2

or —u to search.
3. Ending G/L #

Enter the ending general ledger number to print. Press F1 or i to default to LAST. Press F2 or

s to search.
4. Branch

Enter the branch to print. The entry must be a valid branch. Press F1 or " to default to ALL. Press
F2 or % to search.

5. Department

Enter the GL department to print. The entry must be a valid GL department. Press F1 or <D to
default to ALL. Press F2 or —% to search.
6. Scope

Enter whether to print Summary or Detail information. The program defaults to Summary.

7. Check report. OK to remove records just printed?
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Select OK to remove the records and update the system. Select Cancel to skip the update.

I o1-FACTS 7.7 Development, Expense Distribution (APR820) - Infor ; - |EI|5|
Template Print Options  Help

CP=09/2004 5EP

Period :l Current Period
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Template Printer =
Mone Windx Laser Cancel

Enter period to arint, F1-Current Period
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Period Disbursement Distribution (APR830)

Function

This program allows the user to obtain a list of all General Ledger
Disbursement Distribution from Check Registers for the period. Records on
this register are created during the update portion of the Check Register if the
Use period disbursement report flag in the company AP static control record is
setto Y.

It is suggested this report be printed as part of the end-of-period procedures.
To prevent file overflow, the records should be removed once a month after the
register is run.

Report information includes the following:

e Summary: The GL number, description, debit amount and credit
amount. Report totals are included along with the total number of
accounts listed.

e Detail: Summary plus vendor number and name, check number and
register number.

User Fields
The following fields are involved in printing the Period Disbursement
Distribution:
1. Period

Enter the period to print (PPYY). Press F1 or id to default to the current AP period.
2. Beginning G/L #

Enter the beginning general ledger number to print. Press F1 or id to default to FIRST. Press F2

or —u to search.
3. Ending G/L #

Enter the ending general ledger number to print. Press F1 or i to default to LAST. Press F2 or

s to search.
4. Branch

Enter the branch to print. The entry must be a valid branch. Press F1 or & o default to ALL. Press
F2 or % to search.

5. Department

Enter the GL department to print. The entry must be a valid GL department. Press F1 or <D to
default to ALL. Press F2 or —% to search.
6. Scope

Enter whether to print Summary or Detail information. The program defaults to Summary.

7. Check report. OK to remove records just printed?
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Select OK to remove the records and update the system. Select Cancel to skip the update.

T 01-FACTS 7.7 Development, Disbursement Distribution (APRE830) - Infor B [ 4

Template Print Options  Help
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Register History Report (APR840)

Function

This program allows the user to print a report of all registers affecting the
Accounts Payable balance. This provides a trace of what transpired to obtain
the current AP balance. The optional update will remove the printed records
preceding the first trace number for the next period without affecting any
balances.

Registers that appear on this report include the Document Entry & Adjustments
Register, the Check Register and the Vendor Balancing Register.

It is suggested that the report be printed as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Report information includes the following: AP trace number, register date,
period, register number, register type, beginning AP balance, dollar amount,
discount amount, adjustment amount and ending AP balance. The recap lists
for each period the total dollar amount, discounts, adjustments and change in
AP balance. The total number of traces (registers) listed is also included.

User Fields

The following fields are involved in printing the Register History Report:
1. Print report

Choose OK in the main report window. Choose OK at the End of Register
message.

2.  Check report. OK to remove records preceding first trace# for next period?

Select OK to remove the records and update the system. Select Cancel to skip
the update.
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I o1-FACTS 7.7 Development, Register History Report (APR840) - Infor o - |EI|5|
Template Print Options | Help
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Template Printer
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Document Removal Register (APR850)

Function

This program allows the user to print a report of all documents paid down to
zero and optionally remove those records from the open documents file. The
update also maintains the paid document history file.

As the system removes invoices from the open documents file, the invoice
status in the AP check history detail file is also updated.

It is suggested the report be printed and updated as part of the end-of-period
procedures. To prevent file overflow, the records should be removed once a
month after the register is run.

Records removed by this program will no longer appear on the Open Payables
or Aged Payables Reports. The information regarding paid off documents is
available for screen display in the Vendor Inquiry program.

Report information includes the following for each vendor: the vendor number
and name, document number, entry period and date, amount, document
register date and number, payment amount, discount taken and current
document balance (0). An asterisk indicates that the total of the transactions for
that document does not equal the document amount. The total number of
documents listed with a balance of zero is also included.

User Fields

The following fields are involved in printing a Document Removal Register:
1. Enter the Branch code or codes.
The code must be on file in Branch F/M. The program defaults to the branch assigned to the

terminal. Press F1 or ‘a to default to ALL. Press F2 or —% to search.
2. Print the register.

Choose OK in the main report window. Choose OK at the End of Register message.
3. Check the register output and indicate whether or not you want to remove the documents on the
output.

At the "Check Register. Remove these Records?" message, choose OK to remove the documents
that appear on the register output. Choose Cancel to abort the update and leave the documents in
the system. At the "Update Not Run" message, choose OK.
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How to run the Document Removal Register

1.

8-14

Access this program by choosing Account Payable-> End of Period >Document
Removal Register.

In the Branch field, enter the branch for the document removal. Press Enter (CR)
defaults to the branch assigned to the terminal. Select the <D icon to process all
branches for the register. Select the —% to search for branches.

Select the OK button to print the register.

After printing the Document Removal Register, verify the printout. If you need to
correct the register data, select Cancel to exit the program. After you make
corrections, you can rerun the Document Removal Register. If everything is
correct, select OK to continue.

The program displays the message Check Register. Remove these Records?"
Choose OK or press Enter to remove the documents that appear on the register
printout. Choose Cancel or press F4 to abort the update and leave the documents
in the system. At the "Update Not Run" message, choose OK.

Accounts Payable—7.7
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Vendor Ledgercard Removal (APU810)

Function

This program allows the user to remove vendor ledgercards from the system. It
is suggested to print the Vendor Ledgercards before running this program. The
program can be run by vendor number, alpha, or vendor class based on the
transaction cutoff date. It is suggested to run this update as a part of the end-
of-period procedures.

User Fields

The following fields are involved in running the Vendor Ledgercard Removal:
1. Order

Select the order the ledgercards are to be removed.

2. Beginning order choice

Select the beginning order choice.

3. Ending order choice

Select the ending order choice.
4. Cutoff date

Enter the last transaction cutoff date. Records will be removed through this date. Press Enter (CR)
to default to the ending date of the last general ledger period closed.

5. Keep

Enter the minimum number of ledger cards to keep on file per vendor regardless of the entered
cutoff date (1-99). Press Enter (CR) to default to NO MINIMUM.
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{i_ ¥endor Ledgercard Removal (APUS10)
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How to remove vendor ledgercards

FACTS AP

Access this program by choosing Account Payable->End of Period >Vendor Ledgercard Removal.

In the Order field, select the order to use when removing the ledgercards. You can select V for
vendor code, A for Alpha, or C for vendor class order. Press F4 to exit the program.

In the Beginning field, enter the number of the beginning order choice to remove.
In the Ending field, enter the number of the ending order choice for the removal range.

In the Cutoff Date field, enter the last transaction cutoff date. Records will be removed through
this date. Press Enter (CR) to default to the ending date of the last general ledger period closed.

In the Keep field, enter the minimum number of ledger cards to keep on file per vendor
regardless of the entered cutoff date (1-99). Press Enter (CR) to default to NO MINIMUM.

When the system displays the message: End of Fields. Enter Yes to Continue, F4 to backup,
enter Yes to remove the records and update the system, press F4 to backup and change the field
values, or press F4 twice to exit the program.

If you enter Yes, the system displays the criteria you entered in the upper portion of the screen
and processing information in the lower portion of the screen. When the program is complete
the system displays a message telling you how many records were removed and then exits the
program.
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End-Of-Period Update (APU890)

Function

This program allows the user to close the current accounts payable period. The
End-of-Period Update should be run at the end of each Accounts Payable
period.

This update allows the user to:

e Close out the current period in accounts payable.

e Remove all temporary vendors with a zero balance.

¢ Remove documents from the past history file if the balance is zero and
the document is older that the number of periods set in the static control
records for storing past documents.

o (lear the month-to-date vendor information.

o If this is the end of the year, it will roll year-to-date information to prior
year.

As invoices are being removed based on the number of months to store paid documents from the AP
Static Control file, FACTS updates their status in the AP check history detail file. Check history
records are removed based on the number of months to be stored in the AP Static Control file.

Prior to running this update, the user should make sure that the final PO
Invoice Receipt Register, Document Entry & Adjustments Register, and Check
Register have been run. The Period Check Register, Period Expense
Distribution, Disbursement Distribution, Register History Report and
Document Removal Register should also be run. At end of year, the 1099 Print
should be run.

User Fields

The following fields are involved in running the End-of-Period Update:
1. Close-Out Period

Indicate whether or not to close the current accounts payable period. Pressing
Enter (CR) defaults to selected.

2. Have the above end-of-period programs been run?

Indicate if the above reports have been run. This input is just a last check to
make sure the user has run all the necessary reports before closing the period.
Pressing Enter (CR) defaults to unselected and the program is terminated.

If the last AP period was closed less than 20 days before the system date, a
message is displayed indicating the number of days since the last close. If the
last AP period was closed more than 20 days before the system date, input #3 is
skipped.

3. Are you sure you want to close out this period?

Indicate whether to close the period. Pressing Enter (CR) defaults to unselected
and the program is terminated.
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End Of Period

How to run the End-of-Period Update

1.

8-20

Access this program by choosing Accounts Payable-->End of Period-->End
of Period Update.

In the Close-out period input, indicate whether or not to close the current
Accounts Payable period. The program defaults to selected.

At the Have the above End-of-Period programs been run? prompt, enter
indicate if the above reports have been run. This input is just a last check to
make sure the user has run all the necessary reports before closing the
period. The program defaults to unselected and the program is terminated
unless you select the checkbox.

If the last AP period was closed less than 20 days before the system date, a
message is displayed indicating the number of days since the last close. If
the last AP period was closed more than 20 days before the system date,
the following input is skipped.

At the Are you sure you want to close out this period? prompt, indicate if
you want to remove the records and update the system. Do not select the
checkbox to skip the update.

If you select the checkbox, the system displays the criteria you entered in
the upper portion of the screen and processing information in the lower
portion of the screen. When the program is complete the system displays a
message telling you how many records were updated and then exits the
program.

Accounts Payable—7.7
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CHAPTER 9

File Maintenances

File maintenance programs allow users to enter, change and delete data. These
programs are used to enter the initial data required to set up the system (refer
to the Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
explained in the next chapter.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the Accounts Payable system do not need to be maintained by
the user and it is unlikely that they will be used.

T Infor ERP FACTS - FACTS 7.7 Pre-release Demo - Master Menu =3
inTom ERPFACTS Infor Global Solutions (IN4/T2) [ &
1111942009 - 12:42 pm ci77alpha 2 7 i sefings (@ Hep T

Wendar Fib

B r4 ud] “endar EFT Entry
Payment Histary F
TransferiChange YWendar Codes

Document Entry Fayment & Hold Checks Inquiries Infrequent File Maintenances...
Selection

5 BB

Reparts & Prints End of Periad File Maintenances

powared by 14 Fame
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Vendor F/M (APF910)

Function

This program allows the user to create and maintain records in the vendor file.
Each record contains a vendor number and general information relevant to the
vendor. This file is referenced by most programs in the AP system as well as by
the inventory system.

Vendor numbers may be automatically assigned by the system. You cannot
delete vendors with open documents or open purchase orders.

You can also create Faxlink records based on information stored in Vendor
records. The program will ask you to do this when you save the document for
the first time.

When you save new vendor records, the system allows you to create a Faxlink record and
warehouse/vendor review cycle record directly from this program.

To create a faxlink record, select OK when the system asks if you want to create a faxlink records.
Select OK, and the system displays the Quick Fax Record Entry screen. Complete the information on
the screen and press Enter to add the record.

After you have created the Faxlink record or selected Cancel on the Faxlink message, the system asks
if you want to create a warehouse/vendor review cycle record for the new vendor.

To create warehouse/vendor review cycle record, select OK when the system asks if you want to
create a warehouse/vendor review cycle record. The system automatically displays the
Warehouse/Review Cycle F/M program with the new vendor information. The first warehouse on
file displays as the default. You can complete the warehouse/vendor review cycle record information
and save the record to return to the Vendor F/M (APF910) program, or you can change other vendors'
records and/ or create new warehouse/vendor review cycle records for other vendors.

User Fields

*

The following fields are involved in creating vendor file records:

Vendor number

Enter the vendor number (up to 10 characters). Select the E! or press F1 to assign the next available
vendor number from the AP Nonstatic Control F/M. The word NEXT appears until you enter all of

fields and the actual number is displayed before the record is added to the file. Select the ~% icon

or Press F2 or —* to search existing vendor records.

Vendor F/M Main Screen

2.

3.

4.

9-2

Vendor name

Enter the vendor’s name (up to 30 characters).
Address 1

Enter line 1 of the vendor’s address (up to 30 characters). If only one line is needed, use the first.
Address 2

FACTS AP
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Enter line 2 of the vendor’s address (up to 30 characters).
5. City

Enter the city name (up to 15 characters).
6. State

Enter the state name using the two-character designation provided by the post office.

7. Zip code

Enter the zip code (up to 10 characters).
8. Address 3

Enter line 3 of the vendor’s address (up to 30 characters). Press Enter (CR) or & to default to the

city, state and zip entered in the previous fields. Address 3 may be used for international
addresses. Address 3 will be used for all printouts instead of city, state and zip.

9. Alpha (alphabetic sort key)

Enter the alphabetic sort key to be used to sort vendors alphabetically for printouts, displays and
alpha searches (up to 10 characters). In most cases, the first ten characters of the vendor’s name are
sufficient to achieve alphabetical lookup. Press Enter (CR) to default to the first ten characters of
the vendor’s name as entered in the Vendor Description field.

10. Contact #1

Enter the name of the person you work with at the vendor’s office (up to 25 characters). If only one
contact is needed, use the first.

11. Phone #1

Enter the vendor’s phone number including area code, dashes and extension, if needed (up to 17
characters). If only one phone number is needed, use the first.

12. Email

Enter the email address for the person entered as contact #1 above.
13. Contact #2

Enter the name of another person you work with at the vendor’s office (up to 25 characters).
14. Phone #2

Enter the vendor’s second phone number including area code, dashes and extension, if needed (up
to 17 characters).

15. Email

Enter the email address for the person entered as contact #1 above.
16. Web Site

Enter the company’s Internet address on the World Wide Web. You can select <D to access the
company’s Internet on the World Wide Web.

Vendor F/M Purchase History screen
To access the purchase history screen, click the Purchase History Tab.
The following fields should be used as a file maintenance only once to enter original
information. Thereafter, this information is updated by the system and any changes
you make could compromise data. Entering initial information into these fields is
optional.
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The update portions of the Document Entry & Adjustments Register and the Check
Register programs update purchase history information.

2. Date Opened

Enter the date the account was opened with this vendor. Press Enter (CR) to default to the date this
vendor was entered into the vendor file.

3. Date Last Invoice

Enter the date of the most recent invoice from this vendor.
4. Date Last Payment

Enter the date of the most recent payment made to this vendor.
5. Date Highest Balance

Enter the date the highest amount of money was owed to this vendor.

* Current Balance

7. Highest Balance
Enter the amount of the highest balance for this vendor (+/-99999999.99). Press Enter (CR) to
initially default to 0.

8.1099 Balance
Enter the amount of the 1099 balance for this vendor (+/- 99999999.99). Press Enter (CR) to initially
default to 0.

9. Month-To-Date Invoices, Payments, Disc. Taken, Disc. Allowable
Enter the total amount of month-to-date invoices (+/- 99999999.99). Press Enter (CR) to initially
default to 0.

10. Year-To-Date Invoices, Payments, Disc. Taken, Disc. Allowable
Enter the total amount of year-to-date invoices (+/- 99999999.99). Press Enter (CR) to initially
default to 0.

12. Prior Year Invoices, Payments, Disc. Taken, Disc. Allowable

Enter the total amount of prior year invoices (+/- 99999999.99). Press Enter (CR) to initially default
to 0.

Vendor F/M Financials screen
2. Check Name

Enter the payee’s name that should print on the AP checks (up to 30 characters). Press Enter (CR)
to default to the vendor’s name.

3. Address 1
Enter the first address line to print on the AP checks (i.e., remit-to address) (up to 30 characters).
Press Enter (CR) to default to address 1 of the vendor.

4. Address 2
Enter the second address line to print on the AP checks (i.e., remit-to address) (up to 30 characters).
Press Enter (CR) to default to address 2 of the vendor.

5. Address 3
Enter the city, state and zip to print on the AP checks (i.e., remit-to address) (up to 30 characters).
Press Enter (CR) to default to address 3 of the vendor.

6. Tax Exempt #
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Enter your company’s tax-exempt number applicable for this vendor (up to 10 characters). Tax-
exempt numbers may vary by state. This number prints on any purchase order for this vendor so
that you are not charged tax.

7.1099 ID

Enter the vendor’s 1099 ID number (up to 12 characters). This is used to print on the 1099 forms for
sales more than $400. This number is most often used for contract labor situations.

8. Terms Code

Enter the terms code for this vendor (up to 2 characters). The entry must be a valid terms code.
Press F2 or — to search.

Vendor F/M Miscellaneous screen
2. Our Customer #

Enter your customer number from this vendor (up to 10 characters). It should be the number this
vendor has assigned to you for their records.

3. Vendor Class

Enter the vendor class (up to 3 characters). The entry must be a valid vendor class. Press F2 or
to search.

4. GL Table

Enter the GL posting table to which this vendor belongs (up to 3 characters). The entry must be a
valid AP general ledger posting table. Press F2 or — to search.
5. Doc Group (document group)

Enter the normal document group for this vendor (up to 2 characters). Document groups are
optional and this field may be skipped.

6. Ship-From

Enter the normal (default) ship-from number for purchase orders for this vendor (up to 5
characters). Press Enter (CR) to default to SAME meaning this ship-from name and address is the
same as the vendor’s name and address. If the number is not SAME, the screen will display the
number. After the vendor record is entered, the ship-from number and address should be entered
in the Ship-From F/M program in purchase orders.

7. Default Freight

Enter the default freight code for this vendor. This freight code is used as the default for
warehouse-ship purchase orders created in PO Entry and PO Receipt Entry programs. You can
select from: B-Bill Later, C-Collect, P-Prepaid, A-Prepay/Add.

8. Perm/Temp (Permanent/Temporary)

Enter whether the vendor is Permanent or Temporary. Temporary vendors who have a zero
balance are removed during the End-of-Period Update. The temporary vendor numbers may be
reused. Press Enter (CR) to initially default to P.

9. Temporary Item Lead Time
Enter the default lead time for temporary items. This field represents the default lead time for this
vendor for temporary items for use in determining when to release a request on a blanket sales

order. This value can be overridden during blanket sales order entry. Press Enter (CR) to initially
default to 0.
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10. Message

Enter a message if desired (up to 30 characters). This message only appears on the screen during
document entry programs.

11. Active

Indicate whether the vendor is active. If N is entered, no processing is allowed for this vendor (i.e.,
no checks may be processed and no documents may be entered). Press Enter (CR) to initially
default to selected.

12. On Hold

Indicate whether to place the vendor on hold. If selected, no checks may be written to this vendor.
Press Enter (CR) to initially default to unselected.

13. Use Ledgercards

Indicate whether to store ledgercards for this vendor. Press Enter (CR) to initially default to the
vale set for the Use Vendor Ledger Card checkbox on the General screen of AP Static Control F/M.

14. Store Past POs

Indicate whether to store past purchase orders for this vendor. Press Enter (CR) to initially default
to selected (yes).

Vendor F/M Costing Screen
2. Default Cost Class Prompt

Enter the default cost class. Press F1 for @ for no cutoff date. Press F2 or % to search, or F4 to
backup. If your company does not use costs classes for cost contracts, enter None in this field.

3. Cost Hierarchy Prompt

v

Press to enter the cost hierarchy types. You can select from: S=Standard PO cost, I=Contracts
for specific items, C=Contracts for items in a cost class, or A=Contracts for all items. Press Enter
(CR) to default to I+C+A+S. Press F1 for None or F4 to backup.

4. Use Lowest Cost

Select the Use Lowest Cost checkbox to indicate you want to ignore the cost hierarchy and use the
lowest cost the system can find.

Vendor F/M User-Defined Screen

Many users have a few pieces of information about customers, vendors, and items that are unique
to their business that they would like to enter into FACTS for reference purposes. The User-
Defined screen displays user-defined fields in the major file maintenances and makes them
available in FACTS Inquiry programs for information only. There are 5 user-defined fields
available to any user that has access to Vendor F/M. You will be able to configure these fields
within the following constraints: If the user has administrator privileges for User-defined Fields
setting on the Security tab of User Code F/M (SMF410): Each field can be designated by a type--
text, numeric, validated list, and date, as well as a label that can be edited in the F/M to create
custom labels for each field. This allows the user to have a meaningful label other than "User
Defined 1" and so on.
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T 01-FACTS 7.7 Development, Yendor F/M (APF310) - Infor - |I:I|5|

Motes Help

Yendor General Industrial MFG |I|::|D|I|

Main | Purchase History Financials Miscellaneous Costing User-Defined

Marme |General Industrisl MFG |

Address 1 | 9610 Durseoody, P

Address 2 [Suite 133134

City | Atlarta | State  [za Fip Code

Address 3 |Atlarts, G2 30338 |

Alpha  |GENERAL IN

Contact Information

Contact1  |Roger Smith | Phone |404-333-9444
E-mail
Cantact 2 | cloria Faye | Phaone |(4n4)393-945?
E-mail
Web Site |

(B save | (88 Delete | [ New | (M  Ext

Enter phone # 2
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Vendor EFT Entry (APE910)

Function

Use this program to enter the required information needed from a vendor for processing electronic
payments. Vendors must be set up in Vendor F/M before being accessible within this program. Only

vendors who accept electronic payments should be set up here. Multiple routing and account numbers
can be set up for one vendor.

Lines only need to be created for ACH payments. If a Vendor will only be paid electronically via wire
transfers, lines do not need to be entered. All vendors with the header portion of this entry set up will be
able to be paid via wire transfers.

The Pre-note button on this screen allows the user to create a pre-notification for the highlighted account
for transmission to the bank. This will ask the user what bank the pre-notification will be sent through
(this is required so FACTS knows where to create the file.)

T 01-FACTS 7.7 Development, Yendor EFT Entry (APE910) - Infor [_ =] ]
File Cptions Help
wendar w100 | [ ] General Industrial MFG
Email
Consumer Payments I:‘ To | stephanie keller@intor.com
Combine Payrments Ce
Default Payment Type [ A- ACH ﬂ Recipient Mame | Stephanie Keller
Remittance Advice Type |- Email v/ Subject | This is the email subject
Fau
Fax Mumber
Routing # | 078401251 Account# | E03s528 O
Acct Mame/Desc Same as Vendor
AcctType | c- Checing &) Pre-note Status  |n-Notsent 7]
Routing# | Account # | Frimary | Acct Name/Desciiption | Type Pre-note Status @
076401251 6002231 Tes Stephanie Keller Chedding Approved on 10/01/2008
Sammy Dawiz Jr. Savings Rejected =
Checking Mot Sent

Fre-note ][ Done

User Fields

Use the following fields to create individual records for each vendor:
1. Vendor
Enter the vendor number. Press F2 or ~* to search. Press F3 for a Vendor EFT search.
2. Consumer Payment

Allows you to identify individuals set up as vendors that payments are made to. Consumer payment
creates PPD type ACH transactions.
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3. Combine Payments

Indicates you want to allow payments from multiple vendors with the same routing and account
numbers to be combined when transmitted to the bank.

4. Default Payment Type

Enter the default payment type. You can select from: A-ACH, W-Wire Transfer, or C-Check. FACTS
uses A-ACH as the default.

5. Remittance Advice Type
Enter the remittance advice for electronic payments. You can select from: P-Print, E-Email, or F-Fax.
6.To

Enter the “To” (recipient) email address. Note: FACTS disables this prompt is the remittance advice
is not email.

7.CC

Enter the “CC” (carbon copy) email address. Note: FACTS disables this prompt is the remittance
advice is not email.

8. Recipient Name

Enter the email recipient’s name. Note: FACTS disables this prompt is the remittance advice is not
email.

9. Subject

Enter the email subject line. Note: FACTS disables this prompt is the remittance advice is not email.
10. Fax Directory Record Number

Enter the fax directory record number, Press F2 or = to access the Fax Directory Search. Note: This
field is disabled if the remittance advice type is not fax.

11. Cover

Enter the cover page. Press F1 or ) for None. Press F2 or “* to search. Note: This field is disabled if
the remittance advice type is not fax.

12. Subject

Enter the subject for the email. Note: This field is disabled if the remittance advice type is not fax.

A This concludes the header portion of the EFT Submission program. To enter vendor lines in
electronic funds transfers, complete the following.

Line numbers are assigned automatically beginning with 001 and incrementing by one for each
additional line-item up to 999. When you enter a new submission or edit an existing one the system
places you in add mode so you can enter recurring document lines. Press Q to stop line item
addition.

13. Routing Number

Enter the ABA routing number. Note: This field may NOT be left blank and must be 9 characters
long.

14. Account Number

Enter the account number. Note: This field may NOT be left blank.

15. Primary Account

Indicate whether this is the vendor’s primary account. Note that only one account can be flagged as
primary.

16. Account Name or Description

Enter the account name or description, Press F1 or to enter “Same as Vendor”.
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17. Account Type

Enter the account types. You can select from: C-Checking or S-Savings. FACTS uses C-Checking as
the default.

Enter the pre-notification status. You can select from: N-Not Sent, S-Sent, A-Approved, or R-
Rejected. FACTS uses N-Not Sent as the default. Note: When you change the value to “A-
Approved”, the pre-notification approval date will be set to the system date and the pre- notification
user will be set to the user code.

After you enter the line, press H to save your work. Press F4 or the @ icon to end line-item entry.
You can:

¥ . Adds a line-item

# _ Deletes the document

I Inserts a line item above the highlighted line in the browser.
. Changes the highlighted line-item

After you complete line item entry processing select the @ jicon.

You can select Pre-note to create a pre-notification for the highlighted account for transmission to the
bank. The system asks the user what bank the pre-notification will be sent through and verifies that
the bank is set up to accept electronic payments. This function creates a file in the bank’s default
payment batch file directory in the bank’s default ACH Entry Class format and sets the pre-
notification status will be changed to “S-Sent”.

Press the Done button to complete the EFT submission entry.

Menu Options:

-File

Delete Vendor Entry--Deletes all account lines and the vendor EFT header record.

Exit—Returns to the FACTS AP File Maintenances menu.

-Options

Create Pre-notification-- Allows the user to create a pre-notification for the highlighted account for
transmission to the bank. The system asks the user what bank the pre-notification will be sent
through and verifies that the bank is set up to accept electronic payments. This function creates a file
in the bank’s default payment batch file directory in the bank’s default ACH Entry Class format and
sets the pre-notification status will be changed to “S-Sent”.

-Help

Accesses online help for this screen.
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Payment History F/M (APF930)

Function

This program allows the user to create and maintain vendor payment history
which includes payments made to each vendor for the next period, current
period and 26 previous periods.

This program should be used as a file maintenance only once to enter original
information. Thereafter, it is updated by the system and changes made by the
user may compromise data. Entering initial information into this file is
optional.

The update portion of the Check Register program updates the information in
the payment history file.
User Fields

The following fields are involved in creating a payment history record:
* Vendor number

Enter the vendor number. If a payment history record for this vendor is on file,
it will be displayed.

Most Current Period Payments and Previous Payments

Enter the payment amounts for the next period, current period and prior 26
periods (+/-99999999.99). The 14 most current periods are located on the Most
Current Period tab. Another 14 periods are located on the Previous Periods tab.

Press Enter (CR) to initially default to 0. F2 sets the current and remaining
fields to 0.
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T 01-FACTS 7.7 Development, Payment History F/M {APF930} - Infor - |EI|5|
Help
vendor General Industrial MFG MR
Most Current Periods | Previous Periods
Petiod Payment Period Payment
MP 102004 Oct 500.00 FP 03/2004 Mar 7350.03
P 09/2004 Sep G347 .21 PP 022004 Feb a0a5.56
LP 08/2004 Aug i bricac i FP 01/2004 Jan 716416
PP O7/2004 Jul 11655 .25 PP 122003 Dec 5920.56
FP 062004 Jun 11736 54 PP 1172003 Moy 5427 .50
PP 052004 May 10269 .25 PP 102003 Oct 979130
FP 0452004 Apr g2 72 FP 0952003 Sep a750.39
[H Save ] [x Delete ] [ [& Mew ] [ Exit
Enter payment for Mext Period 1002004 Oct
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Transfer/Change Vendor Codes (APU910)

Function

This program allows the user of the FACTS system to change specific
information in the vendor file for a range of vendors.

The user has the option to change the following fields:

1. Vendor class 7. Default cost

2. Terms code class

3. GL posting table 8. Cost hierarchy
4. Document group 9. Use lowest cost
5. Ledgercard flag flag

6. Past PO flag

To change a field the user may:

e Select the order to change - vendor, alpha, or vendor class.
e Select the beginning and ending order choice to change.

e Select the change FROM field.

o Select the change TO field.

The fields above are all part of the information stored on each vendor in the
vendor file. This program is especially useful to make changes to many
vendors without having to manually change each vendor individually through
the Vendor F/M program.

An example of the use of this program is if the user started to give a 2% terms
discounts replacing the 1% discounts. All fields being changed must be valid
fields. For example, if changing terms codes, all codes being changed must be
valid terms codes. Changes made in this program do not affect transaction files
or other modules.

User Fields

The following fields are involved in changing vendor information:
1. Select number

Enter the number of the field to be changed (1-6).
2. Order

Select the order the field is to update.

3. Beginning order choice

Enter the beginning order choice.

4. Ending order choice

Enter the ending order choice.

5. Change from

The answer to the first field (Select #) is the field being changed (e.g., if vendor class was selected,
enter the vendor class that is being changed). Press F3 or <D to default to ALL.
6. Change to
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The answer to the second field (Select #) is the field being changed to (e.g., if vendor class was
selected, enter the vendor class to change to). Press F3 to default to the user selection. If you press
F3, the program stops at every vendor whose vendor class is to be changed and requires field of the
new vendor class.

{i_ Transfer/Change Yendor Codes {APUI10) - |EI|5|
Help
B1-FACTS 7.7 Development TRANSFERfCHAHGE UVEHDOR CODES APuU91d

THIS PROGRAM ALLOWS AUTOMATIC OR OPERATOR ASSISTED CHAMGES OF SPECIFIC
INFORMATION IH THE UVEHDOR FILE FOR A RAHNGE OF VEHDDRS.
CHAHGES DO HOT AFFECT TRAWSACGTION FILES OR OTHER MODULES.

UEHDOR CLASS
TERMS CODE

GL POITIHG TABLE
DOCUMENT GROUP
LEDGERCARD FLAG
PAST PO FLAG

DEF COST CLASS
COST HEIRARCHY
USE LOWEST FLAG

L= --R N - RV N LR L

SELECT # OF INFORMATION TO BE CHANGED, F4—END ..

9-14 FACTS AP



IiNfoe

Infor ERP FACTS

Infrequent F/M

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to the Installation Manual).

CHAPTER 10

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
for the latter programs; most of these are used only one time during the initial set
up of the system. However, the information in the infrequent file maintenances
may be updated by the system. An example would be the Nonstatic Control
F/M which keeps track of the accounts payable period and all the register trace

numbers.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the accounts payable system do not need to be maintained by
the user and it is unlikely that they will be used.

T Infor ERP FACTS - FACTS 7.7 Pre-release Demo - Master Menu

inTos ERPFACTS
11/19/2009 - 12:42 prr

Infor Global Sohtions (INHT2)

C:\77alpha

&

Crocument Entry

=

Repors & Prints

Fayment & Hold

£

Checks

=X

Inquiries
Selection

i

End of Period

File Maintenances

&
0 Help ™

“endor Class

Terms Code Fit

GL Posting Tahle Fid
Register Histary Fid
Check Print Contral Fit
Static Contral FiM
Monstatic Cantral Fikd
Fehuild AP Sort Files

powared by 14 Fame
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Vendor Class F/M (APF950)

Function

This program allows the user to create and maintain vendor class records which
are used to categorize the different types of vendors.

Users may establish their own set of valid vendor classes. Each vendor will be
placed into a vendor class. These classes are used on some printouts in order to
group vendors. For example, the user may want to group all inventory vendors,
utility vendors, office supply vendors, etc. Assign any alphanumeric code to
indicate each class (i.e., 001, 002, 003 or INV, UTL, OFF). If the user chooses not
to use vendor classes, one class should be created and all vendors must be
assigned to that class.

At least one vendor class must be entered here prior to entering vendors into the
vendor file.

User Inputs

The following inputs are involved in creating a vendor class record:
1. Vendor class
Enter the vendor class code (up to 3 characters). Press F2 or —= to search.
2. Vendor class description

Enter the description of the vendor class (up to 30 characters).
3. GL table

Enter the default GL posting table for this class. This is only a default and is used in the Vendor F/M
program. If the vendor class is UTL and the GL posting table is 100, then when entering UTL as the
vendor class in the Vendor F/M program, the GL posting table will default to 100 with the user

having the option to override the GL posting table. Press F2 or — to search.

T 01-FACTS 7.7 Development, Yendor Class F/M (APF950) - | =]

Help

Yendaor Class |:| |I|E|D|I|

Description |

GL Table

[lT Save ][r”' Delete ][F Mewy ][E] Exit

Entervendor class, F2-Search, F3-First Record
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Terms Code F/M (APF955)

Function

This program allows the user to create and maintain terms code records.

Users may establish their own set of valid terms codes to be assigned to each
vendor. The information given about each terms code will be used in
determining due dates and discount due dates during AP Document Entry. The
user should assign terms code designations that are easy to remember, for
example, 30-net 30 days, 01- 1% 10 net 30, etc.

An M-manual terms code should be set up. During the Document Entry
program the M terms code indicates to the system that the due date, discount
due date and allowable discount are entered by the user and not calculated by
the system. The M terms code should be assigned to vendors with variable terms
codes.

The following table illustrates how some of the more common terms codes
would be entered:

Code 10 20 99
Description 1% 10 Net 30 2% 10 Net 30 Cash
Date/Num/Spec N N N
# of Payments 1 1 1
Discount % 1.00% 2 0.00
First Net Due 30 10 0
Discount Due 10 0 0
Cutoff Day Current Month 10

Cutoff Day Next Month 25

Subsequent Due
Sub. Dscnt Due
Specific Date Due
Spec. Dsent Due

Valid terms codes must be entered here prior to entering vendors into the vendor
file.

FACTS AP 10-3



Infrequent F/M Accounts Payable—7.7

User Inputs

The following inputs are involved in creating a terms code record:

1. Terms code

Enter a terms code (up to 2 characters). Press F2 or — to search.

2. Terms description

Enter the description of this terms code (up to 15 characters).
3. Date/Num/Spec (date/number of days/specific)

Enter D if payment is always due on a certain day of the month, e.g., the 10th. Enter N if payment is
always due in a certain number of days, e.g., in 30 days. Enter S if payment is due on a specific date,
e.g., 7/8/97. Press Enter to initially default to D.

4. # of payments

Enter the number of payments expected (1-12). Press Enter to initially default to 1. Example, if terms
are Net 30, 60, 90 then three payments will be made. If S was selected for field #3, then the number of
payments must be 1.

5. Discount %

Enter the allowable discount percent (0 to 99.99). For example, if it is a one percent discount enter
1.00. Press Enter to initially default to 0.

6. First net due (date)

If D or N was selected in field #3, enter either the day of the month or the number of days until due
(0-999). If S was chosen in field #3, this field is skipped. Press Enter to initially default to 0.

7. First discount due (date)

If S was selected in field #3, this field is skipped. Enter the day of the month or number of days that
payment is due to be eligible to receive a discount (0-999). Press Enter to initially default to 0.

8. Cutoff day current month

If S was selected in field #3, this field is skipped. Enter the day (invoice date) before which the due
date will still be in the current month. If this is set to zero, the invoice will never be due in the
current month. If this is set to 5, the due date will only be in the current month if the invoice date is
the 1st - 4th of the month. For example, if the terms are 2% 10th Net 30th and anything invoiced after
the 4th is due the next (following) month, the cutoff would be set to 5. If invoiced on September 4th
the discount due date is September 10th and the net due date is September 30th. If invoiced on
September 5th the discount due date is October 10th and the net due date is October 30th.

9. Cutoff day next month

If S was selected in field #3, this field is skipped. Enter the day (invoice date) before which the due
date will be in the next month. If this is set to 25, the due date will only be in the next month if the
invoice date is between the cutoff for the current month and the 25th of the month. For example, if
the terms are 2% 10th Net 30th and anything invoiced after the 25th is due in two months, the cutoff
would be set to 25. If invoiced on September 24th the discount due date is October 10th and the net
due date is October 30th. If invoiced on September 25th the discount due date is November 10th and
the net due date is November 30th.

10. Subsequent due (date)

If S was selected for field #3 or the number of payments selected in field #4 is 1, then this field is
skipped. If N was entered in field #3, enter the number of days until due (0-999). If D was entered in
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field #3, enter the date of each month when payment is due (0-31). This field is used only for terms
codes with multiple payment due dates. Press Enter to initially default to 0.

11. Subsequent dscnt due (subsequent discount due date)
If S was selected for field #3 or the number of payments selected in field #4 is 1, then this field is
skipped. If N was entered in field #3, enter the number of days until discount due date (0-999). If D

was entered in field #3, enter the date on which payment is due to be eligible for a discount each
month.

12. Specific date due

Enter the specific date on which payment is due if S was chosen in field #3.

13. Specific dscnt date (specific discount date)

Enter the specific due date on or before which payment must be made to receive a discount if S was

chosen in field #3.
T 01-FACTS 7.7 Development, Terms Code F/M (APFI55) - Infor - |EI|5|
Help
Terms Code | 1] MANUAL [TEIEI
Description | ManUAL |
DatesMurmiSpec |0 - Based on Date j|
# of Payments Discount %
First Due
et Discount
Cutoff Day

Current Manth E Mext Month
Subsequent Due
Met E Discount E

[H Save ][R Delete ][[,g e ][ Exit

Specific Date

Enter terms description
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GL Posting Table F/M (APF960)

Function

This program allows the user to create and maintain GL posting tables. GL
posting tables are used to expedite input of GL expense account numbers during
AP Document Entry.

Users may establish their own set of valid GL posting tables to be assigned to
each vendor. For example, all invoices from freight companies may be expensed
to the same GL account number. The user should assign one GL posting table to
all freight vendors. Posting tables may be alphabetic or numeric and should be
easily recognized. During Document Entry, the user must input the vendor
number. The GL posting table code assigned to that vendor is displayed and
may be overridden on the invoice. The GL account numbers stored with the GL
posting tables become the default value for the expense account number entered
in Document Entry. Document Entry also allows a search to display all GL
numbers set up in a posting table.

In Document Entry, the user may expense an invoice to up to 999 expense
accounts. The GL posting table allows the user to set up to five default expense
accounts to make entry of AP documents easier.

The GL posting table also contains the Accounts Payable GL number to post and
the Discounts GL number to post when a discount is taken.

Example: Southern bell is a vendor set up in the vendor file and for GL posting
purposes is considered a telephone vendor. Therefore, the user sets up a GL
posting table TEL-telephone. When posting most phone bills from Southern Bell,
the user normally expenses to the telephone GL expense account. However,
occasionally the user advertises in the yellow pages and when those bills are
entered, they are expensed to the advertising GL expense account. The user sets
up the GL posting table as follows:

GL Table  TEL
Description Telephone

G/L# Description

Expense 1 735-00-00 Telephone

2 710-00-00 Advertising

3

4

5
Accounts Payable 310-00-00 Accounts Payable
Discounts 490-00-00 Discounts Taken

In Document Entry, if the GL posting table is TEL for the invoice being entered,
the system automatically defaults to 735-00-00 for the first GL number to be
expensed. The user also may perform a search to display all of the GL expense
numbers set up in the TEL GL posting table. In this example, 735-00-00
telephone and 710-00-00 advertising are displayed.

Therefore, when a regular telephone bill is entered, the user may allow the
system to default to 735-00-00 telephone. However, when an occasional
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advertising bill is entered, the user may search to see the other possible expense
GL numbers to use.

If the Post by branch flag is set to Y in the AP static control record, the Document
Entry program automatically inserts the branch in the proper position in the GL
number when displaying the expense numbers of the GL posting table.

Within each GL posting table there is also an account number for accounts
payable. This number is posted when entering an accounts payable document or
writing a check and paying it off. The discounts number is posted when a
discount is taken, i.e., when the payment is made and the check is written.
Discounts are not posted upon initial entry of the document, but when the
discount is entered when payment is made (i.e., when the discount is taken).

If the user enters two bills for Southern Bell - a telephone bill for $350 and an
advertising bill for $150, the summary Document Entry Register GL distribution
using the GL posting table listed above would be as follows:

Debit Credit
310-00-00 Accounts payable -500.00
730-00-00 Telephone 350.00
710-00-00 Advertising 150.00

If the user pays the two bills and takes a 2% discount on the advertising bill, the
summary Check Register GL distribution using the GL posting table listed above
would be as follows:

Debit Credit

*100-00-00 Cash in Bank -497.00
310-00-00 Accounts Payable 500.00

490-00-00 Discounts Taken -3.00

* The cash G/L number comes from the Bank G/L number set up in the Bank
F/M in the banking and check system in system management.

If the Post by Branch flag is set to Y in the AP static control record, the Document
Entry & Adjustments Register and Check Register automatically insert the
branch (assigned to each document) in the AP and discounts GL numbers when
posting to GL.

When setting up the GL Posting Tables, because they are user-defined, there is no
limit to the number set up. Any of the expense numbers may be entered as
defaults in the AP Document Entry. The AP and Discount G/L numbers are
mandatory numbers and may not be overridden during entry of current payment
selection or check writing.
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If a loan is to be entered and the balance posts to Notes Payable rather than an
accounts payable account, when setting up GL posting tables, one may be set up
as follows:

GL Table LN

Loans

G/L # Description

* Expense 1
* 2
* 3
* 4
* 5
Accounts Payable 320-00-00 Notes Payable
Discounts 490-00-00 Discounts Taken

If a GL posting table is set up with no expense accounts, the user has no default
expense numbers in Document Entry.

The Document Entry program, Document Entry & Adjustments Register and
Check Register programs use information stored in these records.

User Inputs

The following inputs are involved in creating a GL posting table:
1. GL table

Enter the GL posting table (up to 3 characters). The user may wish to begin numbering GL posting
table with 001 and continue with 002, 003, etc. We suggest reserving GL posting table 000 for
temporary vendors or any vendor for whom the expense account number may change with each
invoice. Posting table 000 would have no expense account numbers entered. Posting table 000 may
also be used by the user who does not wish to take advantage of GL posting tables and wishes to

type all expense account numbers with each invoice entered. Press F2 or — to search.

2. Description

Enter the description of the GL posting table (up to 30 characters).

3. Expense 1
Enter the general ledger expense account number used by this GL posting table. The entry must be a
valid general ledger number. Press Enter (CR) to default to no expense number initially. Press F2 or

» to search.

4. Expense 2
It may be the case that invoices are divided and expensed to several different account numbers. The
user may enter up to five expense account numbers to be used as default values during Document
Entry. For example, office supplies may be expensed to several departments. The office supply GL

posting table would list up to five expense account numbers for office supplies. Enter the second GL
expense number if one is needed. Press Enter (CR) to initially default to no expense number. Press

F2 or —% to search.

5. Expense 3

Enter the third GL expense number if needed. Press Enter (CR) to initially default to no expense

number. Press F2 or —% to search.
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6. Expense 4

Enter the fourth GL expense number if needed. Press Enter (CR) to initially default to no expense
number. Press F2 or — to search.

7. Expense 5

Enter the fifth GL expense number if needed. Press Enter (CR) to initially default to no expense
number. Press F2 or % to search.

8. Accounts Payable GL number

Enter the accounts payable general ledger account number to be used as the off-setting entry against

the expense accounts. The entry must be a valid general ledger number. Press F2 or —% to search.
9. Discounts GL number

Enter the discounts taken GL account number. The entry must be a valid general ledger number.
Press F2 or — to search.

T 01-FACTS 7.7 Development, GL Posting Table F/™ (APF960]) - - |EI|5|
Help

GL Tahle [T

Description | Office |

Expense 1 E20-01-1 Office Expense
2 | oooooo
3 | oooooo
4 | oooooo
5 [ oooooo
Accounts Payahle 30-01-0 Accounts Payable

Discounts 480-01-1 Discounts Taken

[H Save ][x Delete ][[3 MNew ][ Exit

Enter GL posting table description
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Register History F/M (APF965)

Function

This program allows the user to trace through all registers of the current period
to see how the Accounts Payable balance is affected by each register.

When initially setting up the AP system, no records need to be entered here.

For every register run and updated that affects the Accounts Payable balance, a
record is created by the system. Information includes the following:

e AP register trace number - As each register is updated the system assigns a trace
number.

e Register types - Check, Entry, and Vendor balancing.

e Date - The date the register is updated.

e Period - The period the register is updated.

e Register # - The number which is assigned to each register when it is run.

e Beginning AP balance - The AP balance before the register is updated.

e Dollar amount - The actual dollar amount of the register which affects the AP balance.

e Discount amount - The discount amount (if applicable) on the register.

e Adjustment amount - The adjustment amount (if applicable) on the register.

¢ Ending AP balance - The AP balance after the register is updated. This balance
becomes the beginning balance on the next AP register trace number.

User Inputs

The following inputs are involved in creating a register history record:
1. AP register trace number
Enter the AP register history trace number (1-9999).
2. Register type

Indicate whether the register type is C-check, E-entry or V-vendor balancing. Press Enter (CR) to
initially default to C.

3. Date

Enter the register date.
4. Period

Enter the register period (PPYY).
5. Register number

Enter the register number (1-9999).
6. Beginning AP balance

Enter the AP balance before the register was updated (+/- 99999999.99). Press Enter (CR) to initially
default to 0.

7. Dollar amount

Enter the dollar amount of the register to affect the AP balance (+/-99999999.99). Press Enter (CR) to
initially default to 0.
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8. Discount amount
Enter the discount amount of the register to affect the AP balance (+/-99999999.99). Press Enter (CR)
to initially default to 0.

9. Adjustment amount
Enter the adjustment amount of the register to affect the AP balance (+/-99999999.99). Press Enter
(CR) to initially default to 0.

10. Ending AP balance
Enter the AP balance after the register has been updated (+/- 99999999.99). Press Enter (CR) to
initially default to 0.

T 01-FACTS 7.7 Development, Register History F/™M (APFA65) - Infor - |EI|5|

Help

AP Register Trace # 6547 |I|C|D[I|

Register Type  |[EERICIRREN Dollar Amount G65.47

Date | 08072004 Discount Amaunt on

Period  |ogso04 SEP Adjustment Amaunt Jull]

i

Register # 1505 Ending AP Balance 146261 22

Beginning AP Balance

145582 75 |

[H Save ][x Delete ][[3 e HE Exit

Enter check, entry, or vendar balancing register type
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Check Print Control F/M (APF975)

Function

This program allows the user to create and maintain check parameters that
determine the print positions of information on AP checks.

The check parameter records enable the user to control, within broad limitations,
the print positions of AP check information without requiring program changes.
One record is stored for each bank to allow different checks for each bank. If the
standard AP check is to be used, the user should allow each input to default to its
preset value. This will produce a check that matches the standard FACTS check.

The Check Print program verifies that check parameters are on file for the
selected bank. Therefore, this record must be set up prior to printing checks.

Laser Check Driver Print Parameters

The laser driver, HPCHECK, prints to laser printers in 12 pitch. Using the correct settings in FACTS
and the correct forms, this driver accommodates printing laser checks in FACTS. Contact TransForm
Technologies directly to order checks or to request samples at (800) 226-2564 or email Chris Bilello at
chris.bilello@thetransformgroup.com or Dottie Ward at dottie. ward@thetransformgroup.com.

To use the HPCHECK laser driver, associate a link file for the laser printer with the HPCHECK printer.
You can set it up as an additional printer in FACTS if other users make use of the laser printer for
normal printing tasks. Use the settings below in Check Print Control F/M for Accounts Payable and
Payroll laser check forms.

Note that these settings are only for the laser check forms (Accounts Payable and Payroll) provided by
Transform Technologies. Laser check forms provided by any other forms vendor may not comply with
the set up parameters given below.

Accounts Payable Check HPCHECK Laser Driver Parameters

Vouchers tab Checks tab

# Lines Per Voucher 41 # Lines Per Check 19
# Invoices Per Voucher | 32 Maximum Columns - Script 55
Void Stub Overrun Y Check Column - Check Number 51
Checks

Plain Paper Vouchers N Check Column - Date 62
Voucher Column - 44 Check Column - Script 11
Vendor

Voucher Column - 62 Check Column - Amount 80
Name

Voucher Column - Date | 45 Check Column - Name/ Address 13
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Vouchers tab (continued)

Voucher Column - 70
Check Number

Voucher Column - Page | 86
Number

Voucher Column - 0
Invoice Date

Voucher Column - 11
Invoice Number

Voucher Column - 25
Invoice Amount

Voucher Column - 39
Discount

Voucher Column - 53
Payment

Voucher Column - 66
Memo

User Inputs

The following inputs are involved in creating a check parameter record:

Check Print Control E/M Vouchers tab
*. Bank

Enter the bank code for these parameters. The entry must be a valid bank code. Press F2 or % to
search.

Vouchers tab
2. # Lines Per Voucher
Enter the maximum number of horizontal lines (10-99) on the voucher (or stub) portion of the check.
Press Enter (CR) defaults to 21 initially.
[10If you don’t want to print a voucher, enter 0.
3. # Invoices Per Voucher
Enter the maximum number of invoices to print on the voucher portion of the check (1-9 less than

lines per voucher chosen in field #2). If 0 was entered in field #2, 0 is the only valid field. Press Enter
(CR) to initially default to 12.
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4. Void Stub Overrun Checks
Enter Y or N to indicate whether to void the checks when the voucher is filled with invoices and
print continued and continue on another voucher. Press Enter (CR) to initially default to Y.

5. Plain Paper Vouchers
Enter Y, N or O to indicate whether to print vouchers on plain paper after checks are printed.

Entering an O means to print the vouchers on overruns only. Press Enter (CR) to initially default to
N.

6. Voucher Column - Vendor
Enter the column number where the vendor number will print on the voucher (0-125). Press Enter
(CR) to initially default to 39.

7. Voucher Column - Name
Enter the column number where the vendor name will print on the voucher (0-106). Press Enter (CR)
to initially default to 53.

8. Voucher Column - Date
Enter the column number where the date will print on the voucher (0-123). Press Enter (CR) to
initially default to 40.

9. Voucher Column - Check Number
Enter the column number where the check number will print on the voucher (0-125). Press Enter
(CR) to initially default to 59.

10. Voucher Column - Page Number
Enter the column number where the page number will print on the voucher (0-129). Press Enter (CR)
to initially default to 75.

11. Voucher Column - Invoice Date
Enter the column number where the invoice date will print on the voucher (0-123). Press Enter (CR)
to initially default to 2.

12. Voucher Column - Invoice Number
Enter the column number where the invoice number will print on the voucher (0-125). Press Enter
(CR) to initially default to 11.

13. Voucher Column - Invoice Amount
Enter the column number where the gross amount of the invoice will print on the voucher (0-120).
Press Enter (CR) to initially default to 22.

14. Voucher Column - Discount
Enter the column number where the invoice discount amount will print on the voucher (0-120). Press
Enter to initially default to 34.

15. Voucher Column - Payment
Enter the column number where the payment amount will print on the voucher (0-120). Press Enter
(CR) to initially default to 46.

16. Voucher Column - Memo

Enter the column number where the memo entered during Document Entry will print on the
voucher (0-106). Press Enter (CR) to initially default to 58.
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Check Print Control E/M Checks tab

2. # Lines Per Check
Enter the maximum number of horizontal lines per check (19-99). Press Enter to initially default to
21.

3. Maximum Columns - Script

Enter the maximum number of columns to be used when spelling out the check amount in words.
Count one column for each letter and space (0-130). Press Enter (CR) to initially default to 55.

4. Check Column - Check Number

Enter the column number where the check number will print on the check (0-125). Press Enter (CR)
to initially default to 45.

5. Check Column - Date
Enter the column number where the check date will print on the check (0-123). Press Enter (CR) to
initially default to 55.

6. Check Column - Script
Enter the column number where the check amount spelled out in words will print on the check (0-

131 depending on the maximum number of columns in the script). Press Enter (CR) to initially
default to 11.

7. Check Column - Amount

Enter the column number where the check amount in numbers will print on the check (0-120). Press
Enter (CR) to initially default to 68.

8. Check Column - Name/Address

Enter the column number where the vendor's name and address will print on the check (0-106). Press
Enter (CR) to initially default to 13.
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T 01-FACTS 7.7 Development, Check Print Control F/M (APF375] - Ink - |EI|5|

Help

Bank First National Bank of Atlanta (X EN T

Vouchers |Checks

#¥Lines PerVoucher Yoid Stub Overrun Checks

# of Invoices PerVoucher FPlain PaperYouchers |Y- Print j|
—Woucher Columns
Yendar 34 [ # 11
Marne 53 I At 22
Date an Discount 34
Check # 59 Payrment 45
Page # 75 Merno
Iy Date 2

H save | (38 Delete |[[@ New |[W Ext

Enter # oflines perwoucher stub (10-99, 0=Mo Check Stub)
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Static Control F/M (APF980)

Function

This program allows the user to create and maintain the company AP Static
Control record. The AP Static Control record is critical to the proper functioning
of the AP system. The record contains information which the AP system
references in performing various functions.

CAUTION: It is strongly advised that a password be used for this program.
Changes should be made only with extreme caution and under the supervision
of your dealer.

User Inputs

The following inputs are involved in creating the company AP static control record:

Financial Screen

AP Static Control F/M Financial Screen
1. Bank

Enter the bank code of the standard AP bank. This bank becomes the default value throughout the
AP system where a bank code is required. The entry must be a valid bank code. Press Enter to

initially default to the first bank on file. Press F2 or —* to search.
2. GL Distribution

The accounts payable system may post to general ledger automatically. The Document Entry and
Check Registers may print a general ledger distribution and make a journal posting to GL during the
update. Enter 0 (Not Used) , 1 (Print Only) , or 2 (Print and Post), to indicate how AP is tied in with
general ledger. Press Enter (CR) to initially default to 0.

3. GL Expense Journal
If 0 or 1 was entered the GL Distribution field, this field is skipped. Enter the general ledger journal
number to post to for the expense posting of the Document Entry & Adjustments Register. The entry
must be a valid journal number. Press F2 or —% to search.

4. GL Disbursements Journal
If 0 or 1 was entered in the GL Distribution field, this field is skipped. Enter the general ledger
journal number to post to for the disbursement posting of the Check Register. The entry must be a
valid journal number. Press F2 or — to search.

5. Post By Branch

Enter N or Y to indicate whether to insert the branch in the G/L# when posting to general ledger.
If set to Y, when entering documents in the Document Entry program, the branch assigned to the
document is inserted in the GL account numbers displayed from the GL posting table. When
posting to GL in the Document Entry and Check Registers, the branch assigned to the document
is inserted in the Accounts Payable and Discounts GL account numbers.

Note that the Post by Branch setting only applies to non-expense portions of the AP Document.
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The GL number for the expense side of an AP Document can be for any branch, regardless of
whether "Post by Branch' is selected (set to Y) on AP Static Control F/M.

6. Use Period Check Register

Indicate whether the Period Check Register will be used. If you do not select this checkbox, the
Period Check register will not be available. Press Enter (CR) to initially default to selected.

7. Use Period Expense Report

Indicate whether the Period Expense Distribution will be used. If you do not select this checkbox, the
Period Expense Distribution program will not be available. Press Enter (CR) to initially default to
selected.

8. Use Period Disbursement Report

Indicate whether the Period Disbursement Distribution will be used. If you enter N, the Period
Disbursement Distribution program will not be available. Press Enter (CR) to initially default to Y.

AP Static Control F/M General Screen
1. Number Of Periods Paid Documents Stored

Enter the maximum number of periods to store information regarding paid off documents for report
and inquiry purposes (0-99). Press Enter (CR) to initially default to 3; press & or 0 to indicate that
paid documents are not stored.

2. Number Of Months Check History Stored
Enter the maximum number of months to store information regarding check history for report and

inquiry purposes (0-99). Press Enter (CR) to initially default to 3; press ** or 0 to indicate that check
history is not stored.
3. Number Of Days Auto Increment

The Cash Requirement Reports in accounts payable and purchase orders print amounts due in each
of several columns. You have the ability to determine the number of days in each column. The
number of days (1-99) entered here will become the default value for the field on the Cash
Requirement Reports. This is also used as the default lead time in the Payment Selection by Date
program. Press Enter (CR) to initially default to 7.

4.1099 EOY Period

Enter the end-of-year period for 1099 purposes (i.e., the fiscal period for December). Press Enter (CR)
to initially default to the last period of the fiscal year.

0 - no GL distribution is printed or posted.
1 - the GL distribution is printed (printing is in detail format) but not posted to GL.

2 - the GL distribution is printed (printing is in detail format) and posted to GL in detail
(posting includes each item contributing to the amount for each account number).

5. YTD Roll Period

Enter the fiscal period when year-to-date purchase history figures in the vendor file should be rolled
to the prior year. Press Enter (CR) to initially default to the last period of the fiscal year.

6. Use Payment History

Indicate whether monthly payment history will be used. If you do not select this checkbox, the
Payment History Report will not be available. Press Enter (CR) to initially default to selected.
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7. Use Vendor Ledgercards

Indicate whether to use vendor ledgercards. If you do not select this checkbox, ledgercards will not
be available. Press Enter (CR) to initially default to selected.

8. Use Job Cost

Indicate whether Job Cost is to be used and tied into Accounts Payable. Press Enter (CR) to initially
default to unselected.

9. Aging - First Cutoff
Enter the first aging cutoff (number of days) to be used to determine the second column on the Aged
Payables Report. Press Enter (CR) to initially default to 30. The first column is CURRENT.

10. Aging - Second Cutoff

Enter the second aging cutoff (number of days) to be used to determine the third column on the
Aged Payables Report. Press Enter (CR) to initially default to 60.

11. Aging - Third Cutoff
Enter the third aging cutoff (number of days) to be used to determine the fourth column on the Aged

Payables Report. Press Enter (CR) to default to 90 initially. The fifth column is OVER 90 if you
entered 90.

& 01-FACTS 7.7 Development, A/P Static Control F/M (APF98O) - Infor AEA
Help

Financial | General

# Periods Paid Docs Stored

# Periods Check Histary Stored
# Days Auto Increment

1099 EOQY Period

YTD Roll Period 12

Not Used

Ilze Payment History
Use Vendar Ledgercards
se Job Cost

Ading Cutoff 1

Aning Cutoff 2

Aning Cutoff 3

[< [5] [
S8

o
[ I | e |

[H Save ][ﬁ Delete Exit

Enter# of periods to store paid documents, F1-Mot Used
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T o1-FACTS 7.7 Development, A/P Static Control F/™ (APF980) - Infor - |EI|5|

Help

Financial | General

# Petinds Paid Docs Stored 1| [Q)
# Days Auto Increment 7
1099 ECY Period 12

YTD Roll Period 12

Usze Payment History
UszeVendor Ledgercards
Use Job Cost

Aging Cutaff 1

Aning Cutoff 2 B0

Aning Cutoff 3 a0

(& Save | (86 Detete | [F mew | (M Ew

Enter # of periods to store paid documents, F1-Mot Used
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Nonstatic Control F/M (APF990)

Function

This program allows the user to create and maintain the company AP Nonstatic
Control record. The AP Nonstatic Control record is critical to the proper
functioning of the AP system. The record contains information which the AP
system references in performing various functions.

CAUTION: It is strongly advised that a password be used for this program.
Changes should be made only with extreme caution and under the supervision
of your dealer.

User Inputs

The following inputs are involved in creating the nonstatic control record:
*1. Current AP balance

This field should initially be set to 0. It will be updated by the system when
documents are entered, checks are written or the Vendor Balancing Register is
run. Press Enter (CR) to initially default to 0.

2. Current AP period
Enter the current accounts payable period (PPYY). Press Enter (CR) to initially
default to the current GL period and must be in the current or next GL period.

After initial entry, this field will be updated by the End-of-Period Update
program.

3. Date of last End-of-Period Update

Enter the date of the last End-of-Period Update in accounts payable. After the
initial entry, this field will be updated by the End-of-Period Update program.
Press Enter (CR) to initially default to 010100.

4. Lastrecurring post date

Enter the date of the last recurring payables posting. After initial entry, this field
will be updated by the Post Recurring Payables Update program. Press F1 to
default to NA (not applicable). Press Enter (CR) to initially default to NA.

The system uses the following inputs to track register numbers, and it maintains the information that
appears in these fields.

*5-10. Register numbers

These numbers keep track of the last register number used. As a register is
updated, the last number used is incremented by one. Upon installation, these
fields should be set to 0. These fields will automatically be updated through
normal processing. Press Enter (CR) to initially default to 0.

11. Last vendor number used

Enter the last vendor number used when the system automatically assigns
vendor numbers in the Vendor F/M. If F1-NEXT is used to enter the vendor
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number in the Vendor F/M, the first vendor number will be 1. Press Enter (CR)

to initially default to blank.

* indicates that changing the field after initial installation may have serious repercussions. Please refer
to your dealer before any changes are made.

T o1-FACTS 7.7 Devyelopment, Nonstatic Control F/M (APF990) - Infor - |EI|5|

Help

—Current AP
Balance | 1133226193 |
Period SEP
—Last
Date of EOP Update  |07/10/2003 |
Recurring Post Date | ar20i2004 | @]
Renister Trace # BE01
Document Entry Reo# 1523

Check Redister # 0373

Yendar Balancing Reg# 0021
Document Removal Reg# 0oE1
Document Change Reg# W
Yendor ¥ Used |

[H Save ][x Delete ][F ey ][E Exit

Enter current accounts payable halance
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Rebuild AP Sort Files (APU990)

Function

This program allows the user to rebuild sort files which may not be up to date
with the rest of the system.

Sort files are used throughout the FACTS system to enable the user to report or
retrieve information in an order other than the order in which the main file is
stored in. For example, the records of the customer file are stored in customer
number order. To access this file in alphabetical order requires a sort file which
is stored by an alpha look up by customer number. The corresponding record in
the main file may then be accessed for the needed information.

The Rebuild AP Sort Files program should only be run under the supervision of
your dealer.

User Inputs

The following inputs are involved in rebuilding AP sort files:
1. APVAILIX

Indicate whether to rebuild APVALX. This file is the AP vendor by alpha sort
file to the AP vendor file (APVEND). The file is used in the various AP reports
that can be printed alphabetically. Press Enter (CR) to default to unselected.

2. APCLSX

Indicate whether to rebuild APCLSX. This file is the AP vendor by vendor class
sort file to the AP vendor file (APVEND). The file is used in the various AP
reports that can be printed by vendor class. Press Enter (CR) to default to
unselected.

3. APDOCX

Indicate whether to rebuild APDOCX. This file is the AP document sort to the
document entry & adjustments file (APDOCM). This file is used in the AP
Document Entry & Adjustments Register. Press Enter (CR) to default to
unselected.

4. APCONX

Indicate whether to rebuild APCONX. This file is the vendor by vendor contact
sort file to the AP vendor file (APVEND). This file is used during the contact
search in the Vendor Search Program. Press Enter (CR) to default to unselected.
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{i_ Rebuild AP Sort Files (APU390)

(1) () (Ena | (oK

S
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Appendix A: References

1. Alignment- An alignment check is often desired to ensure that forms paper is correctly aligned
in the printer. Enter Y or N to indicate whether to print an alignment. CR defaults to N and no
alignment check is printed. If Y is entered, the alignment check prints immediately and the program
returns to this input.

2. Date - Dates will be displayed according to the format set in the Company Control Record. For
viewing purposes, all dates will be displayed with a two digit year. For editing purposes, all dates
will allow the entry and display of a four digit year. An entry date can be viewed in its entirety by
using the left and right arrow keys or by using the HOME and END keys to scroll through the date
field. The system will allow the full date or a partial date to be entered.

Special dates that were previously displayed and stored as 01/01/00 and 12/31/99 will no longer be
handled in the same manner. Tag names such as NONE, ASAP, FIRST, LAST, etc. will now be used in
place of “generic’ dates. These tag names will also be accepted as the valid input dates in some data
entry prompts.

If you are upgrading from FACT 6.05 (or earlier) to FACTS 6.06 (or later), the dates stored in your
system are converted for you behind the scenes. Dates that display as **/**/** indicate that data is
present for the field but the system does not know how to interpret the date. Contact your affiliate for
support.

The Rule of 50: FACTS programs uses a “rule of 50” logic to expedite date processing. If the two
digit year is greater than or equal to 50, the system will assume the date to be in the 1900s; if the two
digit year is less than 50, the system will assume the date to be in the 2000s.

During data entry, if the system is unable to interpret the date entered, the date mask will be
displayed in the prompt. If the system is able to interpret the date entered, the date will be displayed
in the prompt. Dates prior to 01/01/1800 or after 12/31/2199 are not allowed during date entry.

FACTS programs contain 8-character and 10-character date fields. The date editing/entry display
varies slightly depending on whether it is an 8-character or 10-character field. When editing a date,
using the right arrow or the END key, will advance the cursor to the end of the date field and using
the left arrow or the HOME key, will advance the cursor to the beginning of the date field.

8-Character Date Field 10-Character Date Field
When entering a date in the 1900s
(as defined by the 50-rule), the date
will be displayed as follows: ORDERED 01/02/96< ORDERED 01/02/96 <

Use the right arrow key or the END
key to display the full 4-digit year:
ORDERED /02/1996< ORDERED 01/02/1996<
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A plus sign at the end of the date
field indicates that the year is not in
the default century. ORDERED 01/02/96+ ORDERED 01/02/2096<

3.

Order - In various reports, payment selection and transfer/change codes, the order choice may

be selected. The options are by V-vendor number, A-alpha sort or C-vendor class. For example, the
user may want to print in vendor class order. CR defaults to V.

4.
(C) was selected above, the user selects the beginning vendor class to process. CR defaults to FIRST
(the first vendor class on file).

Beginning Order Choice - Enter the beginning order choice to be selected, e.g., if vendor class

Ending Order Choice - Enter the ending order choice to be selected, e.g., if vendor class (C) was

selected above, the user selects the ending vendor class to process. CR defaults to LAST (the last

vendor class on file).

Prompt-Selection Input - This refers to the flashing cursor usually found in the lower right hand

corner of a screen. This prompt allows the user to perform a number of functions:

# - Changes a line-item. Line-items may be changed or deleted by entering the corresponding
line number. During this change routine, F1 allows the currently displayed value to remain the
same.

L - Lists line-items. A limited number of line-items appear on the screen at any one time. The
list function allows line-items to be redisplayed. The user selects the beginning line number to
list.

A - Adds aline-item. Line-items may be added as needed.

D - Deletes the document/adjustment. The document/adjustment may be deleted at any time.
The screen is cleared and the program returns to the vendor number input to await further
entries.

F2 - Changes header. Header information in the upper portion of the screen may be changed as
necessary. During this change routine, F1 allows the currently displayed value to remain the
same.
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F3 - Accesses the ending routine. F3 ends entry of the document which clears the screen of the
information just entered and returns to the vendor number input to await further entries.

7.  Searches - Search features allow you to search for various fields (example: salesperson/ territory)
when little or no information is known about them. The search displays in a separate screen. The
user may enter a search key, continue to view the search fields, select the line number of one of the
fields displayed, or return to the program input.

8. Vendor Search - Vendor information can be searched alphabetically, as well as by contact name
and vendor number. To switch between search orders, press F2 and select one of the options from the
popup window that appears.

Press F1 to restrict a search by class, keyword or the first several characters of the vendor number.
(These restrictions appear in the program as Class, Keyword, Vendor # Starts With.)

LINE #+W TO DISPLAY WAREHOUSE QUANTITIES

F2-CHANGE SEARCH ORDER: ALPHA. IWTERCHANGE, ITEM MUMBER, CLASS

ENITER BEG ALFHA. F1-3ET RESTRICTIONS, F3-ALT SHCH, F4-BKUP ....................
ARBOMS = UP=PREEUIOUS. DOMMN=MERT. LEFT=FGUF. RIGHT=PGIM

Search shortcuts. As shown in the graphic above, search order and restrictions are represented by
bold, underlined letters. If you combine these letters at the entry prompt with first several characters
of the item you are searching for, followed by F1 or F2, you can reduce the number of steps it takes to
switch search orders or set restrictions. In a vendor search, for example, you can find vendors with
contacts named Ellis by entering CK.Ellis at the entry prompt and then press F1 or F2. Following are
more examples of search shortcuts.

If you want to... Then...
Switch to an Item Number search Enter N plus F2
Switch to an Item Number search and begin your search at Enter N.I310 plus F2

entries starting with 1310

Switch to an Alpha search order and set a keyword restriction | Enter AK.ladder plus F1 or F2
of ladder

9. Sync - Sync is a method of connecting information entered in Sales Orders with information
displayed in customer, item and vendor inquiries. Itis a very useful tool if you are using any form of
windowing because you can quickly switch from Sales Orders to the inquiries that have been
connected.
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NOTE: Sync is used in inquiries to Sales Order Entry is based on user code. This means that if
you logged into FACTS in one window under one name and signed into another window under
another name, it will appear as if the Sync function is not working.

Sync can be initiated or disabled by pressing F1 from the following screens:
e SO Customer Inquiry SOI610
e AP Vendor Inquiry API610
¢ AR Customer Inquiry ARI610

¢ ICItem Inquiry ICI610

While in Sync mode, the inquiry program will examine a file called SMUSED approximately
every three seconds. This file contains the last customer number, item number and vendor
number input in Sales Order Entry. If this number is different than the one currently being
displayed in the inquiry, the inquiry will change its display to show information on this new
customer, item or vendor.
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Branch - Branch number is used throughout the FACTS system. Branches may be referred to as
stores or profit centers, divisions within an organization. The system will default various branch
prompts to the branch set up in System Management Terminal F/M for each user. The posting
tables for each module may be set up so that the branch number is automatically inserted into the
General Ledger Account number when the system creates its journal entries. Inquiries and reports
may be run by branch.

Department - GL departments are used to track revenues and expenses by division. The GL
department is imbedded in the G/L number for posting purposes. General Ledger financial reports
may be printed by department.

Document Groups - Optionally, vendors may be assigned a document group. The most common use
of the document group is to flag vendors receiving 1099’s with a specific group number for printing
1099’s. Various AP reports allow the user to print the report for selected document groups.

G/L # (General Ledger account number) - G/L numbers are set up through the GL Account F/M
program. GL account numbers are user-defined and are used throughout the FACTS system for
posting purposes to GL.

Journal Number - Journal numbers are used for separating journal entries in GL by type of entry
(example: sales, payroll, receivables, etc.). Each module determines the journal number to post the
transactions of that module to in general ledger.

Ledgercards - Vendor ledgercards provide a detail history of every transaction for a vendor (i.e., any
invoices entered, checks written). Each vendor in the vendor file has a choice of whether to store
ledgercards. Ledgercards include information for each transaction such as the date, transaction type
and debit or credit amount. Ledgercard information is available for display through the Vendor
Inquiry and may be printed through the Vendor Ledgercards print. Ledgercards may be removed
through the Vendor Ledgercard Removal program.

Manual Checks - The AP Manual Check entry program allows the user to enter and record manual
checks that have been written against a payable that is currently in the open payables file.

Noninvoice Checks - The AP Noninvoice Check entry program allows the user to pay a document
that is not in the open payables file. This entry program allows for the document to be entered,
expensed and the payment recorded in one process. Recording COD payments are the most
common use of this program.

Temporary Item Lead Time - Lead time is the number of days from the date a purchase order is
placed for an item until the date the item is received. Lead time data for stocked items is maintained
by the system; the temporary lead time prompt provides the capability of manually providing lead
time information for temporary items used in Blanket Sales Order entry.

Permanent/Temporary Vendors - The system allows flagging each vendor as permanent or
temporary so that the AP Vendor file can be routinely purged of unnecessary records. At the end of
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B-2

the period, if the vendor has a zero balance and has been flagged Temporary, the vendor will be
removed from the system.

Recurring Documents - Documents that are paid repetitively such as rent or loan payments can be
set up once in the Recurring Document system specifying the amount of the payable, the dates to
post the associated invoice and a predetermined cutoff date.

Sequence Number - Sequence number is the numbering scheme (from 01 to 99) used on recurring
AP documents. The use of sequence numbers allows multiple recurring payable documents to be
entered for each vendor.

Terms Code - Terms codes are created and maintained through Account Payable Terms Code F/M
and Accounts Receivable Terms Code F/M. Terms codes are used in calculating invoice due dates,

and discount information.

Vendor Class - Vendor classes are used as a way of categorizing groups of vendors. A GL table is
associated with each class. This GL table will be used as a default entry when using Vendor F/M.
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APPENDIX C: SAMPLE REPORTS

PROGRAM NAME

FACTS AP

APR110
APR112
APR120
APR210
APR220
APR310
APR310
APR310
APR312
APR710
APR720
APR730
APR740
APR750
APR750
APR755
APP710
APP720
APR760
APR770
APP730
APR810
APR820
APR830
APR840
APR850

Document Entry & Adjustment Register
Document Entry Register G/L Distribution

Recurring Document Listing
Payment Selection List
Hold List

Sample Accounts Payable Check Printout

Accounts Payable Check Register
Noninvoice Check Register

Accounts Payable Check Register G/L Distribution

Cash Requirements Report

Open Payables Report

Aged Payables Report

Inactive Vendor Listing

Vendor Listing - General Information
Vendor Listing - History Information
Vendor Ledgercards

Vendor Label Print

Rolodex Vendor Card Print

Purchase History Report

Payment History Report

1099 Print

Period Check Register

Period Expense Distribution

Period Disbursement Distribution
Register History Report

Document Removal Register

PAGE

C-2
C-3

C-5
C-6

C-8

C-9

C-10
C-12
C-13
C-14
C-15
C-16
C-17
C-18
C-19
C-20
C-21
C-22
C-23
C-24
C-25
C-26
Cc-27
C-28
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Document Entry Register
DATE: 09/28/09
USER: SSI ToX

PERIOD 09/09 SEP

DEMO COMPANY

DOCUMENT ENTRY & ADJ REGISTER #1512

Sample Reports

APR110 PAGE:

1

TIME: 8:53 AM

BRANCH 01

GL  mmmmmmm——— DATE-—-———————- GROSS ALLOWABLE ----GL DISTRIBUTION-—-—--
VENDOR NAME DOCUMENT BR TBL PO# ENTRY DUE DISCOUNT AMOUNT DISCOUNT G/L# AMOUNT

Document Entries
V103 OFFICE PRODUCTS IN 13589 01 001 004985 09/28/09 10/28/09 10/08/09 126.11 1.26 620-01-1 120.11
540-01-1 6.00
V111 ATLANTA GAS COMPAN 321981 01 002 000065 09/28/09 10/08/09 10/08/09 259.93 .00 790-01-1 247 .55
540-01-1 12.38
V118 GEORGIA INSURANCE 321981 01 004 015651 09/28/09 10/28/09 10/28/09 208.83 .00 780-01-1 198.89
540-01-1 9.94
V122 PREMIUM INSURANCE 321918 01 004 000654 09/27/09 10/27/09 09/27/09 744 .99 .00 750-01-1 709.51
540-01-1 35.48

DOCUMENT TOTAL 1339.86 1.26

BEGINNING AP BALANCE
ENTRYc TOTAL
ADJUSTMENT TOTAL
ENDING AP BALANCE

DOCUMENTS: 4

44696.38
1339.86

.00

46036.24

END OF REGISTER

FACTS AP



Accounts Payable—7.7

Document Entry Register GL Distribution

DATE: 09/28/09

DEMO COMPANY

Sample Reports

APR110 PAGE: 1

USER: SSI ToX AP ENTRY REGISTER GL DISTRIBUTION #1512 TIME: 8:53 AM
GL PERIOD 09/09 SEP
G/L# DESCRIPTION VENDOR NAME DOCUMENT DEBIT CREDIT NET
310-01-0 ACCOUNTS PAYABLE V103 OFFICE PRODUCTS INTERNATIO 13589 126.11
V111l ATLANTA GAS COMPANY 321981 259.93
V118 GEORGIA INSURANCE SERVICES 321981 208.83
V122 PREMIUM INSURANCE COMPANY 321918 744 .99
ACCOUNT TOTAL .00 1339.86 (1339.86)
540-01-1 SALES TAX V103 OFFICE PRODUCTS INTERNATIO 13589 6.00
V111l ATLANTA GAS COMPANY 321981 12.38
V118 GEORGIA INSURANCE SERVICES 321981 9.94
V122 PREMIUM INSURANCE COMPANY 321918 35.48
ACCOUNT TOTAL 63.80 00 63.80
620-01-1 OFFICE EXPENSE V103 OFFICE PRODUCTS INTERNATIO 13589 120.11
ACCOUNT TOTAL 120.11 00 120.11
750-01-1 INSURANCE EXPENSE V122 PREMIUM INSURANCE COMPANY 321918 709.51
ACCOUNT TOTAL 709.51 00 709.51
780-01-1 LEGAL & PROFESSIONAL V118 GEORGIA INSURANCE SERVICES 321981 198.89
ACCOUNT TOTAL 198.89 00 198.89
790-01-1 UTILITIES V111 ATLANTA GAS COMPANY 321981 247 .55
ACCOUNT TOTAL 247.55 00 247 .55
REPORT TOTAL 1339.86 1339.86 .00

ACCOUNTS: 6

FACTS AP

END OF GL DISTRIBUTION

C-3



Accounts Payable—7.7 Sample Reports

Recurring Document Listing
DATE: 09/28/09 DEMO COMPANY APR120 PAGE: 1
USER: SSI ToX RECURRING DOCUMENT LISTING TIME: 8:58 AM

VENDOR FIRST TO LAST
ALL DOCUMENTS, DATE 09/20/09-09/28/09
CURRENT PERIOD 09/09

DOC  GL POST ----DOCUMENT AMOUNT---- CUT ---TO DATE----
SQ GRP TBL TC BRANCH PO# DAY MONTHS STANDARD THIS PD OFF # AMOUNT MEMO STATUS
Vendor V103 OFFICE PRODUCTS INTERNATIONAL
01 02 001 30 O1 325624 10 010203040506070809101112 314.42 314.42 N 2 1257.66 COMPUTER MAINTENANCE u
02 02 001 30 02 623452 10 010203040506070809101112 155.96 155.96 N 2 623.84 COMPUTER MAINTENANCE U
Vendor V118 GEORGIA INSURANCE SERVICES
01 02 004 30 01 345634 10 010203040506070809101112 395.89 395.89 N 2 791.78 INSURANCE PREMIUMS U
02 02 004 30 02 672354 10 010203040506070809101112 197.98 197.98 N 2 395.96 INSURANCE PREMIUMS u

SQ=SEQUENCE NUMBER, TC=TERMS CODE, CUTOFF BASIS: A=AMOUNT, D=DATE, N=NUMBER OF PAYMENTS
STATUS: U=UNEXPIRED, P=POST THIS PERIOD, C=COMPLETED THIS PERIOD, E=EXPIRED, *=UNABLE TO POST

DOCUMENTS: 4 END OF REPORT
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Payment Selection List
DATE: 09/28/09
USER: SSI ToX

ALPHA FIRST TO LAST

DEMO COMPANY
PAYMENT SELECTION LIST

Sample Reports

APR210 PAGE: 1
TIME: 8:59 AM

BRANCH 01

DOC —--————mm - DATE——————mmmmm —mm CURRENT DOCUMENT--- ————-—-- PAYMENT-—-———--

VENDOR NAME DOCUMENT GRP  ENTRY DUE  DISCOUNT AMOUNT ~ DISCOUNT AMOUNT ~ DISCOUNT
V100 GENERAL INDUSTRIAL MFG 1345 01 09/10/09 09/30/09 09/10/09 88.88 1.77 88.88 00~
VENDOR TOTAL 88.88 .00

V110 GEORGIA SHIPPING EQUIP. CO. 1325 01 08/29/09 09/28/09 08/29/09 1908.68 .00 1908.68 00~
VENDOR TOTAL  1908.68 .00

V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1335 01 09/03/09 10/03/09 09/13/09 1301.79 11.52 1301.79 00~
VENDOR TOTAL  1301.79 .00

V107 LIGHTNING COURIER SERVICE 14825 02 09/24/09 10/04/09 09/24/09 8.55 .00 8.55 00~
4512368753 02 09/14/09 09/24/09 09/24/09 34.78 .00 34.78 00*

VENDOR TOTAL 43.33 .00

V114 LINDA"S FLOWER SHOP 1254589365 02 09/21/09 10/20/09 10/10/09 219.64 .00 219.64 00*
VENDOR TOTAL  219.64 .00

V115 NATIONAL CONVEYORS, INC. 1357 01 09/17/09 09/30/09 09/10/09 181.39 3.33 181.39 00*
VENDOR TOTAL  181.39 .00

V122 PREMIUM INSURANCE COMPANY 08198198 02 08/31/09 09/30/09 08/31/09 197.98 .00 197.98 00*
VENDOR TOTAL  197.98 .00

V102 S.E. INDUSTRIAL PROD. & EQUIP. 1340 01 09/04/09 10/04/09 09/04/09 2948.59 .00 2948.59 00*
VENDOR TOTAL  2048.59 .00

V116 WORLD MATERIALS HANDLING CO. 1351 01 09/13/09 09/30/09 09/10/09 238.42 4.77 238.42 00*
VENDOR TOTAL  238.42 .00

REPORT TOTAL  7128.70 .00

DOCUMENTS: 10 END OF REPORT
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Hold List
DATE: 09/28/09

DEMO COMPANY

Sample Reports

APR220 PAGE: 1

USER: SSI ToX HOLD LIST TIME: 9:01 AM
ALPHA FIRST TO LAST
BRANCH 01
DOC —--————mm - DATE-———————— -
VENDOR NAME DOCUMENT GRP  ENTRY DUE  DISCOUNT AMOUNT ~ DISCOUNT HOLD MEMO
V110 GEORGIA SHIPPING EQUIP. CO. 1350 01 09/12/09 10/12/09 09/12/09 230.40 .00 DISPUTE RE: DAMAGE
VENDOR TOTAL 230.40 00
V119 INDUSTRIAL CHEMICALS INC. 1343 01 09/09/09 10/30/09 10/10/09 1342.54 25.85 APPARENT OVERCHARGE
VENDOR TOTAL 1342_54 25.85
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1356 01 09/17/09 10/17/09 09/17/09 269.34 .00 ALLOWANCE FOR DEFECT
VENDOR TOTAL 269.34 00
REPORT TOTAL 1842.28 25.85

DOCUMENTS: 3

END OF REPORT
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Sample Check Printout

V122 PREMIUM INSURANCE COMPANY

09/28/09 003100 1
08/31/09 98198198 197.98 .00 197.98
197.98 .00 197.98

003100 09/28/09

ONE HUNDRED NINETY SEVEN AND 98/100 DOLLARS FHXXX]197.98

PREMIUM INSURANCE COMPANY
9272 CROGAN STREET

ATLANTA, GA 30309
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AP Check Register
DATE: 09/28/09
USER: SSI ToX

REGISTER DATE: 09/28/09

DEMO COMPANY

AP CHECK REGISTER #0353

BANK 01 FIRST NATIONAL BANK OF ATLANTA

PERIOD 09709 SEP

Sample Reports

APR310 PAGE: 1
TIME: 9:05 AM

-——-DATE--- DISCOUNT
CHECK  DATE AMOUNT VENDOR NAME DOCUMENT ENTRY DUE PAYMENT TAKEN MEMO
REGULAR CHECKS
003071 09/28/09 1301.79 V101 INDUSTRIAL SUPPLY DIS 1335 09703 10/03 1301.79 .00
003072 09/28/09 2948.59 V102 S.E. INDUSTRIAL PROD. 1340 09704 10/04 2948.59 .00
003074 09/28/09 1908.68 V110 GEORGIA SHIPPING EQUI 1325 08/29 09/28 1908.68 .00
003075 09/28/09 219.64 V114 LINDA"S FLOWER SHOP 1254589365 09/21 10/20 219.64 .00 WEDDING ARR. FOR MR. THRY
003077 09/28/09 238.42 V116 WORLD MATERIALS HANDL 1351 09713 09/30 238.42 .00
003078 09/28/09 .00 VOIDED - REPRINT CHECK
003100 09/28/09 197.98 V122 PREMIUM INSURANCE COM 98198198 08/31 09/30 197.98 .00
REGULAR CHECKS __;iéé_;é
MANUAL & VOID CHECKS
003066 09/21/09 -1251.91 V108 GEORGIA NEWSPAPER 681681 08/24 09/23 -600.13 .00
3457124114 08/25 09/24 -651.78 .00
041851 09/28/09 72.08 V100 GENERAL INDUSTRIAL MF 1364 09/17 10/30 72.08 1.47
MANUAL & VOIDS _zééé;_éé
REGISTER TOTAL __;1;1?11
CHECK REGISTER RECAP:
BEGINNING AP BALANCE 44696 .38
-PAYMENTS 4141.11
-DISCOUNTS 1.47
ENDING AP BALANCE __;6;;5?56
REGULAR, MANUAL, AND VOID CHECKS: 13

C-8
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Accounts Payable—7.7

AP Noninvoice Check Register

DATE: 09/28/09
USER: SSI ToX

DEMO COMPANY
AP NONINVOICE CHECK REGISTER #0353

Sample Reports

APR310 PAGE: 2
TIME: 9:05 AM

AMOUNT ~ DISCOUNT
CHECK  DATE AMOUNT VENDOR NAME DOCUMENT  DATE PAID TAKEN G/L# MEMO
041849 09/27/09 12.18 V107 LIGHTNING COURIER SERV 456813 09/27/09 12.18 .00 730-01-1 SERVICE CHARGE
041852 09/28/09 297.35 V113 ATLANTA CRANE & HOISTS 12512411 09/28/09 297.35 .00 175-01-0
REGISTER TOTAL ___éaéjéé
NONINVOICE CHECKS: 2 END OF REGISTER

FACTS AP



Accounts Payable—7.7 Sample Reports

AP Check Register GL Distribution
DATE: 09/28/09 DEMO COMPANY APR310 PAGE: 1
USER: SSI ToX AP CHECK REGISTER GL DISTRIBUTION #0353 TIME: 9:05 AM

GL PERIOD 09/09 SEP

G/L# DESCRIPTION VENDOR NAME CHECK DOCUMENT DEBIT CREDIT NET
100-01-0 CASH V100 GENERAL INDUSTRIAL MF 003070 1345 88.88
041851 1364 72.08
V101 INDUSTRIAL SUPPLY DIS 003071 1335 1301.79
V102 S.E. INDUSTRIAL PROD. 003046 1299 1833.81
003072 1340 2948.59
V107 LIGHTNING COURIER SER 003073 14825 8.55
003073 4512368753 34.78
041849 456813 12.18
041850 1145525896 26.05
V108 GEORGIA NEWSPAPER 003066 681681 600.13
003066 3457124114 651.78
V110 GEORGIA SHIPPING EQUI 003074 1325 1908.68
V113 ATLANTA CRANE & HOIST 041852 12512411 297.35
V114 LINDA"S FLOWER SHOP 003075 1254589365 219.64
V115 NATIONAL CONVEYORS, 1 003076 1357 181.39
V116 WORLD MATERIALS HANDL 003077 1351 238.42
V122 PREMIUM INSURANCE COM 003100 98198198 197.98
ACCOUNT TOTAL 3085.72 7536.36 (4450.64)
175-01-0 INVENTORY V113 ATLANTA CRANE & HOIST 041852 12512411 297.35
ACCOUNT TOTAL 297.35 .00 297.35
310-01-0 ACCOUNTS PAYABLE V100 GENERAL INDUSTRIAL MF 003070 1345 88.88
041851 1364 73.55
V101 INDUSTRIAL SUPPLY DIS 003071 1335 1301.79
V102 S.E. INDUSTRIAL PROD. 003046 1299 1833.81
003072 1340 2948.59
V107 LIGHTNING COURIER SER 003073 14825 8.55
003073 4512368753 34.78
041850 1145525896 26.05
V108 GEORGIA NEWSPAPER 003066 681681 600.13
003066 3457124114 651.78
V110 GEORGIA SHIPPING EQUI 003074 1325 1908.68
V114 LINDA"S FLOWER SHOP 003075 1254589365 219.64
V115 NATIONAL CONVEYORS, I 003076 1357 181.39
V116 WORLD MATERIALS HANDL 003077 1351 238.42
V122 PREMIUM INSURANCE COM 003100 98198198 197.98
ACCOUNT TOTAL 7228.30 3085.72 4142 .58

c-10 FACTS AP



Accounts Payable—7.7 Sample Reports

AP Check Register GL Distribution (cont’'d)

490-01-1 DISCOUNTS TAKEN V100 GENERAL INDUSTRIAL MF 041851 1364 1.47
ACCOUNT TOTAL .00 147 (.47)
730-01-1 POSTAL EXPENSE V107 LIGHTNING COURIER SER 041849 456813 12.18
ACCOUNT TOTAL 1218 .00 12.18
DATE: 09/28/09 DEMO COMPANY APR310 PAGE: 2
USER: SSI ToX AP CHECK REGISTER GL DISTRIBUTION #0353 TIME: 9:05 AM
G/L# DESCRIPTION VENDOR NAME CHECK DOCUMENT DEBIT CREDIT NET
REPORT TOTAL  10623.55  10623.55 .00
ACCOUNTS: 5 END OF GL DISTRIBUTION

FACTS AP C-11



Accounts Payable—7.7

Cash Requirements Report

DATE: 09/28/09
USER: SSI ToX

ALPHA FIRST TO LAST
HOLDS INCLUDED
BRANCH 01; BASED ON DUE DATE

DEMO COMPANY
CASH REQUIREMENTS REPORT

Al
T

Sample Reports

PR710 PAGE: 1
IME: 9:09 AM

——————————————————————————————————— DATES-===——— e e

VENDOR NAME BALANCE  THRU 09/28 09/29-10/05 10/06-10/12 10/13-10/19 10/20-10/26 10/27-11/09
V117 D"ANCONIA COPPER AND ELECTRIC 982.33 .00 .00 .00 982.33 .00 .00
V109 FIRST BANK OF THE SOUTH 160.77 .00 .00 .00 160.77 .00 .00
V100 GENERAL INDUSTRIAL MFG 1193.43 .00 88.88 .00 .00 .00 1104.55
V118 GEORGIA INSURANCE SERVICES 1050.00 .00 .00 .00 .00 1050.00 .00
V108 GEORGIA NEWSPAPER 373.37 .00 .00 .00 347.12 26.25 .00
V110 GEORGIA SHIPPING EQUIP. CO. 4319.57 1908.68 .00 2065.54 345.35 .00 .00
V112 GRANDE HOTEL 959.21 .00 .00 .00 420.43 538.78 .00
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1819.06 .00 1301.79 .00 517.27 .00 .00
V119 INDUSTRIAL CHEMICALS INC. 3732.98 .00 .00 .00 .00 .00 3732.98
V107 LIGHTNING COURIER SERVICE 43.33 34.78 8.55 .00 .00 .00 .00
V114 LINDA"S FLOWER SHOP 219.64 .00 .00 .00 .00 219.64 .00
V115 NATIONAL CONVEYORS, INC. 362.78 .00 181.39 .00 .00 .00 181.39
V103 OFFICE PRODUCTS INTERNATIONAL 297.92 .00 .00 .00 127.82 170.10 .00
V122 PREMIUM INSURANCE COMPANY 279.09 .00 197.98 81.11 .00 .00 .00
V104 REARDEN METALS, INC. 171.43 .00 .00 68.11 103.32 .00 .00
V102 S.E. INDUSTRIAL PROD. & EQUIP. 3217.93 .00 2948.59 .00 269.34 .00 .00
V106 SANITATION SERVICES, INC. 332.27 .00 .00 .00 332.27 .00 .00
V121 SOUTHERN ELECTRIC COMPANY 2288.63 .00 .00 .00 .00 2288.63 .00
V105 WAREHOUSE EQUIPMENT UNLIMITED 3272.47 .00 .00 3272.47 .00 .00 .00
V116 WORLD MATERIALS HANDLING CO. 2724.92 .00 238.42 .00 .00 .00 2486.50
REPORT TOTAL 27801.13 1943.46 4965.60 5487.23 3606.02 4293.40 7505.42

VENDORS: 20

C-12

END OF REPORT

FACTS AP



Accounts Payable—7.7

Open Payables Report

DATE: 09/28/09

DEMO COMPANY

APR720 PAGE: 3

USER: SSI ToX OPEN PAYABLES REPORT TIME: 9:11 AM
DOC ----- ENTRY--—= ——————- ORIGINAL-——————- TRANSACTION CURRENT

VENDOR NAME DOCUMENT GRP PD DATE AMOUNT DISCOUNT TOTAL BALANCE
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1340 01 09709 09704709 2948.59 .00 .00 2948.59
1356 01 09709 09/17/09 269.34 .00 .00 269.34

VENDOR TOTAL 3217.93

V106 SANITATION SERVICES, INC. 4516218732 03 09/09 09/14/09 332.27 .00 .00 332.27
5246256235 03 08/09 08/10/09 737.22 .00 737.22 .00

7456323563 03 08/09 08/11/09 1104.72 .00 1104.72 .00

VENDOR TOTAL 332.27

V121 SOUTHERN ELECTRIC COMPANY 13461346 03 08/09 08/10/09 182.56 .00 182.56 .00
98465654 03 09/09 09/25/09 2288.63 .00 .00 2288.63

5253856969 03 08/09 08/11/09 182.56 .00 182.56 .00

VENDOR TOTAL 2288.63

REPORT TOTAL 21803.74

OPEN DOCUMENTS: 57

FACTS AP

END OF REPORT

Sample Reports
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Accounts Payable—7.7

Aged Payables Report

DATE: 09/28/09
USER: SSI

ToX

ALPHA FIRST TO V108
AGING DATE 09/28/09
INCLUDING NEXT PERIOD

DEMO COMPANY
AGED PAYABLES REPORT

APR730 PAGE: 1
TIME: 9:13 AM

BRANCH 01
LAST = = e AGING- ===
VENDOR NAME PAYMENT BALANCE CURRENT 1-30 31-60 61-90 OVER 90
V117 D"ANCONIA COPPER AND 09/09/09 982.33 982.33 .00 .00 .00 .00
V109 FIRST BANK OF THE SOU 09/09/09 160.77 160.77 .00 .00 .00 .00
V100 GENERAL INDUSTRIAL MF 09/09/09 1193.43 1193.43 .00 .00 .00 .00
V118 GEORGIA INSURANCE SER 09/09/09 1050.00 1050.00 .00 .00 .00 .00
V108 GEORGIA NEWSPAPER 09/21/09 373.37 373.37 .00 .00 .00 .00
V110 GEORGIA SHIPPING EQUI 09/21/09 4319.57 4319.57 .00 .00 .00 .00
V112 GRANDE HOTEL 09/14/09 959.21 959.21 .00 .00 .00 .00
V101 INDUSTRIAL SUPPLY DIS 09/21/09 1819.06 1819.06 .00 .00 .00 .00
V119 INDUSTRIAL CHEMICALS 08/24/09 3732.98 3732.98 .00 .00 .00 .00
V107 LIGHTNING COURIER SER 09/21/09 43.33 8.55 34.78 .00 .00 .00
V114 LINDA®"S FLOWER SHOP  09/14/09 219.64 219.64 .00 .00 .00 .00
V115 NATIONAL CONVEYORS, 1 09/09/09 362.78 362.78 .00 .00 .00 .00
V103 OFFICE PRODUCTS INTER 09/09/09 297.92 297.92 .00 .00 .00 .00
V122 PREMIUM INSURANCE COM 09/14/09 279.09 279.09 .00 .00 .00 .00
V104 REARDEN METALS, INC. 09/09/09 171.43 171.43 .00 .00 .00 .00
V102 S.E. INDUSTRIAL PROD. 09/21/09 3217.93 3217.93 .00 .00 .00 .00
V106 SANITATION SERVICES, 09/09/09 332.27 332.27 .00 .00 .00 .00
V121 SOUTHERN ELECTRIC COM 09/09/09 2288.63 2288.63 .00 .00 .00 .00
REPORT TOTAL 21803.74 21768.96 34.78 .00 00 00
VENDORS: 18 END OF REPORT
C-14

Sample Reports

FACTS AP



Accounts Payable—7.7

Inactive Vendor Listing

DATE: 09/28/09
USER: SSI ToX

ALPHA FIRST TO LAST
YTD PURCHASES LESS THAN $ 5000.00

DEMO COMPANY
INACTIVE VENDOR LISTING

Al
T

Sample Reports

PR740 PAGE: 1
IME: 9:14 AM

DOC  DATE LAST LAST  ---HIGHEST BALANCE-- CURRENT ———————- PURCHASES--------

VENDOR NAME CLASS GRP OPENED PURCHASE PAYMENT  DATE AMOUNT BALANCE YTD PYR
V109 FIRST BANK OF THE SOUTH C&T 02 04/15/09 09/14/09 09/09/09 08/04/09 490.83 221.21 3745.48 4322.72

V107 LIGHTNING COURIER SERVICE MIS 02 12/20/09 09/24/09 09/21/09 08/17/09 887.54 69.38 4340.17 5006.75

V114 LINDA®"S FLOWER SHOP MIS 02 03/24/09 09/21/09 09/14/09 09/21/09 406.69 406.69 879.59 543.45

V122 PREMIUM INSURANCE COMPANY INS 02 12/05/09 09/25/09 09/14/09 09/09/09 533.88 491.88 2273.65 2936.41

V104 REARDEN METALS, INC. MIS 02 01/12/09 09/14/09 09/09/09 08/04/09 295.36 206.27 2325.26 2771.41
VENDORS: 5 END OF REPORT

FACTS AP
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Accounts Payable—7.7 Sample Reports

Vendor Listing - General

DATE: 09/28/09 DEMO COMPANY APR750 PAGE: 3
USER: SSI ToX VENDOR LISTING - GENERAL INFO TIME: 9:17 AM
DoC GL OUR TAX
VENDOR NAME ALPHA CLASS TERMS GRP  TBL HOLD P/T CUSTOMER # EXEMPT #
V103 OFFICE PRODUCTS INTERNATIONAL OFFICE PRO  OFF 30 02 001 NO P D9400-1

45121 NORTH DECATUR AVE.
ATLANTA, GA 30339

404-874-9334 /
MORGAN KING
V122 PREMIUM INSURANCE COMPANY PREMIUM IN INS 30 02 004 NO P S900339

9272 CROGAN STREET
ATLANTA, GA 30309
404-223-9214 /
ROBERT FLETCHER
SYLVIA ROBINSON

V104 REARDEN METALS, INC. REARDEN ME  MIS 30 02 MIS NO P 3409 458909
34 NORTH BUFORD STREET
ATLANTA, GA 30309
404-991-8358 /
HANK REARDEN
GREG PAGANSON

V102 S.E. INDUSTRIAL PROD. & EQUIP. S.E. INDUS INV 30 01 005 NO P D3433 11944876
11908 N.E. EXPRESSWAY
ATLANTA, GA 30321

404-321-0944 /
JERRY CLARK
VICTOR
V106 SANITATION SERVICES, INC. SANITATION UTL 30 03 002 NO P L89032

9292 HURRICANE SHOALS
LAWRENCEVILLE, GA 30240
404-963-5333 /
JIMMY LARSON

V121 SOUTHERN ELECTRIC COMPANY SOUTHERN E UTL 30 03 002 NO P
219 CLAYTON STREET
LAWRENCEVILLE, GA 30248
404-968-9776 /
MARIAN HOWARD
DOC=DOCUMENT, P/T=PERMANENT OR TEMPORARY

VENDORS: 20 END OF REPORT

C-16 FACTS AP



Accounts Pay

Vendor Listing - History Information

able—7.7

DATE: 09/28/09 DEMO COMPANY APR750 PAGE: 1
USER: SSI ToX VENDOR LISTING - HISTORY INFO TIME: 9:18 AM
ALPHA FIRST TO LAST
DATE LAST LAST  ---HIGHEST BALANCE---
VENDOR NAME BALANCE OPENED INVOICE PAYMENT  DATE AMOUNT HOLD
V113 ATLANTA CRANE & HOISTS .00 07/28/09 08/30/09 09/09/09 08/30/09 4243.29 NO
V111 ATLANTA GAS COMPANY 287.88 10/01/09 09/14/09 09/21/09 09/14/09 1390.92 NO
V117 D"ANCONIA COPPER AND ELECT 982.33 02709709 09/14/09 09/09/09 08/04/09 994.62 NO
V109 FIRST BANK OF THE SOUTH 221.21 04/15/09 09/14/09 09/09/09 08/04/09 490.83 NO
V100 GENERAL INDUSTRIAL MFG 2583.74 11/30/09 09/17/09 09/09/09 01/11/09 22114.72 NO
V118 GEORGIA INSURANCE SERVICES 2090.00 08/18/09 09/21/09 09/09/09 09/21/09 2090.00 NO
V108 GEORGIA NEWSPAPER 592.93 02/19/09 09/25/09 09/21/09 09/14/09 2428.87 NO
V110 GEORGIA SHIPPING EQUIP. CO 5205.92 11/30/09 09/19/09 09/21/09 08/16/09 33022.50 NO
V112 GRANDE HOTEL 959.21 03/25/09 09/21/09 09/14/09 09/14/09 5671.99 NO
V101 INDUSTRIAL SUPPLY DISTRIBU 2307.30 12/05/09 09/17/09 09/21/09 08/01/09 30302.03 NO
V119 INDUSTRIAL CHEMICALS INC. 3732.98 04/23/09 09/21/09 08/24/09 09/21/09 3732.98 NO
V107 LIGHTNING COURIER SERVICE 69.38 12/20/09 09/24/09 09/21/09 08/17/09 887.54 NO
V114 LINDA"S FLOWER SHOP 406.69 03/24/09 09/21/09 09/14/09 09/21/09 406.69 NO
V115 NATIONAL CONVEYORS, INC. 866.95 09/28/09 09/17/09 09/09/09 08/31/09 6044.81 NO
V103 OFFICE PRODUCTS INTERNATIO 764.39 09/14/09 09/25/09 09/09/09 08/10/09 940.75 NO
V122 PREMIUM INSURANCE COMPANY 491.88 12/05/09 09/25/09 09/14/09 09/09/09 533.88 NO
V104 REARDEN METALS, INC. 206.27 01/12/09 09/14/09 09/09/09 08/04/09 295.36 NO
V102 S.E. INDUSTRIAL PROD. & EQ 3217.93 07/18/09 09/17/09 09/21/09 01/11/09 21204.17 NO
V106 SANITATION SERVICES, INC. 553.46 07/06/09 09/14/09 09/09/09 08/10/09 2210.55 NO
V121 SOUTHERN ELECTRIC COMPANY 3093.15 07/06/09 09/25/09 09/09/09 09/25/09 3093.15 NO
V105 WAREHOUSE EQUIPMENT UNLIMI 9873.77 03/28/09 09/21/09 09/21/09 08/24/09 34345.07 NO
V120 WAREHOUSE INTERIORS, INC. 2727.24 05/13/09 09/14/09 09/21/09 01/11/09 29220.44 NO
V116 WORLD MATERIALS HANDLING C 3461.77 12/29/09 09/20/09 09/09/09 08/09/09 44258.19 NO
VENDORS: 23 END OF REPORT

FACTS AP

Sample Reports
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Accounts Payable—7.7

Vendor Ledgercards

DATE: 09/28/09
USER: SSI ToX

ALPHA FIRST TO V103
DATE FIRST TO LAST

DEMO

COMPANY

VENDOR LEDGERCARDS

APR755 PAGE: 1
TIME: 9:20 AM

VENDOR NAME DATE  TRANSACTION DEBIT CREDIT  DOCUMENT REG#
V100 GENERAL INDUSTRIAL MFG BEGIN BALANCE 2688.17
09/09/09 CHECK REGISTER -2688.17 1315 0347
09/09/09 DOC ENTRY REG 1212.75 1339 1507
09/14/09 DOC ENTRY REG 88.88 1345 1509
09714709 DOC ENTRY REG 177.56 1355 1509
09/21/09 DOC ENTRY REG 1031.20 1361 1510
09/25/09 DOC ENTRY REG 73.55 1364 1511
09/25/09 DOC ENTRY REG -.20 1361 1511
ENDING BALANCE 2583.74
V101 INDUSTRIAL SUPPLY DISTRIBUTORS BEGIN BALANCE 2020.11
09/09/09 CHECK REGISTER -292.04 6025611863 0347
09/09/09 DOC ENTRY REG 1301.79 1335 1506
09709709 DOC ENTRY REG 222.00 1338 1507
09709709 DOC ENTRY REG -100.00 2865187182 1507
09/14/09 DOC ENTRY REG 61.22 1349 1509
09/14/09 CHECK REGISTER -137.60 2865187182 0350
09/21/09 CHECK REGISTER -61.22 1349 0351
09721709 DOC ENTRY REG 517.27 1359 1510
09/27/09 VENDOR BALANCE -1271.78 0020
09/25/09 DOC ENTRY REG 47.55 1365 1511
ENDING BALANCE 2307.30
V103 OFFICE PRODUCTS INTERNATIONAL BEGIN BALANCE 940.75
09/09/09 CHECK REGISTER -628.83 90081001 0346
09/09/09 CHECK REGISTER -311.92 90081002 0347
09/14/09 DOC ENTRY REG 127.82 1010553494 1508
09/14/09 DOC ENTRY REG 78.15 1561878921 1508
09/14/09 DOC ENTRY REG 303.52 4512453269 1508
09/25/09 DOC ENTRY REG 170.10 489849 1511
09/25/09 DOC ENTRY REG 84.80 4984651 1511
ENDING BALANCE 764.39

VENDORS: 3

C-18

END OF REPORT

Sample Reports
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Accounts Payable—7.7

Vendor Label Print

GENERAL INDUSTRIAL MFG
9610 DUNWOODY PL

SUITE 133-134

ATLANTA, GA. 30338

REARDEN METALS, INC.
34 NORTH BUFORD STREET
ATLANTA, GA 30309

GEORGIA NEWSPAPER
P.0. BOX 88550
ATLANTA, GA 30337

GRANDE HOTEL
71 HWY 29 SOUTH
LILBURN, GA 30321

WORLD MATERIALS HANDLING CO.
2000 NORTH AVE
ATLANTA, GA 30309

WAREHOUSE INTERIORS, INC.
9537 BROOK INDUSTRIAL BLVD.
DALLAS, TX 75037

FACTS AP

INDUSTRIAL SUPPLY DISTRIBUTORS
19874 MOUNTAIN INDUSTRIAL PARK
ATLANTA, GA 30335

WAREHOUSE EQUIPMENT UNLIMITED
11598 GENERAL AVE.
DALLAS, TX 75022

FIRST BANK OF THE SOUTH
P.0. BOX 4998
ATLANTA, GA 30301

ATLANTA CRANE & HOISTS
147 S. DEKALB DRIVE
DORAVILLE, GA 30341

D"ANCONIA COPPER AND ELECTRIC
7125 CROGAN STREET
STONE MOUNTAIN, GA 30278

SOUTHERN ELECTRIC COMPANY
219 CLAYTON STREET
LAWRENCEVILLE, GA 30248

S.E. INDUSTRIAL PROD. & EQUIP.
11908 N.E. EXPRESSWAY
ATLANTA, GA 30321

SANITATION SERVICES, INC.
9292 HURRICANE SHOALS
LAWRENCEVILLE, GA 30240

GEORGIA SHIPPING EQUIP. CO.
3376 WASHINGTON AVE. S.E.
ATLANTA, GA. 30302

LINDA®S FLOWER SHOP
701 KILLIAN WAY
LILBURN, GA 30247

GEORGIA INSURANCE SERVICES
11321 STATE CAPITOL BLVD.
ATLANTA, GA 30301

PREMIUM INSURANCE COMPANY
9272 CROGAN STREET
ATLANTA, GA 30309

Sample Reports

OFFICE PRODUCTS INTERNATIONAL
45121 NORTH DECATUR AVE.
ATLANTA, GA 30339

LIGHTNING COURIER SERVICE
99 EAGLE LANDING DRIVE
MARIETTA, GA 30067

ATLANTA GAS COMPANY
P.0. BOX 31921
ATLANTA, GA 30321

NATIONAL CONVEYORS, INC.
3121 INDUSTRIAL PARK DRIVE
ATLANTA, GA 30312

INDUSTRIAL CHEMICALS INC.
12093 EAST MCEWEN
DALLAS, TX 75289
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Accounts Payable—7.7

Rolodex Vendor Card Print

ATLANTA CRANE & HOISTS
404-949-2100

147 S. DEKALB DRIVE

DORAVILLE, GA 30341

FRANK CARTER

class:

D*ANCONIA COPPER AND ELECTRI

404-631-9921
7125 CROGAN STREET
STONE MOUNTAIN, GA 30278

FRANSICO D"ANCONIA
OSCAR WASHINGTON
class:

GENERAL INDUSTRIAL MFG

404-393-9444
9610 DUNWOODY PL
SUITE 133-134
ATLANTA, GA 30338

ROGER SMITH

GLORIA FAYE
class:

C-20

ATLANTA GAS COMPANY V111
404-931-5556

P.0. BOX 31921

ATLANTA, GA 30321

JOAN BOZEMAN

class: UTL

FIRST BANK OF THE SOUTH V109
404-231-9921

P.0. BOX 4998

ATLANTA, GA 30301

RALPH MCMILLAN

class: C&T

GEORGIA INSURANCE SERVICES V118
404-261-1111

11321 STATE CAPITOL BLVD.

ATLANTA, GA 30301

RICHARD DICKSON

class: INS

Sample Reports

FACTS AP



Accounts Payable—7.7

Purchase History Report

Sample Reports

DATE: 09/28/09 DEMO COMPANY APR760 PAGE: 1

USER: SSI ToX PURCHASE HISTORY REPORT TIME: 9:24 AM
VENDOR FIRST TO LAST

DATE LAST LAST -—————m——- YEAR TO DATE------=——--= = PRIOR YEAR----—————————

VENDOR NAME OPENED PURCHASE PAYMENT  PURCHASES PAYMENTS DISCOUNTS PURCHASES PAYMENTS DISCOUNTS

V100 GENERAL INDUSTRIAL MF 11/30/09 09/17/09 09/09/09 78659.36 93187.49 5002.85 104206.00 102909.15 1296.85

V101 INDUSTRIAL SUPPLY DIS 12/05/09 09/17/09 09/21/09 80751.94 94791.58 10525.68 125688.00 123663.29 2024.71

V102 S.E. INDUSTRIAL PROD. 07/18/09 09/17/09 09/21/09 55380.80 67913.89 .00 76200.00 74450.36 .00

V103 OFFICE PRODUCTS INTER 09/14/09 09/25/09 09/09/09 7375.80 6555.26 56.15 14079.79 13803.72 276.07

V104 REARDEN METALS, INC. 01/12/09 09/14/09 09/09/09 2325.26 2065.87 53.12 2771.41 2771.41 .00

V105 WAREHOUSE EQUIPMENT U 03/28/09 09/21/09 09/21/09 163018.09 164282.62 .00 209726.00 208583.71 .00

V106 SANITATION SERVICES, 07/06/09 09/14/09 09/09/09 9532.34 8846.17 132.71 13465.94 13332.61 133.33

V107 LIGHTNING COURIER SER 12/20/09 09/24/09 09/21/09 4340.17 4308.50 .00 5006.75 5006.75 .00

V108 GEORGIA NEWSPAPER 02/19/09 09/25/09 09/21/09 8497.95 7729.02 176.00 11980.30 11861.68 118.62

V109 FIRST BANK OF THE SOU 04/15/09 09/14/09 09/09/09 3745.48 3435.92 88.35 4322.72 4237.96 84.76

V110 GEORGIA SHIPPING EQUI 11/30/09 09/19/09 09/21/09 105271.19 115100.47 .00 138219.00 137149.88 .00

V111 ATLANTA GAS COMPANY 10/01/09 09/14/09 09/21/09 6690.74 6363.39 39.47 7513.03 7365.72 147.31

V112 GRANDE HOTEL 03/25/09 09/21/09 09/14/09 22187.30 21070.06 158.03 26050.77 25792.84 257.93

V113 ATLANTA CRANE & HOIST 07/28/09 08/30/09 09/09/09 14811.90 15767.71 .00 19861.00 18038.86 .00

V114 LINDA"S FLOWER SHOP  03/24/09 09/21/09 09/14/09 879.59 516.55 6.67 543.45 538.07 5.38

V115 NATIONAL CONVEYORS, 1 09/28/09 09/17/09 09/09/09 17905.23 17762.96 3698.14 24581.00 23521.78 1059.22

V116 WORLD MATERIALS HANDL 12/29/09 09/20/09 09/09/09 140757.76 160949.45 19058.99 185321.00 183516.06 1804.94

V117 D"ANCONIA COPPER AND 02/09/09 09/14/09 09/09/09 8004.34 6962.33 59.68 11185.25 11185.25 .00

V118 GEORGIA INSURANCE SER 08/18/09 09/21/09 09/09/09 6282.48 4156.85 35.63 7518.51 7371.09 147 .42

V119 INDUSTRIAL CHEMICALS 04/23/09 09/21/09 08/24/09 11679.70 8929.78 -889.77 14233.00 12989.53 1243.47

V120 WAREHOUSE INTERIORS, 05/13/09 09/14/09 09/21/09 103244.31 117424.49 12313.02 146211.00 143905.07 2305.93

V121 SOUTHERN ELECTRIC COM 07/06/09 09/25/09 09/09/09 5325.66 2199.65 32.86 3273.29 3273.29 .00

V122 PREMIUM INSURANCE COM 12/05/09 09/25/09 09/14/09 2273.65 1781.77 .00 2936.41 2907.34 29.07

REPORT TOTAL  858941.04  932101.78 50547.58 1154893.62 1138175.42 10935.01

VENDORS: 23

FACTS AP

END OF REPORT

Cc-21



Accounts Payable—7.7 Sample Reports

Payment History Report

DATE: 09/28/09 DEMO COMPANY APR770 PAGE: 1
USER: SSI ToX PAYMENT HISTORY REPORT TIME: 9:25 AM

VENDOR FIRST TO LAST

VENDOR NAME 04/09 05709 06709 07/09 08709 09709 TOTAL
V100 GENERAL INDUSTRIAL MFG 9222.72 10269.25 11736.54 11655.25 31233.73 2634.41 76751.90
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 11870.74 9468.24 10320.11 8747.65 20601.22 15490.25 76498.21
V102 S.E. INDUSTRIAL PROD. & EQUIP. 5105.58 8207.85 8680.00 8784.55 11106.58 15109.46 56994.02
V103 OFFICE PRODUCTS INTERNATIONAL 1140.23 886.14 934.36 927.63 .00 940.75 4829.11
V104 REARDEN METALS, INC. 220.73 196.44 334.36 192.83 200.03 95.33 1239.72
V105 WAREHOUSE EQUIPMENT UNLIMITED 17098.18 21883.30 21766.02 21454.72 17627.68 28236.97 128066.87
V106 SANITATION SERVICES, INC. 1200.89 1130.13 1163.25 1201.01 .00 2210.55 6905.83
V107 LIGHTNING COURIER SERVICE 571.22 585.22 478.58 505.13 634.06 539.67 3313.88
V108 GEORGIA NEWSPAPER 854.52 1719.99 917.11 881.37 .00 1862.19 6235.18
V109 FIRST BANK OF THE SOUTH 208.73 481.65 181.61 228.45 327.22 163.61 1591.27
V110 GEORGIA SHIPPING EQUIP. CO. 10962.22 13591.36 13668.88 12898.57 18658.24 22144 .31 91923.58
V111 ATLANTA GAS COMPANY 799.00 491.80 666.04 746.40 877.12 1538.87 5119.23
V112 GRANDE HOTEL 1189.32 5529.32 2593.94 3844.95 15.87 5251.56 18424.96
V113 ATLANTA CRANE & HOISTS 1787.61 1798.54 1808.48 1877.83 703.59 4243.29 12219.34
V114 LINDA"S FLOWER SHOP 60.08 58.55 60.60 36.15 71.03 112.04 398.45
V115 NATIONAL CONVEYORS, INC. 1986.41 1996.35 1683.24 1755.51 548.11 6012.37 13981.99
V116 WORLD MATERIALS HANDLING CO. 15560.47 15863.65 16530.61 16502.35 54720.23 10270.49 129447.80
V117 D"ANCONIA COPPER AND ELECTRIC 1071.20 1296.53 844.30 891.05 664.13 330.49 5097.70
V118 GEORGIA INSURANCE SERVICES 686.50 687.50 63.98 751.00 .00 593.87 2782.85
V119 INDUSTRIAL CHEMICALS INC. 1725.97 1818.42 1767.73 1725.05 1166.20 .00 8203.37
V120 WAREHOUSE INTERIORS, INC. 12908.48 12393.59 13476.05 12955.77 21473.64 21512.22 94719.75
V121 SOUTHERN ELECTRIC COMPANY 271.24 252.37 295.39 330.78 .00 556.48 1706.26
V122 PREMIUM INSURANCE COMPANY 280.50 281.50 9.98 291.54 237.50 118.75 1219.77

REPORT TOTAL 96782.54 110887.69 109981.16 109185.54 180866.18 139967.93 747671.04
VENDORS: 23 END OF REPORT
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Accounts Payable—7.7 Sample Reports

Sample 1099 Print

DEMO COMPANY
69 SOUTH PEACHTREE STREET
ATLANTA, GA 30030

- 3422-09-8887

GENERAL INDUSTRIAL MFG 93187.49
9610 DUNWOODY PL

SUITE 133-134

ATLANTA, GA 30338

DEMO COMPANY
69 SOUTH PEACHTREE STREET
ATLANTA, GA 30030

- 984432-095

S.E. INDUSTRIAL PROD. & EQUIP. 67913.89

11908 N.E. EXPRESSWAY
ATLANTA, GA 30321

TOTAL: 436185.21

FACTS AP Cc-23



Accounts Payable—7.7

Period Check Register

DATE: 09/28/0
USER: SSI ToX

9

DEMO COMPANY
PERIOD CHECK REGISTER 09/09

APR810 PAGE: 1
TIME: 9:28 AM

BANK FIRST TO 01
----CHECK---- DISCOUNT CHECK
CHECK VENDOR NAME DATE  REG# AMOUNT AMOUNT  TYPE
Bank 01 FIRST NATIONAL BANK OF ATLANTA
003025 V114 LINDA"S FLOWER SHOP 08/17/09 0346 .00 -10.05 *VOID*
003046 V102 S.E. INDUSTRIAL PROD. & EQUIP. 09/09/09 0346 .00 1833.81
003047 V103 OFFICE PRODUCTS INTERNATIONAL 09/09/09 0346 .00 628.83
003048 V105 WAREHOUSE EQUIPMENT UNLIMITED 09/09/09 0346 .00 5567.57
003049 V106 SANITATION SERVICES, INC. 09/09/09 0346 .00 1841.94
003050 V113 ATLANTA CRANE & HOISTS 09/09/09 0346 .00 693.21
003051 V114 LINDA"S FLOWER SHOP 09/09/09 0346 .00 21.47
003052 V118 GEORGIA INSURANCE SERVICES 09/09/09 0346 .00 395.89
003053 V121 SOUTHERN ELECTRIC COMPANY 09/09/09 0346 .00 365.12
003054 VOIDED - UNUSED CHECK 09/14/09 0349 .00 .00 *VOID*
003055 VOIDED - UNUSED CHECK 09/14/09 0349 .00 .00 *VOID*
003056 V107 LIGHTNING COURIER SERVICE 09/14/09 0349 .00 85.22
003057 V110 GEORGIA SHIPPING EQUIP. CO. 09/14/09 0349 .00 1866.51
003058 V111 ATLANTA GAS COMPANY 09/14/09 0349 .00 222 .22
003059 V112 GRANDE HOTEL 09/14/09 0349 .00 4373.67
003060 V114 LINDA"S FLOWER SHOP 09/14/09 0349 .00 12.33
003061 VOIDED - UNUSED CHECK 09/21/09 0351 .00 .00 *VOID*
003062 V101 INDUSTRIAL SUPPLY DISTRIBUTORS 09/21/09 0351 .61 60.61
003063 V102 S.E. INDUSTRIAL PROD. & EQUIP. 09/21/09 0351 .00 3178.06
003064 V105 WAREHOUSE EQUIPMENT UNLIMITED 09/21/09 0351 .00 5488.96
003065 V107 LIGHTNING COURIER SERVICE 09/21/09 0351 .00 56.83
003066 V108 GEORGIA NEWSPAPER 09/21/09 0351 .00 1251.91
003067 V110 GEORGIA SHIPPING EQUIP. CO. 09/21/09 0351 .00 1922.37
003068 V111 ATLANTA GAS COMPANY 09/21/09 0351 .00 768.02
003069 V120 WAREHOUSE INTERIORS, INC. 09/21/09 0351 1.83 184.45
649849 V114 LINDA"S FLOWER SHOP 09/09/09 0346 .00 25.13 NONINVOICE
798799 V107 LIGHTNING COURIER SERVICE 09/09/09 0346 .00 14.87 MANUAL
BANK TOTAL 2.44 30848.95
REPORT TOTAL 2.44 30848.95
CHECKS: 27 END OF REPORT
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Accounts Payable—7.7

Period Expense Distribution

DATE: 09/28/09
USER: SSI ToX

PERIOD 09709 SEP

G/L# FIRST TO LAST
BRANCH 01 ATLANTA BRANCH
DEPARTMENT 1 WHOLESALE

DEMO COMPANY
PERIOD EXPENSE DISTRIBUTION

A
T

PR820 PAGE: 1
IME: 9:29 AM

G/L# DESCRIPTION DEBIT CREDIT NET
520-01-1 PURCHASES - MISCELLANEOUS 280.28 .00 280.28
540-01-1 SALES TAX 358.05 .00 358.05
590-01-1 TRAVEL 400.41 .00 400.41
620-01-1 OFFICE EXPENSE 50.63 .00 50.63
625-01-1 AUTO & TRUCK EXPENSE 153.11 .00 153.11
630-01-1 MISCELLANEOUS EXPENSE 351.44 .00 351.44
640-01-1 FREIGHT 547.40 .00 547.40
710-01-1 ADVERTISING 846.57 .00 846.57
720-01-1 DUES & SUBSCRIPTIONS 25.00 .00 25.00
730-01-1 POSTAL EXPENSE 162.00 .00 162.00
735-01-1 TELEPHONE 298.72 .00 298.72
740-01-1 TAXES & LICENSES 3179.65 .00 3179.65
750-01-1 INSURANCE EXPENSE 121.67 .00 121.67
780-01-1 LEGAL & PROFESSIONAL 935.55 .00 935.55
790-01-1 UTILITIES 1084.20 .00 1084.20

REPORT TOTAL 8794.68 .00 8794.68
ACCOUNTS: 15 END OF REPORT

FACTS AP

Sample Reports
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Accounts Payable—7.7

Period Disbursement Distribution

DATE: 09/28/09 DEMO COMPANY

USER: SSI ToX PERIOD DISBURSEMENT DISTRIBUTION

PERIOD 09/09 SEP
G/L# FIRST TO LAST

BRANCH 01 ATLANTA BRANCH

Al
T

PR830 PAGE: 1
IME: 9:29 AM

G/L# DESCRIPTION DEBIT CREDIT NET
100-01-0 CASH 10.05 30859.00 (30848.95)
310-01-0 ACCOUNTS PAYABLE 30836.31 10.05 30826.26
490-01-1 DISCOUNTS TAKEN .00 2.44 (2.44)
630-01-1 MISCELLANEOUS EXPENSE 50.32 .00 50.32

REPORT TOTAL  30896.68  30871.49 25.19

ACCOUNTS: 4

C-26
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Accounts Payable—7.7

Register History Report

DATE: 09/28/09 DEMO COMPANY APR840 PAGE: 1
USER: SSI ToX REGISTER HISTORY REPORT TIME: 9:30 AM
AP BEGINNING DOLLAR ENDING
TRACE#  DATE PD REG# TYPE AP BALANCE AMOUNT  DISCOUNTS ADJUSTMENTS AP BALANCE
6547 09709709 09709 1505 DOCUMENT ENTRY 145592.75 668.47 .00 .00 146261.22
6548 09709709 09709 0346 CHECK REGISTER 146261.22 -11352.66 .00 .00 134908.56
6549 09/09/09 09/09 0347 CHECK REGISTER 134908.56 -98536.20 193.19 .00 36179.17
6550 09/09/09 09/09 0348 CHECK REGISTER 36179.17 .00 .00 .00 36179.17
6551 09/14/09 09709 1506 DOCUMENT ENTRY 36179.17 8619.90 .00 .00 44799.07
6552 09/14/09 09709 1507 DOCUMENT ENTRY 44799.07 4357.29 .00 -100.00 49056 .36
6553 09/14/09 09/09 1508 DOCUMENT ENTRY 49056.36 4473.65 .00 .00 53530.01
6554 09/14/09 09/09 1509 DOCUMENT ENTRY 53530.01 7894.07 .00 .00 61424.08
6555 09/14/09 09709 0349 CHECK REGISTER 61424 .08 -6559.95 .00 .00 54864.13
6556 09/14/09 09709 0350 CHECK REGISTER 54864.13 -5908.81 .00 .00 48955.32
6557 09/21/09 09/09 0351 CHECK REGISTER 48955.32 -12911.21 2.44 .00 36041.67
6558 09/21/09 09/09 0352 CHECK REGISTER 36041.67 -4648.78 .00 .00 31392.89
6559 09/21/09 09709 1510 DOCUMENT ENTRY 31392.89 9722.99 .00 .00 41115.88
6560 09/21/09 09709 0020 VENDOR BALANCING 41115.88 .00 .00 .00 41115.88
6561 09/25/09 09/09 1511 DOCUMENT ENTRY 41115.88 3580.70 .00 -.20 44696.38
REGISTER HISTORY RECAP: PERIOD  ——-------m oo o CHANGE

09709 -100600.54 195.63 -100.20 -100896.37

TRACES: 15 END OF REPORT

FACTS AP

Sample Reports
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Accounts Payable—7.7

Document Removal Register

DATE: 09/28/09

DEMO COMPANY

Sample Reports

APR850 PAGE: 1

USER: SSI ToX DOCUMENT REMOVAL REGISTER #0059 TIME: 9:31 AM
BRANCH 01
VENDOR NAME DOCUMENT PERIOD DATE AMOUNT REG# DATE PAYMENT DISCOUNT BALANCE
V101 INDUSTRIAL SUPPLY DISTRIBUTORS 1349 09/09 09/12/09 61.22 0351 09721 60.61 .61 .00
V102 S.E. INDUSTRIAL PROD. & EQUIP. 1299 08709 08/13/09 1833.81 0346 09709 1833.81 .00 .00
1319 08/09 08/24/09 3178.06 0351 09721 3178.06 .00 .00
V103 OFFICE PRODUCTS INTERNATIONAL 90081001 08/09 08/10/09 628.83 0346 09709 628.83 .00 .00
V105 WAREHOUSE EQUIPMENT UNLIMITED 1300 08/09 08/13/09 5567.57 0346 09/09 5567.57 .00 .00
1322 08709 08/27/09 5488.96 0351 09721 5488.96 .00 .00
V106 SANITATION SERVICES, INC. 5246256235 08/09 08/10/09 737.22 0346 09709 737.22 .00 .00
7456323563 08709 08/11/09 1104.72 0346 09709 1104.72 .00 .00
V107 LIGHTNING COURIER SERVICE 198198198 08/09 08/31/09 100.09 0346 09709 14.87 .00
0349 09714 85.22 .00 .00
6549849849 09709 09/09/09 56.83 0351 09/21 56.83 .00 .00
V108 GEORGIA NEWSPAPER 681681 08/09 08/24/09 600.13 0351 09721 600.13 .00 .00
3457124114 08/09 08/25/09 651.78 0351 09721 651.78 .00 .00
V110 GEORGIA SHIPPING EQUIP. CO. 1306 08709 08/16/09 1866.51 0349 09/14 1866.51 .00 .00
1316 08709 08/22/09 1922.37 0351 09/21 1922.37 .00 .00
V111 ATLANTA GAS COMPANY 3161986198 09/09 09/09/09 222.22 0349 09714 222 .22 .00 .00
4253698752 09/09 09/14/09 768.02 0351 09721 768.02 .00 .00
V112 GRANDE HOTEL 724572457 08709 08/17/09 1755.78 0349 09/14 1755.78 .00 .00
7823616484 08709 08/18/09 2633.76 0341 08/03 15.87 .00
0349 09714 2617.89 .00 .00
V113 ATLANTA CRANE & HOISTS 1327 08/09 08/30/09 693.21 0346 09709 693.21 .00 .00
V114 LINDA"S FLOWER SHOP 6186 08709 08/24/09 12.15 0345 08/31 5.48 .00
0346 09709 6.67 .00 .00
198198198 08709 08/31/09 14.80 0346 09709 14.80 .00 .00
5437682764 09/09 09/09/09 25.19 0348 09709 25.19 .00 .00
9498498498 09709 09/09/09 12.33 0349 09714 12.33 .00 .00
V118 GEORGIA INSURANCE SERVICES 90081001 08/09 08/10/09 395.89 0346 09709 395.89 .00 .00
V120 WAREHOUSE INTERIORS, INC. 1352 09/09 09/14/09 186.28 0351 09721 184.45 1.83 .00
V121 SOUTHERN ELECTRIC COMPANY 13461346 08/09 08/10/09 182.56 0346 09709 182.56 .00 .00
5253856969 08709 08/11/09 182.56 0346 09709 182.56 .00 .00

DOCUMENTS: 27
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